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List of Abbreviations

ED electronic delay
EMAT electro-magnetic acoustic transducer
FT flight time
GD global delay
ID inside diameter
LD law delay
OD outside diameter
OPD optical path difference
PA phased array
PRF pulse repetition frequency
SAFT synthetic aperture focusing technique
SNR signal-to-noise ratio
TCG time-corrected gain
TOFD time-of-flight diffraction
UT ultrasonic testing
VC volume corrected
WD wedge delay
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Important Information — Please Read Before Use

Intended Use

FocusPC is designed to perform nondestructive inspections on industrial and 
commercial materials.

Instruction Manual

This instruction manual contains essential information on how to use this Evident 
product safely and effectively. Before using this product, thoroughly review this 
instruction manual. Use the product as instructed.

Keep this instruction manual in a safe, accessible location.

Some of the details of screen images shown in this manual may differ from the screen 
images displayed in your software. However, the principles remain the same.

Software Compatibility

FocusPC is only compatible with the FOCUS PX instrument. For a list of models, refer 
to the FocusPC User’s Manual.

IMPORTANT
Important Information — Please Read Before Use 11
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Safety Symbols

The following safety symbols might appear on the instrument and in the instruction 
manual:

 General warning symbol
This symbol is used to alert the user to potential hazards. All safety messages that 
follow this symbol shall be obeyed to avoid possible harm or material damage.

 Shock hazard caution symbol
This symbol is used to alert the user to potential electric shock hazards. All safety 
messages that follow this symbol shall be obeyed to avoid possible harm.

Safety Signal Words

The following safety symbols might appear in the documentation of the instrument:

The DANGER signal word indicates an imminently hazardous situation. It calls 
attention to a procedure, practice, or the like that if not correctly performed or 
adhered to will result in death or serious personal injury. Do not proceed beyond a 
DANGER signal word until the indicated conditions are fully understood and met.

The WARNING signal word indicates a potentially hazardous situation. It calls 
attention to a procedure, practice, or the like that if not correctly performed or 
adhered to could result in death or serious personal injury. Do not proceed beyond a 
WARNING signal word until the indicated conditions are fully understood and met.

DANGER

WARNING
Important Information — Please Read Before Use12
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The CAUTION signal word indicates a potentially hazardous situation. It calls 
attention to a procedure, practice, or the like that if not correctly performed or 
adhered to may result in minor or moderate personal injury, material damage, 
particularly to the product, destruction of part or all of the product, or loss of data. Do 
not proceed beyond a CAUTION signal word until the indicated conditions are fully 
understood and met.

Note Signal Words

The following symbols could appear in the documentation of the instrument:

The IMPORTANT signal word calls attention to a note that provides important 
information, or information essential to the completion of a task.

The NOTE signal word calls attention to an operating procedure, practice, or the like, 
which requires special attention. A note also denotes related parenthetical 
information that is useful, but not imperative.

The TIP signal word calls attention to a type of note that helps you apply the 
techniques and procedures described in the manual to your specific needs, or 
provides hints on how to effectively use the capabilities of the product.

Warranty Information

Evident guarantees your Evident product to be free from defects in materials and 
workmanship for a specific period, and in accordance with conditions specified in the 
Terms and Conditions available at https://www.olympus-ims.com/en/terms/.

CAUTION

IMPORTANT

NOTE

TIP
Important Information — Please Read Before Use 13
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The Evident warranty only covers equipment that has been used in a proper manner, 
as described in this instruction manual, and that has not been subjected to excessive 
abuse, attempted unauthorized repair, or modification.

Inspect materials thoroughly on receipt for evidence of external or internal damage 
that might have occurred during shipment. Immediately notify the carrier making the 
delivery of any damage, because the carrier is normally liable for damage during 
shipment. Retain packing materials, waybills, and other shipping documentation 
needed in order to file a damage claim. After notifying the carrier, contact Evident for 
assistance with the damage claim and equipment replacement, if necessary.

This instruction manual explains the proper operation of your Evident product. The 
information contained herein is intended solely as a teaching aid, and shall not be 
used in any particular application without independent testing and/or verification by 
the operator or the supervisor. Such independent verification of procedures becomes 
increasingly important as the criticality of the application increases. For this reason, 
Evident makes no warranty, expressed or implied, that the techniques, examples, or 
procedures described herein are consistent with industry standards, nor that they 
meet the requirements of any particular application.

Evident reserves the right to modify any product without incurring the responsibility 
for modifying previously manufactured products.

Technical Support

Evident is firmly committed to providing the highest level of customer service and 
product support. If you experience any difficulties when using our product, or if it 
fails to operate as described in the documentation, first consult the user’s manual, and 
then, if you are still in need of assistance, contact our After-Sales Service. To locate the 
nearest service center, visit the Service Centers page on the Evident Scientific Web site.
Important Information — Please Read Before Use14
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Introduction

FocusPC is a powerful and flexible ultrasonic and phased array acquisition and 
analysis software that can be used to build high speed inspection systems and 
perform high-end data analysis. The objective of the FocusPC User’s Manual is to give 
a good overview of the software and its essential features. The current manual focuses 
on describing the FocusPC advanced features and also provides detailed menu 
descriptions.
Introduction 15



DMTA-20093-01EN, Rev. D, September 2022
Introduction16



DMTA-20093-01EN, Rev. D, September 2022
1. Detailed FocusPC User Interface

This chapter details the FocusPC user interface elements.

1.1 Main Window

The main window (refer to the FocusPC User’s Manual) contains the following 
elements.

Title bar

Displays the program icon, the program identification, and the name of the active file, 
as well as control buttons on the right end of the bar.

Menu bar

Displays the names of the various menus.

Toolbar

Displays command buttons, which can be clicked to carry out various commands.

Document windows

There is a document window, or shell window, for each file opened. Document 
windows provide a primary view of file content. The windows can be overlapping, in 
which case, the topmost window is the active one. The document windows can also 
be arranged as tiles or in a cascade. The active window is always identified by a 
highlighted title bar.
Detailed FocusPC User Interface 17



DMTA-20093-01EN, Rev. D, September 2022
1.2 Menu Bar

This section describes the FocusPC menu bar. The menu bar (see Figure 1-1 on 
page 18) is the horizontal bar displayed at the top of the main window, below the title 
bar, and it provides access to commands. To open a menu, click the menu name. To 
activate a menu command, click its name in the menu, or type the keyboard shortcut 
if there is one indicated.

Figure 1-1  The menu bar

The following subsections describe the commands available in each menu. Note that, 
depending on the operation mode and the type of hardware connected, the content of 
the menus could differ from what is presented in this manual.

1.2.1 File Menu

The File menu (see Figure 1-2 on page 18) contains the commands that manage data 
files and the general preferences of the software.

Figure 1-2  The File menu

The File menu contains the following commands:

Open
Opens a standard Open dialog box, from which you can select and load a setup or 
a data file.
Chapter 118
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Save As
Opens a standard Save As dialog box, from which you can browse through 
folders, and save the active setup.

Import (*.law) file
Opens a dialog box (see Figure 1-3 on page 19) from which you can select and 
load a *.law file used to configure the beam parameters for either the current 
group or a new one.

Figure 1-3  Importing a .law file

Merge Files
Opens the dialog box shown in Figure 1-4 on page 20, from which different data 
files can be selected and merged into a single data file. Refer to the FocusPC User’s 
Manual for more information.
Detailed FocusPC User Interface 19
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Figure 1-4  The Data File Merge dialog box

Export Datagroup to File
Opens the dialog box shown in Figure 1-5 on page 20, which can be used to 
export an A-scan or a C-scan to a *.txt file. See “Export Data Utility” on page 163 
for more information.

Figure 1-5  The Export Datagroup dialog box
Chapter 120
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Preferences
Opens the Preferences dialog box, used to set various basic parameters related to 
general use of the software (see “Preferences Dialog Box” on page 90 for details).

Exit
Closes opened data files and exit FocusPC.

1.2.2 Toolbars Menu

Figure 1-6  The Toolbars menu

The Toolbars menu (see Figure 1-6 on page 21) contains commands relating to the 
display of toolbars. The Toolbar menu commands are the following:

Advanced Weld
Alternately displays and hides the Advanced Weld toolbar.

Advanced Aero
Alternately displays and hides the Advanced Aero toolbar.

1.2.3 Help Menu

Figure 1-7  The Help menu

The Help menu (see Figure 1-7 on page 21) contains commands that provide access to 
information about FocusPC.

Help
Opens a window providing access to complete FocusPC documentation.
Detailed FocusPC User Interface 21
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About
Opens a dialog box indicating which version and edition of FocusPC you are 
running. See Figure 1-8 on page 22.

Figure 1-8  The About FocusPC dialog box

1.3 Status Bar

The status bar appears at the bottom of the document windows (see Figure 1-9 on 
page 22).

Figure 1-9  The status bar

The status bar displays the following information relative to the state of the system:

Scan
Position on the scan-axis from the encoder or from the 1-axis internal clock.

Index
Position on the index-axis from the encoder or from the 2-axis internal clock.

Edition
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Set Encoders
Sets the encoder position of the Scan and Index axes to the Preset values defined 
in the Scan and Mechanical Settings dialog box.

Acq. speed
Maximum acquisition speed with the current settings, directly related to current 
PRF value as specified by the following equation:

where:

PRF:
The pulse repetition frequency is set in the UT Settings dialog box > Digitizer 
tab > PRF group > Current parameter.

Scan resolution:
The scan resolution is set in the UT Settings dialog box > Digitizer tab > Data 
group > Resolution parameter.

You can adjust the Acq. speed by changing the PRF value (in the Digitizer  tab of the 
UT Settings dialog box) and the Resolution value (in the Scan  tab of the Scan and 
Mechanical Settings dialog box). Note, however, that a too high Acq. speed value can 
generate ghost echoes. For example, with a scanner that can move a probe up to 
100 mm/s and a scan resolution of 2 mm, in the Dashboard, set the Acq. speed to 
100 mm/s. FocusPC automatically sets the PRF value to 50 Hz. For manual encoder 
inspections, set the Acq. speed value between 50 mm/s and 100 mm/s.

Mode
Current mode (Setup, Inspection, or Analysis).

Al.
Alarm indicator state for the Alarm 1, Alarm 2, and Alarm 3 (from left to right) 
described in Table 1 on page 24. The alarm indicators only appear when you 
define at least one alarm in the Alarms tab of the UT Settings dialog box.

Acq. speed PRF Scan resolution⋅=

TIP
Detailed FocusPC User Interface 23
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Link
Indicator color reporting the state of the communication with the acquisition 
instrument as given in Table 2 on page 24.

Acq. Unit
Internal temperature of the acquisition instrument. The FOCUS PX automatically 
will shut down if the internal temperature reaches 76 °C.

Table 1  Alarm (Al.) indicator states 

Indicator color Alarm state

Active

Not active

Not defined

Table 2  Link indicator states 

Indicator color Communication with acquisition instrument

Correctly established

Not established

No attempt
Chapter 124
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2. Dialog Box Descriptions

This chapter describes how to use the FocusPC dialog boxes.

2.1 UT Settings Dialog Box

Clicking the UT Settings button ( ) on the Component toolbar toggles the visibility 
of the UT Settings dialog box (see Figure 2-1 on page 25). The UT Settings dialog box 
contains nine basic tabs: General, Gates, TCG, Digitizer, Pulser/Receiver, Position, 
Alarms, Transmitter, and Receiver.

Figure 2-1  The UT Settings dialog box

All beams
When this check box is selected, modifying a parameter causes all focal laws to be 
affected by the modification. If this check box is clear, modifying a parameter 
causes only the active focal law to be affected by the modification.

Interleaved
Used to change the firing order of the different focal laws (refer to the FocusPC 
User’s Manual for more information on using this function).
Dialog Box Descriptions 25
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Linear merged
Selecting this check box activates the Linear Merged mode, which performs the 
dynamic merging of the individual firings. (For proper data display, this mode 
should only be used with 0° linear focal laws).

2.1.1 General Tab

The General tab (see Figure 2-2 on page 26) contains options that are used to 
configure the basic ultrasonic parameters.

Description of the General tab

Figure 2-2  The General tab

The General tab is subdivided into the Gain, Time Base, and Auto Values areas.

Gain parameters

Figure 2-3  The Gain parameters

Group
Sets the gain value in decibels (dB) for the receiver of the active group. The 
group gain is added to the beam gain (when a phased array unit is connected 
to the system). See Figure 2-3 on page 26.
Chapter 226
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When the TCG (time-corrected gain) function is used, the gain programmed 
in the TCG curve (see “TCG Tab” on page 35) is added to this gain value to 
produce the total input gain.

Beam
Sets the gain value in decibels (dB) for the active beam’s receiver.

Apply
This box displays the applied gain, considering the sum of the group and 
focal law gain.

Ref.
This box displays the reference gain that you have set by using the Set 
Reference button.

Auto Set
This button automatically sets the amplitude of the echo between the cursors 
to the value specified in the Ref. amplitude box.

Set Reference
This button transfers the Apply value into the Ref. box.

Reset Beam
This button resets the gain of the active beam to 0 dB.

Time Base parameters

Figure 2-4  The Time Base parameters

Start
Sets the delay in the material at which the acquisition starts. This value can be 
displayed in distance or time units, according to the unit chosen in the Mode 
list. See Figure 2-4 on page 27.
Dialog Box Descriptions 27
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Range
Sets the acquisition range in the material (according to the unit set in the 
Mode list).

The maximum range value is determined by the maximum number of samples 
allowed for an A-scan.

Mode
Selects the unit mode used to set the time base:

○ Time: Time base values are expressed in ultrasonic time-of-flight units: 
µs (microseconds).

○ Full path: Time base values are expressed in distance units: in. (inches) or 
mm (millimeters). The value entered is equal to the time of flight 
multiplied by the ultrasonic velocity in the material.

○ Half path: Time base values will be expressed in distance units: in. 
(inches) or mm (millimeters). The values are equal to half the total 
distance traveled by the ultrasonic wave (Full path divided by 2).

○ TOFD: Time base values will be expressed in distance units, in function 
of the TOFD calibration: in. (inches) or mm (millimeters).

○ True depth: Time base values will be expressed in distance units: in. 
(inches) or mm (millimeters). The calculated true depth is a function of 
the beam angle in the material.

This button appears in a phased array setup when True depth is selected in the 
Mode list. Clicking this button takes the true depth Start and Range values of the 
active focal law and applies the corresponding half path Start and Range values to 
all focal laws in the active group.

This button appears in a phased array setup when True depth is selected in the 
Mode list. Clicking this button takes the true depth Start and Range values of the 
active focal law and applies them to focal laws in the active group.

NOTE
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Set Auto
This button sets the ultrasonic scale (Start and Range under Time base) according 
to the values specified in the Full Range Start and Full Range boxes of the Auto 
Values dialog box.

Set Range
This button sets the ultrasonic scale (Start and Range under Time base) according 
to the positions of the reference and measurement cursors in an A-scan view.

Auto Values parameters

Figure 2-5  The Auto Values parameters

Ref. amplitude
Indicates the reference amplitude that has been specified in the Auto Values 
dialog box (opened with the Auto Values button). See Figure 2-5 on page 29.

Full range start
Indicates the full range start on the ultrasonic axis, according to the value 
specified in the Auto Values dialog box.

Full range
Indicates the distance on the ultrasonic axis corresponding to the full range, 
according to the value specified in the Auto Values dialog box.

Auto Values
This button opens the Auto Values dialog box, used to define the automatic 
values. See Figure 2-6 on page 30.
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Figure 2-6  The Auto Values dialog box

In this dialog box, enter the Ref. amplitude, Ultrasound start, and Ultrasound range 
values that should be programmed when the Set Auto button is clicked. Click OK to 
accept values, or Cancel to return to previous values.

Calibrate
This button opens a dialog box, used to calibrate the ultrasonic velocity or delay 
according to the reference cursor position. See Figure 2-7 on page 31.

To use this function, select a side view (corrected for the angle), place the cursors 
on two reflectors at known positions, and then click the Calibrate button. In the 
calibration dialog box that pops up, enter the know depths of the two selected 
reflectors, and the values shown in the Results section of this dialog box will be 
calculated automatically. To accept these values, click OK. FocusPC will program 
the calculated values.
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Figure 2-7  The calibration dialog box in True Depth mode

2.1.2 Gates Tab

The Gates tab (see Figure 2-8 on page 32) contains options that are used to define the 
detection gate parameters. Detection gates are used to extract information from the 
A-scan and to form the C-scan data groups.

Whenever a gate is enabled, it is represented on the corresponding A-scan view by a 
horizontal line with small vertical lines on both ends. In addition, each time a 
detection gate is defined and enabled, a new data group is added in the left section of 
the Contents dialog box.

You can define four detection gates for each channel, in addition to the 
synchronization gate. Gate I is the synchronization gate, and gates A, B, C, and D are 
the acquisition gates. The A-scan signal that is viewed and acquired can be 
synchronized on pulse or on echo in the main gate. Each gate is defined by a starting 
position, a gate length, a threshold level, and an alarm level. Detection occurs when a 
portion of the signal exceeds the threshold level during the time interval specified by 
the starting position and gate length.
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The setting of the gates can be done either by filling the Start and Length boxes for 
each gate, or interactively by positioning both cursors (reference and measurement) 
on the A-scan and clicking the set button of the gate. The basic procedure to follow for 
the definition of the gates is described later in this section. For the procedure to define 
gates, refer to the FocusPC User’s Manual.

Description of the Gates tab

Figure 2-8  The Gates tab

The Gates tab contains the following parameters:

Set Gate buttons
Sets the start position, the length, and the threshold of synchronization of the 
selected gate according to the position of the reference cursor and the 
measurement cursor in time, and the reference cursor in level.

Check boxes to the left of the Set Gate buttons
When selected (enabled), the position and amplitude data of the corresponding 
gate will be recorded.

Start
Sets the start position of the corresponding gate. The position is expressed in the 
unit chosen in the Mode list of the General tab.

Length
Sets the length of the corresponding gate. The length is expressed in the unit 
chosen in the Mode list of the General tab.

Threshold
Sets the threshold level of the corresponding gate. The level is expressed as a 
percentage (%) of the full-screen height.
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Alarm level
Sets the alarm level of the corresponding gate. The level is expressed as a 
percentage (%) of the full-screen height.

POS B - POS A
When enabled, a differential-position data group in which the position of a signal 
above the gate A threshold is subtracted from the position of a signal above the 
gate B threshold will be recorded.

Type
Use this box to select one of the following detection types according to the 
detection gate:

Maximum
The position and amplitude data of the detected maximum signal peak inside 
the gate is recorded (respectively P1 and A1 in Figure 2-9 on page 33).

Figure 2-9  Maximum gate detection

Crossing
The position data of the first peak crossing the gate and the amplitude data of 
the maximum detected signal peak inside the gate are recorded. (respectively 
P1 and A1 in Figure 2-10 on page 34).
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Figure 2-10  Crossing gate detection

First Peak Maximum
The position and amplitude data of the first signal peak detected inside the 
gate is recorded (respectively P1 and A1 in Figure 2-11 on page 34).

Figure 2-11  First peak maximum gate detection
Chapter 234



DMTA-20093-01EN, Rev. D, September 2022
First Peak Crossing
The position data of the first peak crossing the gate and the amplitude data of 
the first detected signal peak inside the gate are recorded (respectively P1 and 
A1 in Figure 2-12 on page 35).

Figure 2-12  First peak maximum gate detection

Link
This box can be used to synchronize the start of the corresponding gate with 
respect to the previous gate.

Abs. mode
When enabled, the absolute maximum amplitude value is kept. This option is 
only available when the A-scan signal rectification (available in the 
Pulser/Receiver tab) is set to RF.

2.1.3 TCG Tab

The TCG tab (see Figure 2-13 on page 36) contains the options that can be used to set 
the time-corrected gain (TCG) for the current group. The TCG function operates by 
modifying the receiver gain during data acquisition to compensate for the attenuation 
of the ultrasonic wave in the material. The TCG curve defines the gain values that are 
added to the group gain.
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Description of the TCG tab

Figure 2-13  The TCG tab

The TCG tab contains the following parameters:

Enable
This check box alternately activates and deactivates the TCG function according 
to the values set on the TCG tab.

Display
This check box alternately displays and hides the TCG curve in an area covering 
25 % of the A-scan view.

Reset
This button resets the TCG curve by clearing all currently defined points.

Current TCG
This box allows you to choose between High Resolution and Full Range.

High Resolution TCG is designed to optimize subsurface coverage:

— Points can be placed very close to the A-scan synchronization position
— Maximum slope of 40 dB/10 ns
— Maximum TCG gain of 40 dB
Full Range TCG is designed to optimize signal-to-noise ratio:

— Points can be placed 640 ns after the A-scan synchronization position
— Maximum slope of 20 dB/µs
— Maximum TCG gain of 80 dB

Reference level
Sets the wanted reference level, in percent, for the next point.

Maximum slope
Displays the maximum slope between two TCG points.
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Position
Indicates the position of the TCG points on the ultrasonic axis. These points are 
represented by red dots when the TCG curve is displayed at the top of the 
corresponding A-scan view.

Gain
Indicates the gain level for the TCG points.

Add Point
This button adds a new point to the TCG curve, and it is placed in a position 
corresponding to the maximum amplitude that is read between the reference and 
measurement cursors. The gain associated with the TCG point corresponds to the 
theoretical gain required to reach the reference level.

Remove Point
This button removes the selected point from the grid. The TCG curve is then 
recalculated according to the remaining points. The gain and slope parameters 
are updated for the current position.

Import/Export
These buttons allow the user to export the TCG curve applied to the current 
group or import a TCG curve from a .csv file. For more information on the TCG 
curve import/export function, refer to the FocusPC User’s Manual.

2.1.4 Digitizer Tab

The Digitizer tab (see Figure 2-14 on page 37) contains options that are used to set the 
basic digitizer and data-acquisition parameters. The Digitizer tab is subdivided into 
the Digitizing, PRF, Data Sample Size, Data, and Multipeak areas.

Description of the Digitizer tab

Figure 2-14  The Digitizer tab
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The Digitizing parameters are shown in Figure 2-15 on page 38.

Figure 2-15  The Digitizing parameters

Frequency
Allows the user to select the digitizer frequency, specified in megahertz 
(MHz).

Recurrence
The recurrence is the firing recurrence frequency (pulse repetition frequency, 
or PRF) which is defined independently for every group. The effective 
recurrence is the number of ultrasonic pulses generated per second.

Averaging
Indicates the number of A-scans acquired for each A-scan that is returned. 
The returned A-scan is obtained by calculating, for each sample, the average 
value over all the acquired A-scans.

The averaging can be used to reduce the effect of noise; however, using a 
great number of acquisitions for the averaging will decrease the maximum 
acquisition rate.

Synchro
Selects the synchronization mode:

— Pulse: the acquisition is synchronized on the ultrasonic firing pulse.
— Echo: the acquisition is synchronized on the echo crossing gate 1.

The PRF parameters are shown in Figure 2-16 on page 38.

Figure 2-16  The PRF parameters
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Target
This box can be used to select whether the PRF should be set to the maximum 
possible value in hertz or to a custom defined value that FocusPC will try to 
match as closely as possible.

Current
Indicates the current PRF value in hertz.

The Data Sample Size area is shown in Figure 2-17 on page 39.

Figure 2-17  The Data Sample Size setting

The selected data sample size indicates the resolution of the amplitude 
digitalization. This resolution influences the size of an elementary data sample 
and therefore the size of the resulting data file.

The Data area (see Figure 2-18 on page 39) contains the following choices:

Figure 2-18  The Data parameters

Samples
Indicates the number of samples per data acquisition, that is, the number of 
points that compose the A-scan. This number is directly related to the Range 
(General tab) and Digitizing frequency values. If the Units parameter is in 
time (microseconds), multiplying the Range value (in seconds) by the 
Digitizing frequency value (in hertz) gives the number of points. This has an 
effect on the Compression.

Resolution
Indicates the digitizer resolution in the UT scale unit.
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Compression

This box is used to set the digitizer compression ratio. You can reduce the 
sample quantity, and thus the data file size, by keeping the position of the first 
sample with the maximum amplitude (see example shown in Figure 2-19 on 
page 40). This box is only available for certain acquisition units.

Figure 2-19  Example of a compression ratio of 4

A-scan
Creates the A-scan data group.

Conditional
When you select this option, the A-scan is only recorded when an alarm is 
triggered. For more details about this function, refer to the FocusPC User’s 
Manual.

2.1.5 Pulser/Receiver Tab

The Pulser/Receiver tab (see Figure 2-20 on page 41) contains options that you can 
use to configure the pulser and receiver used for the inspection.
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Description of the Pulser/Receiver tab

Figure 2-20  The Pulser/Receiver tab

The Pulser/Receiver tab is subdivided into the following sections: Pulser, Receiver, 
and Filter (see Figure 2-20 on page 41).

Pulser parameters

Figure 2-21  The Pulser parameters

Connector
For a conventional UT group, you can use this box to select the connector to 
use for the pulser. For a phased array group, it indicates the number of the 
first element used in emission.

Voltage (all groups)
Sets the pulse voltage of the pulser, which is the same for all groups, in volts 
(V).

Pulse width
Sets the pulse width of the pulser in nanoseconds.
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Receiver parameters

Figure 2-22  The Receiver parameters

Connector
For a conventional UT group, you can use this box to select the connector to 
use for the receiver. For a phased array group, it indicates the number of the 
first element used in reception.

Scale Type
Indicates the receiver type: LIN (linear receiver).

Rectification
Allows you to choose the rectification type: RF (the A-scan signal is displayed 
without any rectification), HW+ (only the positive part of the signal is kept), 
HW- (only the negative part of the signal is kept), or FW (the negative part of 
the signal is brought back to the positive part).

Filters parameters

Figure 2-23  The Filters parameters

Filter
Allows you to select the frequency of the filter used on the group signal. 
Several high-pass, low-pass, and band-pass filters are available.
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Smoothing
Selects the video filtering of the rectified signal in order to smooth the curve. 
The smoothing function creates an envelope on the rectified signal to 
eliminate the effects of the original RF signal (alternating positive and 
negative amplitudes).

2.1.6 Position Tab

The Position tab (see Figure 2-24 on page 43) contains options that are used to set the 
parameters of the groups and beams used for the inspection.

Description of the Position tab

Figure 2-24  The Position tab

The Position tab contains Probe, Beam, and Total parameters.

Probe parameters

Figure 2-25  The Probe parameters
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Probe selection boxes
Two boxes are available to choose the probe category (type) and model for 
conventional UT probes.

T/R buttons
When a pulse-echo group is selected, the T button transfers the pulse-receiver 
probe parameters. When a pitch-and-catch or a TOFD group is selected, the T 
button transfers the pulser probe parameters and the R button transfers the 
receiver probe parameters.

Delay
Sets the probe delay.

TOFD
Separation

Specifies the distance between the probes (available only with an active TOFD 
group).

Parallel/perpendicular to beam buttons
Specifies the beam orientation as parallel or perpendicular to the scan 
direction (available only with an active TOFD group).

Offset
Scan

Specifies the probe offset on the scan axis.

Index
Specifies the index offset (distance on the index axis between two consecutive 
scan lines).

Angle
Refracted

Specifies the refracted angle of the probe.

Skew
Specifies the skew angle of the probe.
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Beam parameters

Figure 2-26  The Beam parameters

Delay
Sets the total wedge delay of the probe. The wedge delay is calculated as 
follows:

Wave type
Allows you to select the wave type: Longitudinal or Transverse.

Sound velocity
Sets the sound velocity in the inspected material for each wave type. This 
value must be determined with precision as it is used to convert time units 
into distance units.

Adjust Resolution
This button opens the dialog box shown in Figure 2-27 on page 46, which can 
be used to adjust the data group resolution.

(1) Min.
Sets the minimal offset difference, ensuring that there will be no data 
fusion among the data groups, although acquisition gaps may occur.

(2) Max.
Sets the maximal offset difference, ensuring that there will be no 
acquisition gaps among the data groups, although data fusion may occur.

Wedge delay Ultrasound path in wedge
Sound velocity in wedge
-------------------------------------------------------------=
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(3) Average
Sets an average of the offset difference, therefore providing a good 
compromise between acquisition gaps and data fusion among data 
groups.

(4) User
This option enables you to define the offset difference. In the box, enter 
the desired data group resolution between the minimum and maximum 
offset differences.

Figure 2-27  The Adjust Index Data group resolution dialog box

Offset
Scan

The scan offset represents the distance between the scan origin and the beam; 

this value can be positive or negative. Click the  button to view a graphical 
representation of this offset.

Index
The index offset represents the distance between the index origin and the 

beam; this value can be positive or negative. Click the  button to view a 
graphical representation of this offset.

Angle
Refracted

Defines the refracted angle of the beam.

The refracted angle (β) [see Figure 2-28 on page 47] is calculated from the 
probe incidence angle (α), sound velocity in wedge, and sound velocity in 
material according to the following formula (Snell’s law):
Chapter 246



DMTA-20093-01EN, Rev. D, September 2022
Figure 2-28  Refracted angle

Skew
Sets the skew angle of the beam, which is defined as the angle between the 
primary axis of the probe and the scan axis. For more details on the probe 
orientation convention, refer to the FocusPC User’s Manual.

Total

Figure 2-29  The Total parameters

The boxes under Total display the combination of the defined probe and beam 
parameters (Scan, Index, Delay and Skew).

2.1.7 Alarms Tab

The Alarms tab (see Figure 2-30 on page 48) contains options that are used to define 
the alarms. For more information on defining the alarms, refer to the FocusPC User’s 
Manual.

αsin
βsin

----------- Sound velocity in wedge
Sound velocity in material
---------------------------------------------------------------=

β

α
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Description of the Alarms tab

Figure 2-30  The Alarms tab

The Alarms tab contains the following parameters:

Output line
Selects the alarm output line to be used when the alarm condition is met.

Count before Alarm 
Set the number of consecutive times the alarm condition must be exceeded before 
the alarm is triggered.

Conditions parameters
Not

When selected, these check boxes apply the logical operator “NOT” to the 
next condition to the right.

Synchro
This box is used to select the condition relative to the synchronization gate 
(Gate I): Unused or Detect.

Gates A, B, C, and D
These boxes are used to select the conditions relative to gates A, B, C, and D: 
Unused or Detect.

Alarm conditions are defined independently for each channel.
NOTE
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2.1.8 Transmitter Tab

The Transmitter tab (see Figure 2-31 on page 49) is used to specify the parameters of 
each element of a focal law in transmission.

Figure 2-31  The Transmitter tab

The Transmitter tab contains the following parameters:

First element
Specifies the first active element of the transmitter in the considered focal law.

Current element
Selects an element of the probe as the current element. You can also select an 
element by clicking the corresponding bar on the Delay or Amplitude graphs.

On
Selecting or clearing this check box respectively turns on or off the element in 
transmission.

Holding down the SHIFT key while clearing the On check box simultaneously turns 
off all the elements in transmission.

Link transmitter/receiver check box
When this check box is selected, modifying the First Element value for the 
transmitter also sets the same value for the receiver.

Delay (ns)
The Delay box is used to specify the transmission delay applied to the current 
element in nanoseconds (ns).

NOTE
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The bar graph represents the transmission delay law for the different elements. 
The blue bar shows the delay for the element that is being modified, that is, the 
one for which the parameters are displayed. The green bars indicate the delays of 
the other active elements. The inactive elements are left blank.

Amplitude (V)
The Amplitude box is used to specify the pulse amplitude applied to the element 
in volts (V).

2.1.9 Receiver Tab

The Receiver tab (see Figure 2-32 on page 50) is used to specify the parameters of each 
element of a focal law in reception.

Figure 2-32  The Receiver tab

The Receiver tab contains the following parameters:

First element
Specifies the first active element of the receiver in the considered focal law.

Current element
Selects an element of the probe as the current element. You can also select an 
element by clicking the corresponding bar on the Delay or Gain graphs.

On
Selecting or clearing this check box respectively turns on or off the element in 
reception.
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Holding down the SHIFT key while clearing the On check box simultaneously turns 
off all the elements in reception.

Link transmitter/receiver check box
When this check box is selected, modifying the First Element value for the 
receiver also sets the same value for the transmitter.

Insert
Used to insert an element to be used as a receiver in the active focal law. The new 
element is inserted before the currently selected element.

Delete
Deletes the currently selected receiver element from the active focal law.

Sum gain
This box allows you to select whether the Sum gain should be automatically set 
or manually defined.

Current
Indicates the current hardware Sum gain value.

Delay (ns)
This box is used to specify the reception delay applied to the element in 
nanoseconds (ns).

The bar graph represents the reception delay law for the different elements. The 
blue bar shows the delay for the element that is being modified, that is, the one for 
which the parameters are displayed. The green bars indicate the delays of the 
other active elements. The inactive elements are left blank.

Gain (dB)
This box is used to specify the gain applied to the element in decibels (dB).

The bar graph represents the amplitude law in reception for the different 
elements. The blue bar shows the delay for the element that is being modified, 
that is, the one for which the parameters are displayed. The green bars indicate 
the amplitudes of the other active elements. The inactive elements are left blank.

NOTE
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2.2 Part Definition Dialog Box

You can access the Part Definition dialog box (see Figure 2-33 on page 52) by clicking 

the Part and Material button ( ) on the Component toolbar.

Figure 2-33  The Part Definition dialog box

The Part Definition dialog box is subdivided into the Material Velocity, Dimensions, 
and Probe Positioning areas.
Chapter 252



DMTA-20093-01EN, Rev. D, September 2022
Material Velocity parameters

Figure 2-34  The Material Velocity parameters

The Material Velocity area (see Figure 2-34 on page 53) contains the following 
parameters:

Longitudinal/transversal waves
Sets the velocity of the longitudinal and transversal waves inside the part 
material.

In Wedge
Sets the velocity inside the wedge.

Figure 2-35  The Dimensions parameters

The Dimensions area (see Figure 2-35 on page 53) contains the following parameters:

Thickness
Defines the thickness for flat and cylindrical part types.
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Geometry
Option buttons used to select the geometry of the inspected part: Flat, 
Cylindrical, or Bar.

Probe Positioning parameters

Figure 2-36  The Probe Positioning parameters

The Probe Positioning area (see Figure 2-36 on page 54) contains the following 
parameters:

Inspection from
Defines whether the probe is positioned on the outside diameter (OD) or 
inside diameter (ID) for the inspection of cylindrical parts.

Scan orientation
Defines whether the orientation of the scan axis is Circumferential or Axial 
during the inspection.

If the part type is defined as cylindrical or bar, the Polar view type is added to the 
Contents dialog box when performing the analysis (see Figure 2-37 on page 55).

NOTE
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Figure 2-37  The Contents dialog box with the Polar view

2.3 Scan and Mechanical Settings Dialog Box

This section describes the Scan and Mechanical Settings dialog box.

2.3.1 Scan Tab

Clicking the Scan Settings button ( ) on the Component toolbar toggles open and 
close the Scan and Mechanical Settings dialog box. The Scan and Mechanical 
Settings dialog box contains four tabs: Scan, I/O, Encoders, and Data (see Figure 2-38 
on page 55).

Figure 2-38  The Scan tab for one-line scan type

Type
This list allows you to select the scan type to be used for the inspection: One-line 
scan, Free running, Bidirectional, Unidirectional, Helicoidal, Angular, or 
Custom.

Polar view
Dialog Box Descriptions 55



DMTA-20093-01EN, Rev. D, September 2022
These inspection types are described in the FocusPC User’s Manual.

Fire on
Select the trigger signal used to fire the ultrasonic pulses from the list: Encoder, 
External signal, Internal clock, or Absolute position.

Scan reset
Use to select the scan axis reset options from among the following options:

None
The scan axis is never reset.

Modulo
The scan axis is reset when the Scan encoder reaches the Stop position.

Top Turn
The scan axis is reset when an external signal is received on the 
corresponding instrument I/O connector.

Index preset
Use to select the Index axis preset options from among the following options:

None
No preset at acquisition end.

At acquisition end
When the acquisition is stopped, the Start value for the index axis is set to the 
current index axis encoder position.

Angle
If an Angular scan type is chosen, the angle between the mechanical axis and the 
scan axis can be defined.

Figure 2-39  The Scan tab with Angular scan type
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Deg./Index
If a Helicoidal scan type is chosen, this box indicates the number of degrees of 
rotation for every index position.

Figure 2-40  The Scan tab with Helicoidal scan type

Encoder
These boxes indicate the name of the encoder associated with each axis. The 
encoder names can be changed in the Encoder tab.

Start
These boxes are used to set the position on the scan and index axes where the 
inspection is to start. These values can be positive or negative.

Get
These buttons set the start value to the current encoder position for the associated 
axis.

Range
If the Range option button has been selected, these boxes are used to set the range 
on the scan and index axes.

Stop
If the Stop option button has been selected, these boxes are used to set the stop 
position on the scan and index axes.

In the case of an encoded scan, all acquisitions for which the position is outside the 
inspection surface defined by the Start values and Stop values are ignored.

NOTE
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Resolution
These boxes are used to set the acquisition resolution for the scan and index axes. 
The resolution of the scan axis determines the spacing between the acquisitions. 
The resolution of the index axis, in the case of a surface scan, determines the 
separation between the scan lines.

Optimize
This button is enabled when, in the UT Settings dialog box, the Linear merged 
mode option is selected. Depending on the selected skew angle, the optimal 
resolution for the relevant axis is automatically calculated (0° and 180° = scan axis 
resolution, 90° and 270° = index axis resolution).

Speed
Indicates the maximum allowable inspection speed that can be used without 
missing data.

Unit
These boxes are used to select the unit of the corresponding axis in mm, in., or 
deg (°).

Preset
These boxes allow you to select when the corresponding encoder is to be reset 
during the inspection:

Never
The corresponding encoder is never reset.

On start
The corresponding encoder is reset when the acquisition is started.

External
The corresponding encoder is reset when an external signal is received on the 
corresponding instrument’s I/O connector.

Preset value
These boxes specify the encoder positions to be used with the Preset option or the 
Set button.

Set
These buttons set the encoder positions to the Preset value positions for the 
associated axis.
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Apply
This button applies the current tab settings to the scan that is selected in the Scan 
name list.

2.3.2 I/O Tab

The I/O tab contains options and indicators related to the inspection sequence (see 
Figure 2-41 on page 59)

Figure 2-41  The I/O tab

The I/O tab contains the following parameters:

External Start/Stop Firing
Activates the usage of DIN3 for the Start/Stop firing function.

External Start/Stop Acquisition
Activates the usage of DIN4 for the Start/Stop acquisition function.

I/O section
The indicators in this section give the user the current status of the Rot. synchro, 
External reset, Pause acquisition, and External acquisition input/output signals.

2.3.3 Encoders Tab

The Encoders tab contains options related to the configuration of the encoders (see 
Figure 2-42 on page 60).
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Figure 2-42  The Encoders tab

The Encoders tab contains the following options:

Name
These boxes are used to select the encoder associated with the Scan and the Index 
axes, and the Alternate encoder.

You can edit the default encoder names but not when Internal is selected.

Type
These boxes are used to select the encoder type: Pulse + (positive pulse) Pulse − 
(negative pulse), Quadrature, or Clock Dir. (clock direction).

Resolution
This box is used to set the encoder resolution, that is, the number of encoder steps 
needed to move 1 mm (or 1 in.) in linear units, or 1° in angular units.

Invert
When one of these check boxes is selected, the sign of the corresponding encoder 
data is automatically inverted.

Calibrate
This button displays the Calibration of Encoder dialog box, used to calibrate the 
encoder resolution for the corresponding axis (see Figure 2-43 on page 61).
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Figure 2-43  The Calibration of Encoder dialog box

The Calibration of Encoder dialog box is subdivided into Encoder, MCDU Control, 
and Scan Axis areas:

Encoder area
Actual resolution

This box indicates the actual encoder resolution set in the Resolution box of 
the Encoders tab of the Scan and Mechanical Settings dialog box.

Invert
This check box, when selected, inverts the count direction of the encoder.

Set
This button is used to set the encoder position to the value indicated in the 
Preset value box.

Preset value
This box displays the value entered in the Preset value box on the Scan tab.
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Scan Axis

Figure 2-44  The Scan Axis area

Use rotational synchro I/O
Select this check box to use an external rotation synchronization input/output 
signal to set the beginning and end of motion used for the calibration (see 
Figure 2-44 on page 62).

Use external reset I/O
Select this check box to use an external reset input/output signal to set the 
beginning and end of motion used for the calibration.

Set Begin
This button sets the current position as the beginning of the motion used for 
the calibration.

Set End
This button sets the current position as the end of the motion used for the 
calibration.

Set Distance (box)
This box indicates the distance covered by the motion on the axis to perform 
the calibration. When the motion is done, enter the appropriate distance 
value.

Set Distance (button)
This button is used to calculate the encoder resolution so that the actual 
position matches the expected distance you specify in the box.
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The units for the scan and index axes are the same as the ones used on the Encoders 
tab, which are defined on the Scan tab.

Calculated resolution
This box gives the encoder resolution calculated with the calibration.

OK
This button applies the calculated resolution in the Resolution box of the 
Encoders tab of the Inspection Scan and Mechanical Settings dialog box, 
and closes the dialog box.

Cancel
This button closes the dialog box without applying the calculated resolution.

Clear
This button resets the parameters of the dialog box to the default values.

2.3.4 Data Tab

In the Data tab (see Figure 2-45 on page 63) you can set the automatic file saving 
options.

Figure 2-45  The Data tab

The Data tab contains the following parameters:

File Naming Options parameters
Directory

Using this box, you can specify the directory, with its complete path, that is 
then used for the automatic file naming. You can enter the directory name 
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either by typing it directly into the box, or by clicking  and selecting the 
directory in the Browse for Folder dialog box that appears.

Root name
Using this box, you can specify the root name that is to be used for the 
automatic file naming.

○ The @ character inserts a counter, which will be automatically 
incremented in the file names. For example, typing test@ will produce 
test0.fpd, test1.fpd, test2.fpd, and so on.

○ The # character adds the desired number of digits for repeats. For 
example, typing test@## will produce test000.fpd, test100.fpd, 
test200.fpd, and so on.

○ If a file already exists (for example, test000.fpd), then the new file will be 
saved with the following name: test001.fpd (first repeat of the test000.fpd 
file name).

Counter value
This box sets the start value of the counter that is inserted in the file name 
with the @ character.

Automatic
Selecting this option button activates automatic file naming that does not 
require your confirmation.

Prompt
Selecting this option button deactivates the automatic file naming. With this 
option, the Save As dialog box appears at the end of the inspection, 
prompting you to enter the file name you want.

Confirm
Selecting this option button activates automatic file naming that requires your 
confirmation. With this option, the Save As dialog box appears at the end of 
the inspection, prompting you to confirm the file name defined in the Root 
name box.

Continuous inspection
Activates the continuous inspection mode.

The continuous inspection mode lets you avoid interruptions of the 
inspection sequence during the inspection of very large parts. It enables 
automatic data file saving, which permits data files to be continuously 
produced during inspection, resulting in significant time savings.
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Show file size
Activates the display of the data file size when an inspection is started.

When the continuous inspection mode is activated, the following data files are 
generated during the inspection process:
— A series of 700 MB data files containing the A-scan and C-scan data for each 

subsection of the inspected part
— A data file containing the C-scan data of the fully inspected part
To optimize the offline data visualization, the subsections are divided using the 
following logic:
— If you are working in One-line scan or Helicoidal scan modes, the 

subsections are only divided along the index axis of the inspected part (see 
Figure 2-46 on page 65).

Figure 2-46  The subsections for One-line scan and Helicoidal scan modes

— If you are working in Bidirectional scan mode, the subsections are divided 
along both the index and the scan axes of the inspected part, which lets you 
avoid smaller parts next to the inspected part (see Figure 2-47 on page 66).

Index

Scan
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Figure 2-47  The subsections for Bidirectional scan mode

2.4 View Properties Dialog Box

Clicking the View properties button ( ) on the toolbar toggles open and close the 
View Properties dialog box (see Figure 2-48 on page 66). The appearance of tabs 
depends on the data type in the active view. If the tab parameters are not applicable to 
a selected view, the tab does not appear in the View Properties dialog box.

Figure 2-48  The View Properties dialog box

2.4.1 Information Tab

The Information tab (see Figure 2-49 on page 67) contains commands that can be 
applied to the active view or layout.

Index

Scan
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Figure 2-49  The Information tab

The Information tab contains the following parameters:

Title
This box identifies the title of the active view and can be used to change titles.

Bookmark
This box can be used to define the text to be displayed inside a pane when a view 
isn’t available on the current data file.

Reset
Clicking on the Reset button resets the Title to its original value, and also 
removes any defined Bookmark.

Apply
When the bookmark contains code for advanced layout association, clicking this 
button applies the bookmark code. This button is disabled by default for standard 
users.

Save Layout
Saves the modifications made to the current layout.

Save Layout As
Opens the Save Current Layout As dialog box, used to save the current layout 
under the number and name of your choice.

2.4.2 Display Tab

The Display tab contains various options to modify the active view display and will 
change depending on the active view type (see Figure 2-50 on page 68).
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Figure 2-50  The Display tab for an A-scan view

The Display tab is subdivided into Cursors, Zooms and Rulers, Grid, Group Gates, 
and Configuration areas.

Cursors parameters
This area contains check boxes used to select display options related to the 
cursors (see Figure 2-51 on page 68).

Figure 2-51  The Cursors parameters

Ref., Meas, and Gate
Selecting one of these check boxes adds the Reference, Measurement, or Gate 
cursors to the view. Depending on the active view, these cursors can include:

Scan
Cursor for the scan axis.

Index
Cursor for the index axis.

USound
Cursor for the ultrasonic axis.

Ampl.
Cursor for the amplitude axis.
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Autotrack
Autotracking measurement cursor that displays the amplitude of the 
ultrasonic cursor position.

TOFD
Hyperbolic cursor for time-of-flight diffraction.

Polar coordinates
Polar cursors (available only when Polar view is active).

Meas.
Adds the measurement cursors to the view (see previous Ref. check box).

Gate
Adds the gate cursors to the view (see previous Ref. check box). The gate 
cursors are black cursors showing the position of the gate selector.

Zooms and Rulers parameters

Figure 2-52  The Zooms and Rulers parameters

The Zooms and Rulers area has the following check boxes (see Figure 2-52 on 
page 69):

Ultrasound Enabled/Amplitude Enabled
This check box enables the zoom bar on the ultrasound/amplitude axis.

Zoom bar
Adds a zoom bar to the corresponding axis in the active view.

Ruler
Adds a ruler to the corresponding axis in the active view.
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Grid parameters

Figure 2-53  The Grid parameters

The Grid area has the following check box (see Figure 2-53 on page 70):

Show
The Show dialog box enables the grid on the active A-scan view, and the 
Coarse, Medium, and Fine options are used to customize the grid density.

Polar View Image Processing parameters

Figure 2-54  The Polar View Image Processing parameters

Depending on the resolution on the scan or index axis, there might be positions where 
no data is shown because of the limited size of the color-coded A-scan line. You can 
use the Peak holding or Interpolation image processing algorithms to fill these gaps 
(see Figure 2-54 on page 70).

Peak holding
This algorithm looks for a maximum in amplitude and spreads this value 
over the selected number of samples (must be less than or equal to 50). This 
algorithm is optimized for Polar views constructed from C-scan data.
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Interpolation
This algorithm improves the visual representation of a view by filling the 
gaps between the selected number of samples (must be less than or equal to 
50), until recorded data of a higher amplitude sample is detected. This 
algorithm is optimized for Polar views constructed from A-scan data.

Auto-Scroll Zoom parameters

Figure 2-55  The Auto-Scroll Zoom parameters

The Auto-Scroll Zoom area has the following check boxes (see Figure 2-55 on 
page 71):

Scan/Index
This activates the Auto-Scroll Zoom function for the selected axis, which 
dynamically zooms in on the active view within the specified range.

Smooth
Adds a display smoothing function to the active view.

Configuration parameters

Figure 2-56  The Configuration parameters

The Configuration area has the following check boxes (see Figure 2-56 on page 71):
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Reverse Ultrasound
Reverses the data along the ultrasonic axis (horizontal or vertical flip).

Reverse Amplitude
In an A-scan view selecting this check box reverses the data along the 
amplitude axis (vertical flip).

Rotate 90 deg
Rotates the data so that the two axes interchange.

Display TCG
Enables the time-corrected gain (TCG) display on the active A-scan view.

Reverse Horizontal/Vertical
Reverses the horizontal/vertical axis on an active Polar view.

Show part
Enables the display of the defined part on an active Polar view.

Gate selector
Adds the gate selector to the active view.

Keep 1:1 ratio
Displays the view in a way that maintains the 1:1 sample ratio of both 
displayed axes.

Reverse scan
Reverses the data along the scan axis (horizontal or vertical flip).

Reverse index
Reverses the data along the index axis (horizontal or vertical flip).

Group Gates parameters

Figure 2-57  The Group Gates parameters
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The Group Gates area has the following check boxes and buttons (see Figure 2-57 on 
page 72):

I, A, B, C, D, and S
These check boxes enable the display of the corresponding gates on the active 
A-scan.

All Gates
Show/Hide

Enables or disables the display of gates on the active A-scan view.

The Display tab for a Polar view contains additional options that are specific to this 
view (see Figure 2-58 on page 73).

Figure 2-58  The Display tab for a Polar view

The part-definition setting that is needed in order to obtain a Polar view is described 
in “Part Definition Dialog Box” on page 52.

2.4.3 Echo Dynamics Tab

An echo dynamics curve is a 2-D curve resulting from the projection of the data under 
a cursor or between cursors. The Echo Dynamics tab (see Figure 2-59 on page 73) is 
used to set the echo dynamic curve parameters.

Figure 2-59  The Echo Dynamics tab
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The Echo Dynamics tab is subdivided into the Display, Grid, Curve Construction, 
and Peak Selection for Drop Sizing (−X dB) areas.

Display area
This area encloses the display options of the echo dynamic curves (see Figure 2-60 
on page 74).

Figure 2-60  The Display area

Horizontal/vertical curve
When this check box is selected, a horizontal echo dynamic curve is displayed 
at the top or right side of the active view.

Dots only
When this check box is selected, echo dynamic curves are displayed with 
dots.

Ref./Meas. cursor
Enables the display of the reference/measurement cursors on the echo 
dynamic curves.

Envelope
When this check box is selected, the echo dynamic curves are displayed as an 
envelope of all the curves between the cursors or the complete visible image.

Grid area

Figure 2-61  The Grid area
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The Grid area contains the following parameters (see Figure 2-61 on page 74):

The Show grid check box enables the grid on the echo dynamic curves of the 
active view. The Coarse, Medium, and Fine options can be used to customize the 
grid density.

Curve Construction area

The Curve Construction area contains the following option buttons used to select one 
of three curve construction types (see Figure 2-62 on page 75):

Figure 2-62  The Curve Construction area

Complete visible image
With this option, the echo dynamic curve is constructed with the complete 
visible image of the inspected part.

Cut along ref./data cursors
With this option, the echo dynamic curve is constructed with the cross section 
that is specified by the reference cursor.

Slice between ref. and meas. cursors
With this option, the echo dynamic curve is constructed with the slice that is 
specified by the reference and measurement cursors.

Value type
Select to build the echo dynamic curve using the Maximum or the Minimum 
value of the current area.

Peak Selection for Drop Sizing (−X dB)
The Peak Selection for Drop Sizing (−X dB) area contains three option buttons 
(see Figure 2-63 on page 76).
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Figure 2-63  The Peak Selection for Drop Sizing (-X dB) area

This area allows you to select the option that will be used for the −X dB drop 
sizing measurements on echo dynamic curves: Maximum peak in visible image, 
Maximum at reference cursor, or Maximum between ref. and meas. cursors.

2.4.4 Overlay Tab

The Overlay tab (see Figure 2-64 on page 76) is used to set the display of overlay 
drawings on the active volume-corrected view.

Figure 2-64  The Overlay tab

Show Selected Overlays
The Show Selected Overlays area contains the following parameters (see 
Figure 2-65 on page 77):
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Figure 2-65  The Show Selected Overlays area

Part/Weld/Defect Overlays
Enables the display of the selected overlay on the active volume-corrected 
view.

Filter by group and beam
Selecting this check box ensures that only the defects created on the current 
group for the active view are displayed.

Skip Overlays
Enables the display of the skips on the current view for the corrected volume 
and sector (S) views. Clearing the Top or Bottom check boxes removes the 
corresponding skips from the active view.

2.4.5 Palette Tab

The Palette tab (see Figure 2-66 on page 77) is used to set the color palette of the active 
view.

Figure 2-66  The Palette tab
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The Palette tab contains the following items: the Palette list, Edit Palette, Save 
Palette, and Load Palette buttons, the color palette, the cursors, left- and right-arrow 
buttons, the software gain slider, RF symmetrical, Reverse color order, and 
Compression palette.

Palette
This list is used to select a predefined color palette. A zone displays the 
selected color palette.

Edit Palette
Opens the Palette Editor dialog box, used to define color palettes.

Save Palette
Opens a standard Save As dialog box, used to name and save a color palette 
(.col file). The saved color palette replaces the selected palette in the Palette 
list.

Load Palette
Opens a standard Open dialog box, used to select and load a color palette 
(.col file). The loaded color palette replaces the currently selected palette in 
the Palette list.

Color palette
Displays the current color palette for the active view (see Figure 2-67 on 
page 78).

Figure 2-67  The Color Palette dialog box

Double-clicking between the cursors divides the current palette range by two 
and double-clicking outside the cursors restores the full palette range default.

Double-clicking outside the cursors restores the default full palette range, 
which goes from −100 % to +100 %.
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Left and right arrow buttons
Clicking the left- and right-arrow buttons, respectively, shifts the color palette 
range by a fine increment to the left and to the right.

Left and right double-arrow buttons
Clicking the left- and right-double-arrow buttons, respectively, shifts the color 
palette range to the left and to the right by a coarse increment.

Color palette left/right cursors
Dragging the left/right cursor sets the lower and upper limits of the color 
palette range as a percentage (linear data), or in decibels (logarithmic data).

Dragging the color palette itself sets the lower and upper limits of the color 
palette range simultaneously.

Software gain slider
Dragging the slider, or using the arrow keys, sets the software gain, which 
ranges from −100 dB to +100 dB. Clicking on the gain slider moves the slider 
by 6 dB or 6 % increments, depending on the case.

The software gain you set appears in a box to the right of the software gain 
slider. Clicking this box restores the default software gain, which is 0 dB or 
0 %.

The software gain slider is used to set a software-calculated amplitude gain, which 
leaves the acquisition data unchanged.

RF symmetrical palette
Selecting this check box makes the selected color palette symmetrical relative 
to the zero value.

Reverse color order
Selecting this check box reverses the color order in the color palette.

Compression palette
When enabled, the full color palette range is compressed between the left and 
right color palette.
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2.4.6 Data Source Tab

Using the Data Source tab (see example in Figure 2-68 on page 80), you can set the 
data source used to compute the projection displayed in a view. The contents of the 
Data Source tab changes, depending on the current type of view selected.

Figure 2-68  The Data Source tab

The Data Source tab may contain the following parameter options:

Single plane
In this mode, the view displays a single plane crossing the inspection volume. 
A single gate selector selects the cross section to display in the inspected part.

Projection, using gate selectors
In this mode, FocusPC uses all data contained between two gate selectors to 
generate the displayed image. When many samples of data must use the same 
display pixel, the highest value is used.

Link to reference cursor
This check box, when selected, links the gate selector position to the 
corresponding reference and measurement cursors. Dragging these cursors 
then causes gate selectors of other views to react accordingly.

Set gate selectors range to max.
When this check box is selected, the gate selectors are set at lower and higher 
values to display the volume of data. When this check box is selected, it is not 
possible to adjust the gate selector values at the bottom of the pane.

Scan source
Using this list, you can select the cursor (Reference cursor, Measure cursor, 
or Data cursor) that is to be used to select the A-scan along the scan axis.

Index source
Using this list, you can select the cursor (Reference cursor, Measure cursor, 
or Data cursor) that is to be used to select the A-scan along the index axis.
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2.4.7 Units Tab

The Units tab (see Figure 2-69 on page 81) is used to set the units for the four data 
dimensions, for all views displaying the same data group as the active view.

Figure 2-69  The Units tab

The Units tab contains the following parameters:

Scan/Index/USound/Amplitude
Set the scan/index/ultrasonic axis/amplitude units.

Type
This column contains the lists used to select the unit type for each parameter. 
According to the dimension, the possible unit types are the following:

Scan: Distance, Samples, Rotation.

Index: Distance, Samples, Rotation.

USound: True Depth, Half Path, Full Path, Time, Time/2, Samples, TOFD.

Amplitude: Samples, Percentage, Decibels.

Unit
This column contains the lists used to select the measurement unit for each 
parameter. According to the unit type, the possible units are the following:

Distance: True Depth, Half Path, Full Path: m, mm, in., mils.

Samples: smpl.

Rotation: deg, rad.

Time, Time/2: s, µs.

TOFD: m, mm, in., mils.

Percentage: %.

Decibels: dB.
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Precision
This column contains the lists used to select the measurement precision:

. = 0 digits after the decimal

.# = 1 digit after the decimal

.## = 2 digits after the decimal

.### = 3 digits after the decimal

Calibrate
Clicking on the Calibrate buttons opens the Mechanical Axis, Time/Full Path 
and Time/Half Path, TOFD, True Depth, or Translation/Rotation calibration 
dialog boxes.

Mechanical Axis Calibration dialog box
The Mechanical Axis Calibration dialog box (see Figure 2-70 on page 82) is 
used to calibrate the distance value on the scan or index axes.

Figure 2-70  The Mechanical Axis Calibration dialog box

The Mechanical Axis Calibration dialog box contains the following parameters:

Reference cursor/Measurement cursor
These boxes are used to set the reference and measurement cursor positions.

Distance/Resolution
These boxes indicate the distance between reference and measurement cursor 
positions along with the measurement resolution.
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Original file unit type
This line displays the original unit used in the data file.

Time / Full Path and Time / Half Path dialog boxes
The Time / Full Path and Time / Half Path dialog boxes (see Figure 2-71 on 
page 83) are used to calibrate the time value relative to the full path value and 
the half path value.

Figure 2-71  The Time / Half Path dialog box

The Time / Full Path and the Time / Half Path dialog boxes contain the following 
parameters:

What do you want to compute?
This area allows you to select which parameter should be calculated.

Velocity, Wedge Delay
These boxes indicate the sound velocity and wedge delay inside the material.

Ref. cursor position, Meas. cursor position
These boxes indicate the current reference and measurement cursor positions.

Difference
This box indicates the difference between the reference and measurement cursor 
positions.
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TOFD dialog box

The TOFD dialog box (see Figure 2-72 on page 84) is used to calibrate the ultrasonic 
axis when you use the TOFD method.

Figure 2-72  The TOFD dialog box

The TOFD dialog box contains the following parameters:

What do you want to compute?
This area contains option buttons used to select the parameter that is to be 
calculated:

Compute reference cursor position
This option is used to adapt the TOFD ruler, setting it to its zero position at 
the reference cursor position. Position the reference cursor on the first echo 
signal and then click OK.

Compute velocity and wedge delay
This option is used to calculate both the material sound velocity and the 
probe wedge delay by using two reference signals, typically the lateral wave 
and the back wall echo.
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Compute wedge delay
This option is used to calculate the probe wedge delay by using a fixed value 
of the sound velocity and one reference signal, typically the lateral wave or 
the back wall echo.

Scan axis
This area contains option buttons that can be used to select whether the scan 
axis orientation relative to the ultrasonic beam projection should be defined 
as Parallel to beam or Perpendicular to beam.

TOFD Primary Value
Reference cursor position

This box defines the real (true depth) reference cursor position in millimeters 
(mm) or inches (in.).

Probe separation
This box defines the distance between the probes in millimeters (mm) or 
inches (in.).

Sound velocity
This box defines the material sound velocity in meters per second (m/s) or 
inches per microsecond (in./µs).

Wedge delay
This box defines the probe wedge delay in microseconds (µs).

TOFD Secondary Value
Meas. cursor position

This box defines the real (true depth) measurement cursor position in 
millimeters (mm) or inches (in.).

For details on using the calibration function with the TOFD dialog box, see 
“Performing TOFD Calibration in Analysis Mode” on page 113.

True Depth dialog box

The True Depth dialog box (see Figure 2-73 on page 86) is used to calibrate the 
ultrasonic axis in true depth units.
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Figure 2-73  The True Depth dialog box

The True Depth dialog box contains text boxes (on white background) for the values 
that can be changed, or display boxes (appearing dimmed) for the values that are 
calculated from other values. The dialog box contains the following parameters:

Reflectors position
This area contains parameters used to calibrate the ultrasonic axis.

Scan 1/Scan 2
These boxes define the real scan axis position of the reference and 
measurement cursor positions in millimeters (mm) or in inches (in.).

USound 1/USound 2
These boxes defines the real (true depth) reference cursor position in 
millimeters (mm) or in inches (in.).

Diameter
This box defines the diameter of the hole used for calibration.

Angle calibration
This check box, when selected, enables the calibration of the refracted angle.
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Results
The Sound velocity, Wedge delay, Refracted angle, and Scan offset values 
displayed in this section give the values calculated from the defined parameters.

Translation/Rotation dialog box

The Translation/Rotation dialog box (see Figure 2-74 on page 87) is used to calibrate 
the translation value relative to the rotation value.

Figure 2-74  The Translation/Rotation dialog box

The Translation/Rotation dialog box contains the following parameters:

Radius
This box indicates the radius of the rotary motion.

Resolution
This box indicates the measurement resolution.

Ref. cursor/Meas. cursor
These boxes indicate the reference and measurement cursor positions.

Cursor pos. difference
This box indicates the difference between reference and measurement cursor 
positions.

Original file unit type
This line displays the original unit used in the data file.
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2.4.8 View Linking Tab

The View Linking tab (see Figure 2-75 on page 88) is used to set linking cursors types, 
rulers, palette ranges, and other settings for the active view. The particular linking 
types set for the active view override the default links set in the Linking tab of the 
Preferences dialog box.

Figure 2-75  The View Linking tab

Linked Items
The Linked Items area contains the various objects and settings that can be linked 
to the graphical tools of the other views. Selecting a check box activates the 
linking of the corresponding object or setting.

2.4.9 Rebounds Tab

The Rebounds tab (see Figure 2-76 on page 88) is used to set the skip processing 
parameters.

Figure 2-76  The Rebounds tab

The Rebounds tab contains the following items:
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Processing options
This area encloses options that are selected for the skip processing.

Skip quantity
Using these option buttons, you can select the number of skips used in the 
processing from the following: No skip, ½ skip, 1 skip, 1½ skips, or 2 skips.

2.4.10 Strip Tab

The Strip tab (Figure 2-77 on page 89) is used to set options and parameters related to 
the strip views. The Strip tab is only available when the active view is a strip view.

Figure 2-77  The Strip tab

The Strip tab is subdivided into Threshold, Amplitude/Position data, and Strip Axis 
areas.

Threshold area
This area encloses the threshold options of the strip views.

— Display threshold
When this check box is selected, the Threshold value is displayed as a black 
line in the active strip view. When the Secondary data is displayed, if the 
secondary data is below the Threshold value at a defined position, the 
associated stripe of the strip view becomes green. If the secondary data is 
above the Threshold value at a defined position, the associated stripe of the 
strip view becomes red.

— Threshold
Indicates the threshold level in amplitude or as percentage of gate length.

Amplitude/Position data area
This area encloses the amplitude/position data options for the strip views.
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— Stripe
When this option is selected, the data is represented by a colored stripe. The 
color and the length of the stripe are indicative of the amplitude or the 
position of the indication within the associated gate.

— Curve
When this option is selected, the data is represented by a curve.

— Full stripes
When this check box is selected, the data is represented by a colored stripe 
with its length at full-view height. The color of the stripe is indicative of the 
amplitude or position of the indication within the associated gate.

— Secondary data
Using this list, you can choose secondary data to be displayed in the active 
strip view. Depending on the number of gates, the data type recorded, and 
the active strip view, the Secondary data and the different gate’s amplitude 
and position data.

Strip axis area
This area allows you to select whether the strip view should be constructed along 
the scan or index axis (available in Analysis mode only).

2.5 Preferences Dialog Box

You can customize various FocusPC parameters using the Preferences dialog box (see 
Figure 2-78 on page 91). You can access the Preferences dialog box by selecting File > 
Preferences on the menu.

The Preferences dialog box is not available in the FocusPC Viewer edition.

2.5.1 General Settings Tab

This section contains descriptions of the parameters in the General Settings tab of the 
Preferences dialog box (see Figure 2-78 on page 91).
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Figure 2-78  The General Settings tab of the Preferences dialog box

Default Measurement System
Select Metric or US Cust. to respectively use the metric or the US customary 
measurement systems for all FocusPC parameters and views. You can configure 
units in more detail for each view in the Properties dialog box, in the Units tab.

Acquisition File Properties
Use Max Size to set the maximum size of the acquisition file. The maximum size 
of a data file that can be recorded with FocusPC is 2 GB.

Acquisition Mode
Select the Bypass analysis check box to bypass the online Analysis mode so that 
you immediately go to the Setup mode at the end of the acquisition.

Interface
Select the Expert mode check box to activate advanced features (refer to the 
FocusPC User’s Manual for details).

Zoom Scroll
You can scroll the vertical zoom bars on the selected view using the wheel of the 
mouse. Holding the CTRL key while moving the wheel scrolls the horizontal 
zoom bar. The axis range percentage value indicates the magnitude of the zoom 
bar displacement for one tick of the mouse wheel.

Dialog Bypass
Select the check box for the dialog boxes (Startup Selection or Configuration 
Selection) that you want to bypass at startup. These options may be useful when 
you always use the same setup and want to avoid acknowledging the default 
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setup, or when you remotely control FocusPC and you cannot respond to the 
dialog boxes.

Amplitude drop
Set the amplitude-drop negative value for the three axes to be used for flaw sizing 
with the Zone tool.

Peak Holding Algorithm
Set the number of samples to be used in the peak holding algorithm for the three 
axes for flaw sizing with the Zone tool. A setting of n samples means that the 
algorithm ignores an amplitude drop below −x dB along the axis if it is smaller 
than n samples.

Reset all Message Box Status
Click this button to reactivate all messages for which the Do not show again 
check box was selected.

Fill Acquisition Gaps
Select the check box to activate the function that fills data acquisition gaps when 
performing amplitude-drop sizing measurements for each of the two axes.

Bookmark
The Enable editing check box is disabled because its use is reserved for Evident.

Auto Select Pod
The Auto Select Pod feature can be used to automatically boot FocusPC when the 
selected number of instruments have been detected.

Abs. Mode 
Select the Mirror Gate check box to activate a positive and negative A gate in RF 
mode. 

C-Scan
On an amplitude C-scan, FocusPC normally does not show signal amplitudes that 
are below the gate level, replacing these values by no detection codes.

Select the Always record amplitude in analysis check box when you want to 
configure FocusPC to show this signal in Analysis mode, after moving the gate. 
Select Always record amplitude in acquisition if you want the amplitude data to 
be shown whether or not the signal has crossed the gate (thereby ignoring the no 
detection codes).
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2.5.2 Linking Tab

The Linking tab of the Preferences dialog box (see Figure 2-79 on page 93), accessible 
from the File > Preferences menu selection, contains parameters to customize the 
linking features in FocusPC.

When an element is linked, changing it in one context (view, group, gate) 
automatically changes it identically in the other linked contexts. For example, with the 
Scan cursors set to Fully linked, moving the reference cursor on the scan axis in one 
view, moves it to the same position in all the other views. The linking feature can save 
you a large number of tedious adjustments when you work with multiple views, 
multiple groups, and multiple gates. You can set the cursor and ruler linking behavior 
differently for uncorrected and corrected views.

Figure 2-79  The Linking tab of the Preferences dialog box

The following linking behaviors are available with other views:

Unlinked
The selected item is not linked.

Linked per gate
The selected item is linked per gate.

Linked per group
The selected item is linked per group.

Fully linked
The selected item is linked for all gates and all groups.
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Linked with uncorrected
The selected item is linked as defined under Uncorrected Views.

FocusPC classifies an A-scan as an uncorrected view, even when the ultrasound axis is 
set to True Depth mode.

NOTE
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3. Advanced Analysis Using FocusPC

This chapter describes how to use the multiple advanced analysis features available in 
FocusPC.

3.1 Thickness C-Scan Process

A thickness C-scan is a part thickness color illustration used to highlight thickness 
variations. This view is useful for the monitoring of part wear or corrosion.

To create a thickness C-scan

1. On the Component toolbar, click the Thickness C-scan button ( ).
2. In the Create Thickness C-scan dialog box (see Figure 3-1 on page 960), proceed 

as follows:
a) In the Groups list, select the group to create a thickness C-scan.
b) In the Thickness types list, for example, select A ^ - I/.
c) To customize the color palette limits, in the Thickness gate area, select 

Override with user values, and then set Min. and Max. parameters to the 
desired values.

d) Click Create.
e) Click Done.

3. Choose a view in a layout to be configured as a thickness C-scan.

4. On the Component toolbar, click the Add View Content button ( ).
5. In the Contents dialog box, select a thickness C-scan view (see Figure 3-2 on 

page 96).
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Figure 3-1  The Create Thickness C-scan dialog box

Figure 3-2  Selecting a thickness C-scan view

The thickness C-scan illustration appears in the view (see example in Figure 3-3 on 
page 97).
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Figure 3-3  Example of a thickness C-scan

3.2 Volumetric Merge Process

A FocusPC view can only display the data of one data group. The volumetric merge 
function condenses the information of several groups into one group, so that you can 
view more information in a single view.

In Analysis mode, you can use the volumetric merge function to perform a merge of 
the ultrasonic data acquired with various groups. The merging process compares the 
amplitude obtained at each point of the inspected volume by the considered groups, 
and creates a new data group with the maximum amplitude observed at each position 
in the inspected volume.
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The volumetric merge function is a wizard that takes you step by step through the 
merging configuration process. You can save the configuration defined with the 
wizard in a volumetric merge configuration file (.vmc), and recall the file to quickly 
perform a similar volumetric merge. See “Performing a Volumetric Merge” on 
page 98 for details on the volumetric merge configuration file format.

FocusPC saves the created merged data in the attributes file (.A01) that is saved as 
part of the data file (.fpd).

You can also use the automatic volumetric merge that uses the default volumetric 
merge parameters, thus bypassing the steps of the volumetric merge wizard. All 
groups (except TOFD groups) are merged together, but the original data is always 
preserved (see “Performing an Automatic Volumetric Merge” on page 100).

3.2.1 Performing a Volumetric Merge

The volumetric merge function is a wizard that takes you step by step through the 
merging configuration process.

To perform a volumetric merge

1. Open a data file containing more than one beam or more than one data group.

2. On the Component toolbar, click the Volumetric Merge button ( ).
The Volumetric Merge wizard starts.

3. Under Available Data Groups (see Figure 3-4 on page 99), select which beams or 
groups to merge:
a) In the type selection box, select the beam or group type to be displayed in the 

Available Data Groups list.
b) In the Available Data Groups list, select the beams and groups you wish to 

merge, and then click Add.
The selected beams or groups appear in the Selected Data Groups list.

c) Click OK.
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Figure 3-4  The Volumetric Merge dialog box

The volumetric merge function does not work when a cylindrical specimen is defined. 
Also, it is impossible to merge different data types together (for example, A-scan with 
C-scan).

4. Type a name in the Destination Group Name box.
5. If necessary, modify the merge dimensions (Start, Stop, and Resolution) for the 

three axes.
6. Click OK.

The merged group is added to the contents (see Figure 3-5 on page 100).

NOTE
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Figure 3-5  Example of the volumetric merge group created

3.2.2 Performing an Automatic Volumetric Merge

The automatic volumetric merge function performs the volumetric merge of all beams 
in the currently selected file using the default values of the Volumetric Merge dialog 
box (see “Performing a Volumetric Merge” on page 98). The merge process transforms 
the sectorial group data into bitmap images of end-view slices.

To perform an automatic volumetric merge

1. Open the file on which you wish to perform a volumetric merge.

2. On the Component toolbar, click the Automatic Volumetric Merge button ( ).
The merged data groups are added to the view Contents list.

3.2.3 Performing an Automatic Volumetric Merge by Group

The automatic volumetric merge by group function performs the volumetric merge of 
all beams for each group using the default values of the Volumetric Merge dialog box 
(see “Performing a Volumetric Merge” on page 98) and creates one merged data 
group per group.

To perform a volumetric merge by group

1. Open the file on which you wish to perform a volumetric merge.
2. On the Component toolbar, click the Automatic Volumetric Merge by Group 

button ( ).
The merged data groups are added to the view Contents list.
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3.3 Customizing Readings

Readings can be customized in Analysis mode in the same way as in Setup mode. For 
details on how to customize readings, refer to the FocusPC User’s Manual.

3.4 Amplitude Drop Sizing Utility

You can use FocusPC to display the various readings related to the active data file and 
the data views (see “Customizing Readings” on page 101). With user-defined flaw 
sizing settings, you can use some of these parameters to get information on the 
position and the size of a flaw indication.

3.4.1 Defining or Modifying Flaw Sizing Settings

The View Information parameters, related to indication sizing, allow for −X dB 
amplitude-drop sizing of a flaw indication in its three dimensions simultaneously 
(scan, index, and ultrasonic axes). The value of X can be defined independently for 
each axis.

To define or modify the flaw sizing settings

1. On the menu, select File > Preferences.
2. In the Flaw sizing settings area of the General Settings tab (see Figure 3-6 on 

page 102), perform the following steps:
a) In the Amplitude drop (−X dB) area, enter the -X value for each axis 

independently (only negative values are accepted).
b) In the Peak holding algorithm area, enter the number of samples to be used 

for the peak holding algorithm for each axis independently.
The default value is 0, but if for a given axis a value n larger than 0 is entered, 
the sizing algorithm, along this axis, “ignores” an amplitude drop below -X 
dB that is smaller than n samples. This tool can be used to group several 
flaws, or to avoid the problems related to the use of nonsmoothed A-scan 
signals.

c) If the check boxes are selected in the Fill acquisition gaps area, the sizing 
algorithm ignores the missing acquisition points or lines along the considered 
axis by interpolating between the adjacent valid acquisition points or lines.
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Figure 3-6  The General Settings tab

Applying the peak holding algorithm, for a given axis, can oversize the indication by 
2 × n samples for this axis.

3.4.2 Determining the Location and Dimensions of Flaw Indications

The View Information parameters can be used not only to determine the dimensions 
of a flaw indication using −X dB amplitude-drop sizing, but also to determine the 
location of the flaw indication in the inspected volume. The following procedure uses 
the Zone tool of the FocusPC software.

To determine the location and dimensions of a flaw indication in 3-D

1. Create a suitable display layout, showing at least the Top (C), Side (B), or the End 
(D) views.

2. In one of the displayed views display the parameters (as shown in Table 3 on 
page 102).

Table 3  Parameters for flaw indication 

Parameter Description

Z. Max. Ampl. Zone maximum amplitude

NOTE
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These readings can be found in the Statistics > Zone category of the Information 
Groups dialog box (see Figure 3-7 on page 104). Note that the Expert mode must 
be activated for these readings to be available (refer to the FocusPC User’s 
Manual).

Z. Max. Scan Pos. Zone maximum amplitude position on the scan 
axis

Z. Max. Index Pos. Zone maximum amplitude position on the index 
axis

Z. Max. UT Path Pos. Zone maximum amplitude position on the 
ultrasonic axis

Z. Scan1 −X dB Position 1 along the scan axis of “maximum 
amplitude −X dB” position

Z. Scan2 −X dB Position 2 along the scan axis of “maximum 
amplitude −X dB” position

Z. Index1 −X dB Position 1 along the index axis of “maximum 
amplitude −X dB” position

Z. Index2 −X dB Position 2 along the index axis of “maximum 
amplitude −X dB” position

Z. USound1 −X dB Position 1 along the ultrasonic axis of “maximum 
amplitude −X dB” position

Z. USound2 −X dB Position 2 along the ultrasonic axis of “maximum 
amplitude −X dB” position

Z. Scan2 − Scan1 −X dB Length of the flaw indication at −X dB along the 
scan axis

Z. Index2 − Index1 −X dB Length of the flaw indication at −X dB along the 
index axis

Z. USound2 − USound1 
−X dB

Length of the flaw indication at −X dB along the 
ultrasonic axis

Table 3  Parameters for flaw indication (continued)

Parameter Description
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Figure 3-7  Statistics parameter category of the Information Groups dialog box

3. Display and examine the area of recorded data that is of interest (see Figure 3-8 on 
page 105).
Chapter 3104



DMTA-20093-01EN, Rev. D, September 2022
Figure 3-8  Data display examples

4. Position the gate selectors for the ultrasonic axis so that the flaw indication to be 
sized is located between the gate selectors.

5. Create a zone in the Side (B) view [or End (D) view] containing the considered 
flaw indication.

6. Create a zone in the Top (C) view containing the considered flaw indication.
7. The zone in the Side (B) or End (D) view is automatically adjusted to the gate 

selector limits. You have now created a volumetric zone defined by the contour in 
the Top (C) view and the gate selectors in the ultrasonic axis (see Figure 3-9 on 
page 106). The parameters in the Information Groups dialog box give the 
maximum amplitude of the flaw indication, its position along each axis, and its 
size along each axis, with the user-defined amplitude drop value.
Advanced Analysis Using FocusPC 105



DMTA-20093-01EN, Rev. D, September 2022
Figure 3-9  Examples of flaw indication sizing with the zone tool
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3.5 Gain Information Component

The Gain Information dialog box (see Figure 3-10 on page 107) is used to monitor the 
different gain settings, and to adjust the software gain applied to the signal and/or the 
color palette settings in either Setup or Analysis mode.

Figure 3-10  The Gain Information dialog box

The Gain dialog box displays the current color palette. Double-clicking between the 
top and bottom cursors reduces the current palette range by a factor of two. Double-
clicking outside the cursors restores the default full-palette range.

Dragging the top or bottom color palette cursors, respectively, sets the upper and 
lower limits of the color palette range in percentage (linear data), or in decibels 
(logarithmic data). Dragging the color palette itself sets the lower and upper limits of 
the color palette range.

Dragging the slider, or using the arrow keys, sets the software gain, which ranges 
from −100 dB to +100 dB. The software gain slider sets a software-calculated 
amplitude gain that is applied to both the displayed images and the amplitude values 
in the readings, but leaves the raw acquisition data unchanged.

When negative software gain is applied to ultrasonic data, pixels over 100 % FSH keep 
applicable color code for saturation and the corresponding information view keeps 
returning 100 % for the signal amplitude.

Software gain slider

Top color palette cursor

Bottom color palette cursor
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To add or remove software gain

1. Select the view for which you want to modify the gain information.

2. On the Component toolbar, click the Soft Gain Tool button ( ).
The Gain Information dialog box appears (see Figure 3-10 on page 107).

The Hard Gain (dB) information box indicates the applied hardware gain. This 
information can be modified in the UT Settings > General dialog box.

3. Use one of the following methods to modify the software gain:
— Move the software gain slider cursor up or down using the mouse.
— Click in the Gain Information dialog box and use the up and down keyboard 

arrow keys to increase or decrease the software gain in 0.1 dB increments.
— Click above or below the slider cursor ( ) to increase or decrease the 

software gain in 6 dB increments.
— Click on the Soft Gain (dB) button to set the software gain.
— On the color palette, double-click between the cursors to divide the current 

palette range by two, or outside the cursors to restore the default full palette 
range.

3.6 TOFD Manager Component

The TOFD Manager is a complete tool for time-of-flight diffraction (TOFD) 
inspections that performs both basic and advanced analysis of TOFD examination 
data. Using the TOFD Manager, you can perform online and offline TOFD 
calibrations with either conventional or phased array probes.

You can also use the TOFD Manager to perform advanced analysis using typical 
TOFD cursors, algorithms for both lateral wave synchronization (straightening) and 
lateral wave removal, and a synthetic aperture focusing technique (SAFT) algorithm. 
All processing algorithms are developed to leave the raw inspection data unaffected. 
However, all processed data can be saved in separate data groups in the attributes file 
(.A01).

NOTE
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You can open the TOFD Manager by clicking the TOFD Manager button ( ) on the 
Component toolbar. The TOFD Manager dialog box is shown in Figure 3-11 on 
page 109.

Figure 3-11  The TOFD Manager dialog box

In the Information Groups dialog box, when the Expert mode is active, a TOFD 
group of readings is available (see Figure 3-12 on page 109) for fast and easy length 
and through-wall sizing of indications in combination with the indication table (refer 
to the FocusPC User’s Manual).

Figure 3-12  The TOFD readings in the Information Groups dialog box
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3.6.1 TOFD Manager Dialog Box

This section describes the parameters in the TOFD Manager dialog box (see 
Figure 3-13 on page 110).

Figure 3-13  The TOFD Manager dialog box

Analysis Tools
Specifies parameters for the calibration of the ultrasonic axis (depth) for TOFD 
data.

Focalization Process
Allows the operator to use the SAFT algorithm on TOFD data.

Lateral Wave Processing
Specifies parameters for lateral wave processing (synchronization and removal).

3.6.1.1 Analysis Tools Parameters

The Analysis tools area contains the following button:

Calibration
Opens the TOFD dialog box in order to perform TOFD calibration (see 
Figure 3-14 on page 111).
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Figure 3-14  The TOFD dialog box

The TOFD dialog box contains boxes (on a white background) for the values that can 
be changed, or display boxes (appearing dimmed) for the values that are calculated 
from the other values. The dialog box contains the following elements:

What Do You Want To Compute?
This area contains option buttons used to select the parameter that is to be 
calculated from the other parameters.

Compute reference cursor position
This option is used to adapt the TOFD ruler to set its zero position at the 
reference cursor position. Position the reference cursor on the first echo 
signal, and then click OK.

Compute velocity and wedge delay
This option is used to calculate both the material sound velocity and the 
probe wedge delay, by using two reference signals, typically the lateral wave 
and the back wall echo.
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Compute wedge delay
This option is used to calculate the probe wedge delay, by using a fixed value 
of the sound velocity and one reference signal, typically the lateral wave or 
the back wall echo.

Scan Axis
This area contains option buttons used to select the scan axis orientation 
relative to the ultrasonic beam projection: Parallel to beam or Perpendicular 
to beam.

TOFD Primary Value
Reference cursor position

This box defines the real (true depth) reference cursor position in 
millimeters (mm) or inches (in.).

Probe separation
This box defines the distance between the probe exit points in millimeters 
(mm) or inches (in.). This distance is always measured along the 
component surface.

Sound velocity
This box defines the material sound velocity in meters per second (m/s) or 
inches per microsecond (in./µs).

Wedge delay
This box defines the probe wedge delay in microseconds (µs).

3.6.1.2 Lateral Wave Processing Parameters

The Lateral wave processing area (see Figure 3-13 on page 110) contains the 
following options:

Reference position
This box indicates the position, on the scan axis, of the selected reference A-scan.

Set Reference
This button sets the reference A-scan defined by the reference cursor position.

Complete visible image
When this option is selected, the processing is done on the complete image.
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Slice between ref. and meas. cursors
When this option is selected, the lateral wave synchronization, or lateral wave 
removal, is performed on the A-scans enclosed between the reference and the 
measurement cursors on the displayed Side (B) view.

LW Removal
This button performs the lateral wave (LW) removal process on the data group in 
the active view, and creates a new data group containing the processed data.

LW Synchronization
This button performs the lateral wave synchronization process on the data group 
in the active view, and creates a new data group containing the processed data.

3.6.1.3 Focalization Process Parameters

The Focalization process area contains the following elements:

Aperture size
This box indicates the aperture of the SAFT algorithm, which is the total number 
of A-scans used to calculate the processed A-scan. The value is always odd, and is 
determined by the position of the cursors on the active Side (B) view.

SAFT
This button performs the SAFT (synthetic aperture focusing technique) algorithm.

3.6.2 Performing TOFD Calibration in Analysis Mode

This section provides a description on how to use the TOFD calibration of the TOFD 
Manager component in Analysis mode. For information on how to perform TOFD 
calibration in Setup mode, refer to the FocusPC User’s Manual.

To perform a TOFD calibration in Analysis mode

1. Open a data file (.fpd).
2. Display a Side (B) view.
3. Position the reference cursor at the start of the lateral wave signal.
4. Position the measurement cursor at the start of the back wall signal.
5. On the View Properties > Units dialog box, in the Type list of the USound axis, 

select TOFD.

6. On the Component toolbar, click the TOFD Manager button ( ).
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7. In the TOFD Manager dialog box (see Figure 3-13 on page 110), select the 
appropriate options, and then enter the appropriate values (see “TOFD Manager 
Dialog Box” on page 110).

If you select the Compute velocity and wedge delay option button in the What do 
you want to compute area of the TOFD dialog box, the measurement cursor has to be 
positioned on a second reference signal (for example, a lateral wave).

8. Click OK.
The ultrasonic axis is now calibrated in Analysis mode.

3.6.3 Performing Data Processing of TOFD Files

Although the functionality and mathematical correctness of all processing algorithms 
have been thoroughly checked and validated, no guarantees in terms of flaw 
detection and sizing performances can be given. The performance enhancement 
provided by a processing algorithm is definitely related to the specificity of each 
application, and is therefore the responsibility of the user.

3.6.3.1 Lateral Wave Synchronization

This section describes how to synchronize the lateral wave of a TOFD group.

Calibrate the TOFD group prior to applying the lateral wave synchronization 
algorithm.

To synchronize the lateral wave of a TOFD group

1. Open a data file (.fpd).

NOTE

IMPORTANT

IMPORTANT
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2. Select the Side (B) view on which you want the lateral wave synchronization to be 
applied.

3. In the Side (B) view, position the reference (red) cursor to select a reference A-scan 
in an unflawed zone (see Figure 3-15 on page 115).

4. In the Side (B) view, position the ultrasonic reference cursor and the ultrasonic 
measurement (blue) cursor on either side of the lateral wave signal (see 
Figure 3-15 on page 115). Appropriate setting of the cursors determines the result 
of the operation.

Figure 3-15  Selection of a reference A-scan

5. In the TOFD Manager dialog box, in the Lateral Wave Processing area, click Set 
Reference.
By default, the lateral wave synchronization is applied to the Complete visible 
image, but alternatively, the Slice between Ref. and Meas. cursors option can be 
selected if appropriate for the considered TOFD data.

Scan reference cursor

Representative A-scan

Ultrasonic reference and measurement cursors
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6. Click LW Synchronization.

7. Click  (Add View Content) and display the newly created LWS. The lateral 
wave is now synchronized (see Figure 3-16 on page 116).

Figure 3-16  TOFD data after lateral wave synchronization

3.6.3.2 Lateral Wave Removal

This section describes how to remove the lateral wave of a TOFD group.

In order to obtain usable results from the lateral wave removal algorithm, it is 
mandatory to apply the algorithm to previously synchronized data.

To remove the lateral wave of a TOFD group

1. Click  (Add View Content) and display the lateral wave synchronized data.

IMPORTANT
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2. In the Side (B) view, position the scan reference (red) cursor to select a reference 
A-scan in an unflawed zone (see Figure 3-17 on page 117). If the selection of the 
reference A-scan is correctly performed prior to the lateral wave synchronization, 
this operation does not need to be repeated.

3. In the Side (B) view, position the ultrasonic reference cursor (red) and the 
ultrasonic measurement cursor (blue) on either side of the lateral wave (see 
Figure 3-17 on page 117). If the lateral wave signal shows a lot of variation, it is 
important to position the cursors around the first oscillation of the lateral signal.

Figure 3-17  Selection of reference A-scan

4. In the TOFD Manager dialog box, in the Lateral wave processing area, click Set 
Reference.

Scan reference cursor

Representative A-scan

Ultrasonic reference and measurement cursors
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By default, the lateral wave removal is applied to the Complete visible image, 
but alternatively the Slice between Ref. and Meas. cursors option can be selected 
if appropriate for the considered TOFD data.

5. Click LW Removal.

6. Click  (Add View Content) and display the newly created LWR. The lateral 
wave is now removed (see Figure 3-18 on page 118).

Figure 3-18  TOFD data after lateral wave removal

3.6.3.3 SAFT Processing

The synthetic aperture focusing technique (SAFT) is a computer enhanced imaging 
technique for the detection and characterization of discontinuities. The technique 
takes advantage of the nonlinear phase shift of a reflection as a discontinuity is 
linearly scanned. Improved lateral resolution and a higher signal-to-noise ratio are 
achieved by using this phase shift, mathematically simulating the focusing of an 
ultrasonic lens that is focused on every point in an inspected part.
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The SAFT algorithm can be applied either to raw TOFD data or to processed TOFD 
data. It is the responsibility of the data analyst to select the best combination for a 
given application.

To apply the SAFT algorithm

1. Select the Side (B) view on which you want to apply the SAFT algorithm.
2. In this Side (B) view, perform the following procedure in order to select the 

adequate aperture to be used for the SAFT algorithm:
a) Zoom in on a zone of interest containing a punctual TOFD indication (see 

Figure 3-19 on page 120), showing the typical parabolic shape.
b) Position the reference and measurement cursors on either side of the flight-

time minimum of the indication, so that the indication remains clearly visible 
at the selected scan axis positions; the SAFT algorithm tends to smooth out 
and eventually erase indications if too large an aperture is used.

IMPORTANT
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Figure 3-19  Definition of the aperture

3. The SAFT aperture as defined by the positions of the cursors is displayed in the 
TOFD Manager dialog box, in the Focalization process area.

4. In the TOFD Manager dialog box, in the Focalization process area, click SAFT.

5. Click  (Add View Content) and display the newly created SAFT.
The SAFT algorithm has been applied (see Figure 3-20 on page 121).

Scan reference and measurement cursors
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Figure 3-20  Overview of a SAFT ultrasonic image

As the SAFT algorithm involves averaging, which tends to smooth out high 
amplitudes, the use of a higher Software Gain value could be helpful to optimize 
the visualization of the processed data.

3.7 C-Scan Merge Process

In the Analysis mode, you can use the C-scan merge component to merge C-scan data 
acquired with various groups and/or beams.

The merge process compares the minimum amplitude, the maximum amplitude, or 
the minimum position obtained at each point of the inspected part acquired by the 
considered groups and/or beams. It then creates a new data group with the above 
mentioned criterion. FocusPC also saves the created merged data in the Attributes file 
(.A01).

With the C-scan merge component, you can do the following:
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• Merge multiple C-scan images from different data files (see Figure 3-21 on 
page 122).

• Merge C-scan images from different gates (even if you modified the gate position 
and length). This can be used for multilayered parts with bonding (see Figure 3-22 
on page 123).

• Merge Amplitude C-scans and preserve maximum amplitude (for indication 
detection) or minimum amplitude (for back wall attenuation monitoring).

• Merge minimum position C-scans.

Figure 3-21  Example of two merged files
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Figure 3-22  Gate A and Gate B C-scan merging example

To merge C-scan data

1. Open the file containing the data that you want to merge.

2. On the Component toolbar, click the C-Scan Merge button ( ).
3. In the C-Scan Merge dialog box (see Figure 3-23 on page 124), select the data 

groups:
a) In the Data Selection box, select the data that you want to preserve in the 

merge.
b) In the Available data groups list, hold down the SHIFT key (or CTRL key) 

and click to select the groups that you want to merge, and then click Add.
The selected groups appear in the Selected data groups list.

Gate A C-scan Gate B C-scan

Merged Gate A and Gate B C-scans
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Figure 3-23  Example of the C-Scan Merge dialog box

4. Complete the merge settings:
a) In the Scan Axis and Index Axis areas, set the Start and Stop dimensions for 

the merge.
b) In the Destination Group Name box, type the desired group name for the 

merged data.
c) Click OK.

The merged group is added to the contents.
5. To display the merged group (see Figure 3-24 on page 125), do the following:

a) Select the view where you want to display the merged C-scan.

b) On the Component toolbar, click the Add View Content button ( ).
c) In the Contents dialog box, in the list on the left, select the created C-scan 

merged group.
d) In the list on the right, double-click the corresponding view to display.

The selected data appears in the view.
e) Close the Contents dialog box.
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Figure 3-24  Example of the C-scan merge group created

3.8 SNR Analysis Component

FocusPC includes a signal-to-noise ratio (SNR) function. You can use the SNR 
Analysis Utility to calculate the indication surface area above the noise level.

The SNR function is available in Analysis mode. The SNR function is used for 0-
degree inspections, often for aerospace industry parts. You can use the function on 
Top (C), amplitude C-scan, and position C-scan views.

3.8.1 Using the SNR Analysis Utility

This section contains a step-by-step procedure for using the SNR function in FocusPC.

To use the SNR Analysis Utility

1. Start the SNR Analysis Utility by clicking the SNR Analysis button ( ).

2. On the Component toolbar, select the Zone tool ( ), and then draw a rectangle 
over a zone representing a noise reference area (see Figure 3-25 on page 126).
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Figure 3-25  Selecting the noise reference area with the Zone tool

3. In the SNR Analysis Utility dialog box, click Retrieve (see Figure 3-26 on 
page 127).
FocusPC calculates the mean and the standard deviation value for the reference 
area, and displays a distribution chart of the number of pixels as a function of the 
signal amplitude.

Drawing a rectangle 
around a reference 
noise area
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Figure 3-26  Example of reference area analysis results

4. On the C-scan view, move the reference cursor and the measurement cursors 
around an indication for which you know the area (see Figure 3-27 on page 128).

Calculated mean and 
standard deviation for the 
reference area selected 
with the Zone tool

Number of pixels versus
signal amplitude chart
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Figure 3-27  Positioning the cursors around the defect area

5. In the SNR Analysis Utility dialog box, use the K parameter slider to adjust the 
defect area value so that it corresponds with the known area of the defect (see 
Figure 3-28 on page 129).
For this example, if the reference defect area is 246 mm2, the K value must be 
22.62.

Known defective area
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Figure 3-28  Adjusting the K value

6. Now that the K value has been set on a reference defect, move the cursors to size 
other indications.
The defect area value is represented by the set of pixels above the amplitude of 
the lower threshold or the higher threshold (see Figure 3-30 on page 131).

7. To quickly visualize the defect area, click  to update the C-scan view (see 
Figure 3-29 on page 130).

Click to update the view.

Move the K parameter
slider to the desired value.

The reference defect area
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Figure 3-29  Example of SNR analysis

3.8.2 SNR Analysis Conventions

The parameters involved in the SNR calculations are presented in Table 4 on page 130 
and are illustrated in Figure 3-30 on page 131.

Table 4  SNR parameters 

Parameter  Symbol

Mean value inside reference area m

Standard deviation inside reference area σ

Lower threshold S–

Upper threshold S+

Lower area (area of amplitude below S–) A– = A1

Upper area (area of amplitude above S+) A+ = A2

Adjustable factor K
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Figure 3-30  The SNR distribution

In Figure 3-30 on page 131, S− and S+ are calculated as follows:

The mathematical expression for the SNR is:

The defect area value represents the set of pixels with values above the SNR ratio. The 
mathematical expression for the defect area is:

When the K slider is at the maximum left position, the following aspects apply:

• K = 0
• The defect SNR is not applicable.
• The defect area is equal to the total area between the reference and measurement 

cursor positions.

When the K slider is at the maximum right position, the following aspects apply:

• The K value is defined as follows:

Signal amplitude
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m S+S–0 % 100 %

A1 A2

S- m K σ×–=

S+ m K σ×+=

SNR 20 K( )log×=

Defect Area A+ A-+=
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where:
Amax = 100 % (for an amplitude C-scan)

Amax = End of gate position (for a TOF C-scan)

• The defect SNR is defined as follows:

• Defect Area = 0

3.9 Color Palettes

Depending on the application, it can be very helpful to modify the color palette 
associated with the specific view types in order to make certain types of indications 
easier to see. This section shows how the FocusPC color palette can be edited.

3.9.1 Modifying Color Palettes

To modify a color palette

1. To open the Palette Editor dialog box (see Figure 3-31 on page 133):
 In the View Properties > Palette dialog box, click Edit Palette.

OR

Right-click on the active view color palette, and select Edit Color Palette.

K max
Amax m–

σ
------------------------- 
 log m

σ
------- 
 log,=

Defect SNR 20 max
Amax m–

σ
------------------------- 
 log m

σ
------- 
 log,×=
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Figure 3-31  The Palette Editor dialog box

2. In the Palette Editor dialog box, make the necessary adjustments:
a) To open an existing palette, click Load Palette.
b) To distribute the thresholds evenly between the colors, click Equidistant.
c) Enter the desired number of colors in the palette in the Number of colors box. 

The number of active boxes will increase or decrease accordingly.
d) In the Interpolation area, select the desired interpolation type from the 

colors.
e) To have specific colors highlighted on the display, select the Use special 

colors check box and select colors to be associated with the No data, No 
synchro, and No detection boxes.
○ No data corresponds to locations where no data was acquired because of 

missed encoder steps, or because the location was outside the inspected 
volume.

○ No synchro. corresponds to locations where no signal crossed gate I 
(synchronization gate). This color is only effective for synchronization set 
up on echo.

○ Click the No detection box to define the color assigned to locations where 
no signal crossed the considered gate.
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f) To change a color, click on it and select an alternative color using the Color 
dialog box (see Figure 3-32 on page 134).

g) To save the current palette to a .col file, click Save Palette.

Figure 3-32  The Color dialog box

In Setup mode, Special colors functions are not applied to the Scrolling B-scan view, 
Scrolling Strip View (Amp), and Scrolling Strip View (Pos).

3. Click Apply, and then Close.

3.9.2 Optimizing a Color Palette for Corrosion Visualization

Corrosion inspection is a good example of an application where an appropriate color 
palette configuration can be very useful. This section describes the steps to optimize a 
color palette for corrosion.

To optimize a color palette for corrosion visualization

1. Select the C-scan view with which you want to visualize the corrosion.
2. In the Palette Editor, do the following:

NOTE
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a) Set Number of colors to 4.
b) In the Interpolation area, select Threshold.
c) Clear the Use special colors check box.
d) In the Limits area, set the < = 0 % color to gray and the > = 0 % color to red.
e) Set color 1 to green, color 2 to yellow, color 3 to orange, and color 4 to red.
f) Click Save Palette and save the current color palette to a .col file.

Figure 3-33  Color palette optimized for corrosion visualization

3. In the View properties > Palette dialog box, select the Reverse color order check 
box.

4. Click  to open the Gain Information dialog box:
 Adjust the top and bottom color palette cursors to match, respectively, the 

maximum and minimum corrosion thicknesses of your specimen (see the 
example in Figure 3-35 on page 136).
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Figure 3-34  Example of palette limits adjusted to specimen corrosion limits

The C-scan pane view should now highlight the corrosion of the specimen, such 
as in the example in Figure 3-35 on page 136.

Figure 3-35  Example of corrosion visualization on a demonstration specimen

Adjust the top color palette cursor to match the
maximum corrosion thickness of your specimen.

Adjust the bottom color palette cursor to match
the minimum corrosion thickness of your

specimen.
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3.10 Image Analysis Tools

This section provides information on the cursor and zone tools as well as on the 
display of rebound and overlays.

FocusPC offers powerful tools to facilitate advanced data analysis. Table 5 on 
page 137 provides a list of these image analysis tools along with their associated 
buttons and their descriptions.

Table 5  Summary of image analysis tools 

Icon Name Function

Split view vertically Divides the active view into two views with the same 
vertical dimension

Split view 
horizontally

Divides the active view into two views with the same 
horizontal dimension

Split view in four Divides the active view into four views with the same 
horizontal and vertical dimensions

Add view content Opens the Contents dialog box, used to select the data 
view types to be displayed in the active pane

Delete view Deletes the active view

View properties Opens the View Properties dialog box, used to 
configure the parameters of the active view

Zoom tool Select and zoom in a specific region on a view

Zone tool Select a region on a top, side, end, or C-scan view by 
clicking and dragging
Tip: When the Zone tool is not selected, press and hold 
the CTRL key, and then click and drag on a view to 
perform the same task.

Readings 1 Toggles the display of information group 1 in the 
active view (by default, readings related to reference 
cursors)
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As shown in the example in Figure 3-36 on page 138, the reference and measurement 
cursors appear on the various views as horizontal and vertical colored lines on each of 
the three axes (index, scan, and ultrasonic) to mark a specific data point. The Zone 
tool appears as a pink rectangle and the 3-D cursor appears as a pink line.

Figure 3-36  Example of cursor and zone tools

Readings 2 Toggles the display of information group 2 in the 
active view (by default, readings related to 
measurement cursors)

Readings 3 Toggles the display of information group 3 in the 
active view (by default, readings related to reference 
and measurement cursors)

Readings 4 Toggles the display of information group 4 in the 
active view (by default, readings related to the Zone 
tool)

US customary units FocusPC Viewer edition only; changes length 
measurement units to US customary when pressed.

Table 5  Summary of image analysis tools (continued)

Icon Name Function

Reference cursor

Data cursor

Measurement
cursor

Contour rectangle
3-D cursor
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3.10.1 Measurement Cursors and Measures

With FocusPC, you can use the reference and measurement cursors on a view to 
measure the distance along the various axes. Each cursor has a label indicating the 
current coordinate on the view. You can display cursor parameters values at the top of 
the view (see “Displaying Cursor Parameters” on page 140).

3.10.1.1 Relationship between Cursors

Two types of relationships can exist between cursors: a fixed gap or a link.

A fixed gap is a relationship created between the reference and the measurement 
cursors for a given view. You can use it to simultaneously move both cursors with a 
fixed gap between them.

A link is a relationship created between cursors of a same type in different views. You 
can use it to simultaneously move either the reference or the measurement cursors to 
the same coordinate in two different views.

3.10.1.2 Moving a Cursor with the Mouse

To move a cursor with the mouse

1. Place the mouse pointer over the reference or measurement cursor you want to 
move.

The pointer shape changes to  or .
2. Click, drag, and release the cursor onto the new position.

OR
Double-click using the left or right mouse button on the desired position to move 
the reference or measurement cursor directly to the new position.

3.10.1.3 Moving a Cursor with the Keyboard

To move a cursor with the keyboard

1. Select the view on which you want to move the reference or measurement 
cursors.

2. Use the arrow keys to move the reference cursor.
OR
Advanced Analysis Using FocusPC 139



DMTA-20093-01EN, Rev. D, September 2022
Use the arrow keys while holding down the SHIFT key to move the measurement 
cursor.
The cursors only move on the active view, unless they are linked to other views.

3.10.1.4 Moving Cursors with a Fixed Gap

To move the reference and measurement cursors with a fixed gap

1. Place the reference cursor on a given position.
2. Place the measurement cursor at a distance from the reference cursor 

corresponding to the gap you want to create.
3. Place the mouse pointer over one of the cursors you want to move with a fixed 

gap (the pointer shape will change to  or ).
4. Press the mouse button while holding down the CTRL key and drag the cursors 

to the new position.

Both reference and measurement cursors will follow each other with the specified 
gap. The cursors will only move on the active view, unless they are linked to other 
views.

3.10.1.5 Creating a Link between Cursors

To create a link between cursors

1. Click on the view where you want to create a cursor link.
2. Open the View Properties > View Linking dialog box.
3. In the Linked items area, select the Scan/Index cursors check box.

The scan and index cursors will automatically move to the same position as will 
any linked cursor in another view.

3.10.1.6 Displaying Cursor Parameters

As the reference and measurement cursors are often used to take measurements 
inside the different views, it is very convenient to display the various readings related 
to these cursors.
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To display the cursor parameters

1. Click on the view where you want to display the cursor parameters, and then 

activate the readings by clicking a Reading button ( ) on the 
Component toolbar.

2. Double-click on the readings area in the view.
3. In the Information Groups dialog box, proceed as follows:

a) Select the Group n > Favorite Readings category.
b) Select the Reference Cursor (r), Measurement Cursor (m), and Cursors 

readings that you want to display.
c) Click OK.

Figure 3-37  The cursor parameters

4. On the View toolbar, click  to activate the readings that you have 
defined for the current view.
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3.10.2 Zone Tool

You can use the Zone tool to select a part of an image. A zone is a rectangular shape 
that can be used on volume-corrected volumetric views (only one zone can be active 
at a time).

Because contours are 3-D measurement tools, they are always linked from one 
volumetric view to another.

3.10.2.1 Creating a Zone

To create a zone

1. Click on the view where you want to create a zone.

2. On the Component toolbar, click .
3. Drag and release the mouse button on a view to create the zone, which appears as 

a magenta-colored rectangle.

3.10.2.2 Resizing a Zone

To resize a zone

1. Click on the view where you want to resize a zone.
2. Place the mouse pointer over the zone corner to be resized until the pointer 

changes to an oblique arrow (  or ).
3. Drag and release the zone corner using the mouse button until it has reached its 

arrival point.
The other zone corners can similarly be moved to resize the zone as desired.

3.10.2.3 Moving a Zone

To move a complete zone

1. Click on the view where you want to move the zone.

NOTE
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2. Place the mouse pointer over one of the zone lines until the pointer changes to a 

cross ( ).
3. Drag and release the mouse button to move the zone to its new position.

3.10.2.4 Displaying Zone Parameters

No information group displays the coordinates related to the zone. To display zone 
parameters, you must first edit an information group.

To display the zone parameters

1. Click on the view where you want to display the zone parameters, and then 

activate the readings by clicking a Reading button ( ) on the 
Component toolbar.

2. Double-click on the readings area in the view.
3. In the Information Groups dialog box, proceed as follows:

a) Select the Group n > Favorite Readings category.
b) Select the Zone readings that you want to display (see Figure 3-38 on 

page 143).
c) Click OK.

Figure 3-38  The Statistics zone parameters
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4. On the View toolbar, click  to activate the readings that you have 
defined in the current view.

3.11 Cylindrical Correction

This section describes the cylindrical correction tool provided in FocusPC. This 
section provides details on Volume Corrected views (called the VC-X View). To set a 
volumetric view as a Volume Corrected view, right click in the View bar, and select 
Set Volume Corrected Display Mode (see Figure 3-39 on page 144).

Figure 3-39  The shortcut menu for Set Volume Corrected Display Mode

3.11.1 Description of the Cylindrical Correction Tool

FocusPC software can display various types of information about the active data file 
and the data views. View information consists of the various view-related parameters, 
which can be displayed in the upper part of the pane. The information to be displayed 
is defined in the Information Groups dialog box. In FocusPC, all information about 
the position of indications in a user-defined cylindrical geometry has been organized 
in the Cylindrical Correction group (see Figure 3-40 on page 145).
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Figure 3-40  The Cylindrical Correction information group

This information group contains the parameters shown in Figure 3-41 on page 145. 
These parameters provide the position, in the user-defined cylindrical geometry, of a 
point indicated by the reference cursor and/or the measurement cursor, or by the zone 
tool.

Figure 3-41  The cylindrical correction parameters
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Cylindrical correction parameters are available for an inspection conducted from the 
outside diameter (OD) or from the inside diameter (ID). The feature is applicable for 
data files that are acquired with scan or index axes calibrated in distance units 
(millimeters or inches) or rotation units (degrees). In addition, you can convert the 
units in Analysis mode.

The position of the points is determined by the two cursors, and the distance between 
the cursors in the user-defined cylindrical geometry can be calculated along the 
considered axes.

The position of the maximum amplitude within a user-defined zone can be calculated 
in the user-defined cylindrical geometry.

The feature is not relevant for merged views resulting from various focal laws, as the 
data might be deduced from different refracted angles.

3.11.2 Case of a Skew Angle of 0° or 180°

The cylindrical correction for probe skew angles of 0° or 180° is applicable for all 
inspection configurations where both the scanning axis and the probe beam are 
oriented circumferentially, for instance:

• Raster scanning a longitudinal pipe weld to find defects parallel to the weld axis
• Raster scanning a circumferential pipe weld to find defects perpendicular to the 

weld axis

To obtain the cylindrical correction for the points determined by the reference and 
measurement cursors

1. Make sure that the reference (red) cursor is present in the Volume Corrected Side 
(B) view before activating the cylindrical correction.

2. In the VC-Side (B) view, select the applicable information fields (either OD- or ID-
related) as follows:
a) Click to activate the VC-Side (B) view.

b) Click  to display information group 3 in the upper part of the pane.
c) Double-click the readings area to open the Information Groups dialog box.

IMPORTANT
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d) Click Group 3, and then Cylindrical correction.
e) From the Cylindrical correction group, click to select the applicable 

information check boxes (see example in Figure 3-42 on page 147 showing a 
selection of OD-related parameters).

f) Click OK.

Figure 3-42  Selection of OD-related parameters

3. Click the Part and Material button ( ).
4. In the Part Definition dialog box that appears (see Figure 3-43 on page 148), 

define the specimen as follows:
a) Click Cylindrical.
b) In the Thickness box, type the thickness of the considered cylindrical 

geometry.
c) In the Outside diameter box, type the appropriate value for the outside 

diameter.
d) Under Cylindrical geometry, click the OD or ID option button to specify 

whether the inspection is performed from the outside diameter or from the 
inside diameter.

e) Click OK.
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Figure 3-43  The Part Definition dialog box

When the specimen has been defined for one channel or one focal law, it is also 
applied to all channels or focal laws contained in the considered data file, and it can 
be saved in the .A01 file upon closing the data file.

• The OD Cyl. Ref. Scan and OD Cyl. Ref. Depth information fields provide the 
position (scan and depth axes), in the user-defined cylindrical geometry, of the 
point determined by the intersection of the horizontal reference (red) cursor and 
the angled reference (pink) cursor in the VC-Side (B) view, or by the horizontal 
and the vertical reference (red) cursors in the Side (B) view.

• The OD Cyl. Meas. Scan and OD Cyl. Meas. Depth information fields provide 
the position (scan and depth axes), in the user-defined cylindrical geometry, of the 
point determined by the intersection of the horizontal measurement (blue) cursor 
and the angled measurement (cyan) cursor in the VC-Side (B) view, or by the 
horizontal and the vertical measurement (blue) cursors in the Side (B) view.

• The OD Delta Cyl. Scan and OD Delta Cyl. Depth information fields provide the 
distance (scan and depth axes), in the user-defined cylindrical geometry, between 
the points determined by the reference and measurement cursors.
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• The provided position information in the cylindrical geometry takes into account 
multiple rebounds of the ultrasonic beam from both the OD and ID, considering 
the wall thickness entered by the operator in the Part Definition dialog box (see 
Figure 3-44 on page 149).

Figure 3-44  Cylindrical correction: example 1

• The provided position information in the cylindrical geometry is displayed in 
millimeters (or inches) if the scan axis is in distance units, and in degrees (or 
radians) if the scan axis is in rotation units.

To obtain the cylindrical correction for the position of the maximum amplitude within a user-
defined zone

1. Make sure that the reference (red) cursor is present in the VC-Side (B) view before 
activating the cylindrical correction.

2. In the VC-Side (B) view, select the applicable information fields (either OD- or ID-
related) as follows:
a) Click in the VC-Side (B) view to make it the active view.

b) Click  to display information group 3 in the upper part of the pane.
c) Double-click the readings area to open the Information Groups dialog box.
d) Click Group 3, and then Cylindrical correction (see Figure 3-45 on page 150).
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e) From the Cylindrical correction group, click to select the applicable 
information check boxes (see example in Figure 3-45 on page 150 showing a 
selection of OD-related parameters).

f) Click OK to close the dialog box.

Figure 3-45  Selection of OD-related parameters

3. Position the gate selectors for the ultrasonic axis so that the flaw indication to be 
sized is located in the gate. (It might also be useful to display the gate cursors in 
the volume-corrected views.)

4. In the VC-Side (B) view, create a zone containing the considered flaw indication.
5. In the VC-Top (C) view, create a zone containing the considered flaw indication.

You have now created a volumetric zone defined by the zone created in the top 
view and the gate selectors on the ultrasonic axis (see Figure 3-46 on page 151). 
Additionally, the selected parameters in the information group give the position 
of the maximum amplitude in the zone along the scan and depth axes. The 
position of the maximum amplitude along the index axis (flat geometry) can be 
obtained by using the standard parameter Z. Max. Ampl. Index from the 
Statistics information group.
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Figure 3-46  Cylindrical correction: example 2

3.11.3 Case of a Skew Angle of 90° or 270°

The cylindrical correction for probe skew angles of 90° or 270° is applicable for all 
inspection configurations where both the index axis and the probe beam are oriented 
circumferentially, for instance:

• Raster scanning or line scanning a longitudinal pipe weld to find defects parallel 
to the weld axis

• Raster scanning or line scanning a circumferential pipe weld to find defects 
perpendicular to the weld axis

To obtain the cylindrical correction for the points determined by the reference and 
measurement cursors

1. Make sure that the reference (red) cursor is present in the VC-End (D) view before 
activating the cylindrical correction.

2. In the VC-End (D) view, select the applicable information fields (either OD- or ID-
related) as follows:
a) Click in the VC-End (D) view to make it the active view.

b) Click  to display information group 3 in the upper part of the pane.
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c) Double-click the readings area to open the Information Groups dialog box.
d) Click Group 3, and then Cylindrical correction.
e) From the Cylindrical correction group, click to select the applicable 

information check boxes (see example in Figure 3-47 on page 152 showing a 
selection of ID-related parameters).

f) Click OK.

Figure 3-47  Selection of ID-related parameters

3. Click the Part and Material button ( ).
4. In the Part Definition dialog box that appears (see Figure 3-48 on page 153), 

define the specimen as follows:
a) Click Cylindrical.
b) In the Thickness box, type the thickness of the considered cylindrical 

geometry.
c) In the Outside diameter box, type the appropriate value for the outside 

diameter.
d) Under Cylindrical geometry, click the OD or ID option button to specify 

whether the inspection is performed from the outside diameter or from the 
inside diameter.

e) Click OK.
Chapter 3152



DMTA-20093-01EN, Rev. D, September 2022
Figure 3-48  The Part Definition dialog box

When the specimen has been defined for one channel or one focal law, it is also 
applied to all channels or focal laws contained in the considered data file, and it can 
be saved in the .A01 file upon closing the data file.

• The ID Cyl. Ref. Index and ID Cyl. Ref. Depth information fields provide the 
position (index and depth axes), in the user-defined cylindrical geometry, of the 
point determined by the intersection of the horizontal reference (red) cursor and 
the angled reference (pink) cursor in the VC-End (D) view, or by the horizontal 
and the vertical reference (red) cursors in the End (D) view.

• The ID Cyl. Meas. Index and ID Cyl. Meas. Depth information fields provide the 
position (index and depth axes), in the user-defined cylindrical geometry, of the 
point determined by the intersection of the horizontal measurement (blue) cursor 
and the angled measurement (cyan) cursor in the VC-End (D) view, or by the 
horizontal and the vertical measurement (blue) cursors in the End (D) view.

• The OD Delta Cyl. Scan and OD Delta Cyl. Depth information fields provide the 
distance (index and depth axes), in the user-defined cylindrical geometry, 
between the points determined by the reference and measurement cursors.
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• The provided position information in the cylindrical geometry takes into account 
multiple rebounds of the ultrasonic beam from both the OD and ID, considering 
the wall thickness entered by the operator in the Part Definition dialog box (see 
Figure 3-49 on page 154).

Figure 3-49  Cylindrical correction: example 3

• The provided position information in the cylindrical geometry is displayed in 
millimeters (or inches) if the index axis is in distance units, and in degrees (or 
radians) if the index axis is in rotation units.

To obtain the cylindrical correction for the position of the maximum amplitude within a user-
defined zone

1. Make sure that the reference (red) cursor is present in the VC-End (D) view before 
activating the cylindrical correction.

2. In the VC-End (D) view, select the applicable information fields (either OD- or ID-
related) as follows:
a) Click to activate the VC-End (D) view.

b) Click  to display information group 3 in the upper part of the pane.
c) Double-click the readings area to open the Information Groups dialog box.
d) Click Group 3, and then Cylindrical correction.
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e) From the Cylindrical correction group, click to select the applicable 
information check boxes (see example in Figure 3-50 on page 155 showing a 
selection of ID-related parameters).

f) Click OK.

Figure 3-50  Selection of ID-related parameters

3. Position the gate selectors for the ultrasonic axis so that the flaw indication to be 
sized is located in the gate. (It might also be useful to display the gate cursors in 
the volume-corrected views.)

4. In the VC-End (D) view, create a contour containing the considered flaw 
indication.

5. In the VC-Top (C) view, create a contour containing the considered flaw 
indication.
You have now created a volumetric contour defined by the contour created in the 
top view and the gate selectors in the ultrasonic axis (see Figure 3-51 on page 156); 
the selected parameters in the information group give the position of the 
maximum amplitude in the contour along the index and depth axes. The position 
of the maximum amplitude along the scan axis (flat geometry) can be obtained by 
using the standard parameter Z. Max. Ampl. Scan from the Statistics information 
group.
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Figure 3-51  Cylindrical correction: example 4

3.11.4 Using Cylindrical Corrections

For the inspection of cylindrical parts, the Calculator takes into account the cylindrical 
corrections of the beams so that the readings of depth and index values are valid. The 
reading of depth (ODCylRefDepth) is taken perpendicularly to the tangent external 
surface of the part, and the reading of the index (ODCyRefIndex) is taken along the 
circumference of the external surface of the part (see Figure 3-52 on page 157).
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Figure 3-52  Reading of depth and index for a cylindrical part

3.11.5 Calibrating the Wedge

Before performing the inspection of a cylindrical part, you need to configure the 
Calculator with the appropriate part and wedge dimensions. To achieve this, you 
need to calibrate both the height of the first element of the probe and the wedge angle. 
This calibration compensates for inaccurate nominal wedge dimensions or wedge 
wear. Calibrate the wedge using a linear scan at 0 degrees, oriented towards the center 
of the cylinder. The interface echo of a correctly calibrated wedge appears at 0 mm 
depth anywhere along the probe.

To calibrate the wedge

1. On the 1-D Linear array tab of the Calculator (see Figure 3-53 on page 158), 
perform the following configuration steps:
a) In the Scan Type box, select Linear.
b) In the Beam angles selection area, select Refracted angle (deg), and then set 

the Start value to 0.0.
c) In the Elements Selection area, set the Stop parameter to the following value:

Number of elements on primary axis value − Primary axis aperture value + 1

ODCylRefDepth

ODCylRefIndex
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d) In the Wedge area, set the nominal values specified for your wedge.

Figure 3-53  Parameters for wedge calibration

e) In the Probe area, set the Probe index offset.
Measure the probe index offset along the circumference of the outside 
diameter of the part, as shown in Figure 3-54 on page 159, not along a straight 

1.a

1.b

1.d

1.e

1.c
Chapter 3158



DMTA-20093-01EN, Rev. D, September 2022
line. The Probe index offset value is negative when the Probe skew angle is 
90°, and is positive when the Probe skew angle is 270°.

Figure 3-54  Measurement of the probe index offset

2. Click Save As to save the focal laws.
3. In FocusPC, load the focal law that you just saved, and examine the interface 

echo.
A interface echo of correctly calibrated wedge should appear exactly at 0 mm 
depth anywhere along the probe, as shown in the example of Figure 3-55 on 
page 160. If this is the case for your application, you do not need to continue this 
procedure.
If the wedge needs calibration, the interface echo does not appear exactly at 0 mm 
depth anywhere along the probe (as shown in the example of Figure 3-56 on 
page 160), and the echo line around 0 mm in the sectorial scan is not horizontal.

Probe index offset
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Figure 3-55  Example of the interface echo for a correctly calibrated wedge

Figure 3-56  Example of the interface echo for a wedge needing calibration
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4. If your wedge needs calibration, select the 1-D Linear array tab in the Calculator.
5. In the Wedge area, adjust the values for both the Wedge angle and the Height at 

the middle of the first element to better represent the real dimensions of the 
wedge.

6. Repeat steps 2 to 5 until the interface echo line is exactly at 0 mm depth anywhere 
along the probe as shown in the example of Figure 3-55 on page 160.

3.11.6 Analyzing Cylindrical Readings in FocusPC

In FocusPC, you can analyze the cylindrical readings for sectorial and linear scans.

To analyze cylindrical readings for sectorial scans

1. Open the data file to be analyzed.
2. See Figure 3-57 on page 162 and perform the following actions:

a) In the VC sectorial scan view, select the desired focal law to display and 
position the reference cursor.

b) In the Linked VC-END (D) view, read the cylindrical correction values.
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Figure 3-57  Analyzing cylindrical readings for a sectorial scan

Do not use merged or Polar views to measure cylindrical values.

To analyze cylindrical readings for linear scans

1. Open the data file to be analyzed.
2. See Figure 3-58 on page 163 and perform the following actions:

a) Set the reference cursor at the probe index position to correctly display the 
A-scan.

b) In the VC-END (D) view, read the cylindrical correction values.

)

NOTE
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Figure 3-58  Analyzing cylindrical readings for a linear scan

Do not use merged or Polar views to measure cylindrical value.

3.12 Export Data Utility

This section describes how to use the Export Datagroup features to export A-scan and 
C-scan data to a simple text file format, which can be read with Microsoft Excel.

To export a data group

1. Open a data file.

NOTE
Advanced Analysis Using FocusPC 163



DMTA-20093-01EN, Rev. D, September 2022
2. Position the reference and measurement cursors on views to determine the 
volume of the recorded data to be exported.

3. In the menu, select File > Export Datagroup to File (see Figure 3-59 on page 164).

Figure 3-59  The Export Datagroup dialog box

4. In the Export Datagroup dialog box, select from A-scan or C-Scan data, 
depending on what you want to export (this will modify the Available data 
group list according to contents of the data file).

5. Select the data that you want to export in the Available data group list.
6. Adjust the Start and End values of the Scan, Index, and USound parameters to 

determine the data volume to export.
7. Set the Data group header to determine the header format that will be added to 

the exported data.
8. Select if you want to have the Amplitude data exported as Percent or as Raw 

data.
9. If exporting C-scan data, select the format of the Position data.
10. Click Export.
11. Select a name and location for the exported file and click Save.

The data is exported in the following formats:
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For A-scan
— 1st line

A-scan amplitude data at Scan Start, Index Start position

— 2nd line
A-scan amplitude data at Scan Start + 1, Index Start position

— 3rd line
A-scan amplitude data a Scan Start + 2, Index Start position

IndexQTY + 1st line

A-scan amplitude data at Scan Start, Index Start + 1 position

IndexQTY + 2nd line

A-scan amplitude data at Scan Start + 1, Index Start + 1 position

For C-scan
— 1st line

C-scan data of line along the scan axis, at index position Index Start

— 2nd line
C-scan data of line along the scan axis, at index position Index Start + 1

— 3rd line
C-scan data of line along the scan axis, at index position Index Start + 2

The values are delimited by the TAB key (ASCII character code: 9).

3.13 Configuring Links between FocusPC Elements

With FocusPC, you can link the behavior of elements. For example, moving a cursor 
in one view automatically moves the same linked cursor in another view.

You can set the general link configuration for all views in the Link tab of the 
Preferences dialog box (see “Linking Tab” on page 93). You can also customize the 
link configuration for a specific view.

NOTE
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To set the general link preferences

1. On the menu, select File > Preferences.
2. Select the Linking tab.
3. In the two-column list on the left, select the element for which you want to 

configure the linking behavior.
4. For cursor and ruler items, choose the following settings:

a) Under Uncorrected Views, select the desired linking behavior to be applied 
for all uncorrected views.

b) Under Corrected Views, select the desired linking behavior to be applied for 
all corrected views.

5. For the other elements, select the desired linking behavior to be applied for all 
views.

You can press the F4 shortcut key to save view preferences to the display setup (.rst) 
file or SHIFT+F4 to load view preferences from the display setup file.

3.14 Fast Fourier Transforms (FFT) Component

The Fast Fourier Transform (FFT) tool can be used to determine the spectral 
components of the signal received by an ultrasonic transducer. The FFT tool can be 
used at any time. However, to use the FFT tool in Analysis mode, it requires data files 
that have been acquired using the settings detailed below (see Figure 3-60 on 
page 167).

To configure a setup for the FFT component

1. On the Pulser/Receiver tab of the UT Settings dialog box, set Rectification to RF.
2. On the Digitizer tab of the UT Settings dialog box, set Compression to 1.
3. In the Scan and Mechanical Settings dialog box, in the Scan tab’s Type box, set 

the Scan mode to Free running.

4. On the Component toolbar, click  (FFT).
5. In an A-scan view, place the reference and measurement cursors around the 

portion of the signal that you want to analyze.

TIP
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Figure 3-60  The Fast Fourier Transforms dialog box
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4. Shortcut Keys

Table 6 on page 169 provides a list of the keyboard shortcuts that you can use with 
FocusPC. You can use the shortcut keys to activate certain commands without going 
through all the menus or clicking a toolbar button.

Shortcut keys available for menu commands appear on the menu to the right of the 
command that they activate.

Table 6  Shortcut keys 

Shortcut key Toolbar button — Menu command function description
CTRL+[n] Layout > Layout[n]

With [n] equal to 1, 2, 3,...,9, or 0, activates the nth layout as 
when you select one of the ten layouts from the 
Dashboard under Layout. CTRL+0 activates the tenth 
layout. 

CTRL+SHIFT+[n] Layout > Save Current Layout > Save as layout[n]
With [n] equal to 1, 2, 3,..., 9, or 0, opens the Save Current 
Layout as dialog box, allowing you to name and to save 
the nth layout.

CTRL+C Copies the selected text onto the Clipboard.
CTRL+E Tools > Clear Envelope

Resets the envelope mode.
CTRL+SHIFT+E  — Tools > Envelope

Toggles the Envelope mode.
CTRL+F Tools > Freeze

Alternately freezes and resumes the display update of the 
active A-scan view.
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CTRL+SHIFT+F Tools > Freeze All
Alternately freezes and resumes the display update of all 
views.

CTRL+H Hides the menu and the toolbars.
CTRL+M  — View > Maximize/Minimize

Alternately maximizes and restores the size of the active 
view.

CTRL+N File > Load Default Configuration
In Inspection mode, creates a new configuration using 
the default values. 

CTRL+O File > Open
Opens the Open dialog box to select a file to load.

CTRL+S File > Save Configuration As
Opens the Save As dialog box to select the path, name, 
type, and content of the file to save.

CTRL+V Pastes the text previously copied onto the Clipboard into 
a text box.

CTRL+X Cuts the selected text and copies it onto the Clipboard.
CTRL+ click and drag On a C-scan, draws a rectangular zone, independently 

from the selected tool.
On a cursor, moves two cursors together.
For a zoom bar, changes the bar start and end values.

CTRL+SHIFT On a cursor, moves the cursor label.
ALT+C Processing > Automatic Volumetric Merge by Group

Performs an automatic volumetric merge by group on the 
opened data file containing more than one beam per 
group and more than one group.

ALT+V Processing > Automatic Volumetric Merge
Performs an automatic volumetric merge on the opened 
data file containing more than one beam.

F1 Help > Help
Opens the User’s Manual

Table 6  Shortcut keys (continued)

Shortcut key Toolbar button — Menu command function description
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F2
 — View > Splitting > Split Horizontally

Horizontally splits the active view into two views.
F3

 — View > Splitting > Split Vertically
Vertically splits the active view into two views.

F4 View > Save as Preference
Saves the current view properties as the default property 
settings.

SHIFT+F4 View > Apply Preference
Applies the default settings view properties.

ALT+F4 File > Exit
Terminates the execution of FocusPC after validating if 
you want to save unsaved data.

F5 Tools > Previous Group
Selects the previous group.

F6 Tools > Next Group
Selects the next group.

F7 Tools > Previous Beam
In a view containing more than one beam, selects the 
previous beam.

F8 Tools > Next Beam
In a view containing more than one beam, selects the next 
beam.

CTRL+F8 Tools > Change Group
Opens the Change Group dialog box where you can 
select one of the groups.

F9
 — Tools > Zoom

Enables the zoom tool.
F11

 — Tools > Zone
Enables the zone tool (see also “CTRL+ click and drag” 
on page 170).

Table 6  Shortcut keys (continued)

Shortcut key Toolbar button — Menu command function description
Shortcut Keys 171



DMTA-20093-01EN, Rev. D, September 2022
F12  — Tools > Move
Enables the move tool.

ALT+ENTER
 — View > Properties

Alternately opens and closes the Properties dialog box.
SHIFT+ENTER

 — View > Contents
Alternately opens and closes the Contents dialog box.

DELETE Layout > Delete Active Note
Eliminates the active note from the view.

CTRL+DELETE
 — View > Delete

Deletes the active view.
CTRL+SHIFT+DELETE  — View > Empty

Clears the content of the active view.
PAGE UP Selects the next gate selection.

PAGE DOWN Selects the previous gate selection.
TAB Selects the next box or option in a dialog box.

SHIFT+TAB Selects the previous box or option in a dialog box.
CTRL+TAB Selects the next tab in a dialog box.

CTRL+SHIFT+TAB Selects the previous tab in a dialog box.
ALT+Up, Down, Left, or 

Right
Moves the reference (red) cursor.

SHIFT+ALT+Up, Down, 
Left, or Right

Moves the measurement (blue) cursor.

Table 6  Shortcut keys (continued)

Shortcut key Toolbar button — Menu command function description
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5. Troubleshooting

To function correctly, FocusPC requires a HASP key and a properly configured 
computer and acquisition instrument connection.

Security hardware key
If no security hardware key (HASP key) is connected to the computer, only the 
FocusPC Viewer option is available in the Startup Selection dialog box.

If you expect to start FocusPC in one of the other editions, ensure that the security 
hardware key is connected to the computer before starting FocusPC. For details, 
refer to the FocusPC User’s Manual.

Computer configuration
The FocusPC installation procedure includes steps to correctly configure your 
computer. Additionally, FocusPC must be correctly started up in order to 
correctly function. Make sure that you have followed all installation and start-up 
steps, as detailed in the FocusPC User’s Manual.

Connection to FOCUS PX acquisition instrument
Your computer must be correctly connected and configured for the acquisition 
instrument. The FOCUS PX Configuration Tool is needed to configure the 
connection. The FOCUS PX Configuration Tool contains a Troubleshooting 
section with a list of possible causes of problems. For connection details, refer to 
the FocusPC User’s Manual.
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6. Calculator — Overview

The Calculator is designed to calculate phased array probe element delays. This 
manual includes guidelines on how to use the Calculator to generate ultrasonic beams 
for various typical phased array (PA) probe configurations. The Calculator saves the 
individual element delays in text file formats. You can import these files into FocusPC 
for use with supported acquisition instruments.

The Calculator is launched by clicking  in the FocusPC Dashboard.

6.1 Calculator User Interface

The Calculator user interface includes a menu bar and a selection of tabs at the top of 
the screen (see Figure 6-1 on page 175). The menu bar provides file-related 
commands. The first three tabs regroup parameters related to a specific type of probe. 
The last two tabs present graphically rendered illustration and probe element 
information.

Figure 6-1  The menu bar and the available tabs

A button bar is available at the bottom of the Calculator window (see Figure 6-2 on 
page 176).
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Figure 6-2  The button bar

6.2 File Menu Commands

The File menu in the Calculator menu bar contains the following commands:

Load
Used to open the Open dialog box in which you can select a calculator setup file 
to load (.cal or .xcal format).

Save As
Used to open the Save As dialog box in which you can select the name, location, 
and format (.xcal, .pac, or .law) of the file to which you save the calculator data. 
This creates one .law file for each group. The file contains delays to be applied for 
all ultrasonic beams.

Export elementary beam
This command includes a submenu with two items (Delay and No Delay). Both 
submenu commands are used to open the Save As dialog box in which you can 
select the name and location of a .law file in which to save ultrasonic beam data, 
respectively, with or without the delay data. This creates one .law file for each 
ultrasonic beam in the current group. Each .law file contains one beam per 
element used in the aperture.

Progress bar

To exit the Calculator (equivalent of File > Exit)

To save data in .xcal, .pac, or .law files (equivalent of File > Save As)

To load data from .xcal or .cal files (equivalent of File > Load)

To build illustrations

To add the configured focal laws to existing focal laws

To program the configured focal laws on the receiver 
side only

To program the configured focal laws
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Preferences
Used to open the Preferences dialog box in which you can select the 
measurement units (Metric or US Cust.) used in the Calculator user interface.

Exit
Used to close the Calculator program.

6.3 Supported File Formats

The Calculator can open and save data using the file formats described in Table 7 on 
page 177.

Table 7  File formats supported by the Calculator 

File type Extension File content

Calculator setup .cal Calculator setup file

Calculator setup .xcal Calculator extended setup file

Calculator setup .law Calculated ultrasonic beam parameters.
See “Description of the .law File Format” on 
page 285 for details.

Calculator setup .pac Calculated ultrasonic beam parameters.
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7. Calculator — Phased Array Technique

This section describes the main concepts of phased array inspection and the phased 
array data views.

Phased array technology allows the generation of an ultrasonic beam with the 
possibility of modifying the ultrasonic beam parameters such as angle, focal distance, 
and focal spot size with software. Furthermore, this ultrasonic beam can be 
multiplexed over a large array, thus creating movement of the ultrasonic beam along 
the array. These capabilities open a series of new possibilities. For example, it is 
possible to electronically vary the angle of the ultrasonic beam to scan a part or weld 
without moving the probe itself. Phased array capabilities also allow the replacement 
of multiple probes and mechanical scanning devices. Inspecting a part or weld with a 
variable-angle ultrasonic beam also improves detection, regardless of the defect 
orientation, while optimizing signal-to-noise ratio.

7.1 Physical Principles

To generate an ultrasonic beam, the various elements of the probe are pulsed at 
slightly different times. By precisely controlling the delays between the probe 
elements, ultrasonic beams of various angles, focal distances, and focal spot sizes can 
be produced. As shown in Figure 7-1 on page 180, the echo from the desired focal 
point hits the various transducer elements with a computable time shift. The echo 
signals received at each transducer element are time-shifted before being summed 
together. The resulting sum is an A-scan that emphasizes the response from the 
desired focal point and attenuates various other echoes from other points in the 
material.
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Figure 7-1  Emitting and receiving in a phased array system

A phased array probe is typically a one- or two-dimensional array of small transducer 
elements. To control the ultrasonic beam characteristics, the excitation pulse is applied 
at different times to the various elements of the probe.

The multielement composition of the phased array probe enables ultrasonic beam 
angle control (see “Beam Angle Control” on page 180) and ultrasonic beam focus 
control (see “Beam Focus Control” on page 182).

7.1.1 Beam Angle Control

Beam angle control involves the production of a wave front. As shown in Figure 7-2 
on page 181, simultaneous firing of all elements of a linear multielement probe 
produces a series of circular arc waves, one from each transducer element. As all wave 
fronts are at the same distance from their respective emitter, the resulting wave front, 
or envelope, is parallel to the transducer plane. This is very similar to pulsing a single 
element transducer of the same size.
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Figure 7-2  Ultrasonic wave front of a linear array

A phased array instrument pulses the various elements in a sequential manner with a 
small and precisely controlled time delay between each element. Sequential firing of 
the various transducer elements produces a series of circular arc waves. The resulting 
envelope is a wave front that is no longer parallel to the transducer surface but 
propagates at an angle (see Figure 7-3 on page 181). It is possible to adjust the pulse 
delays to produce any desired wave-front angle.

Figure 7-3  Ultrasonic beam angle control of a linear array
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7.1.2 Beam Focus Control

When generating a focused beam, the delays are adjusted so that all individual wave 
fronts stay in phase along the path leading to the desired focal point while canceling 
each other out at all other points. By accurately controlling the pulse delays, it is 
possible to focus the beam at a desired point (see Figure 7-4 on page 182).

Figure 7-4  Ultrasonic beam focusing of a linear array

For beam angle control and beam focus control, signals received by every element are 
time-synchronized by the phased array instrument prior to summing the various 
responses.

7.2 Phased Array Applications

The ultrasonic beam generated by a phased array probe is treated as an ordinary 
ultrasonic beam by the FocusPC ultrasonic visualization and analysis software, and, 
as such, phased array can be used to generate all the regular data views (A-scan 
views, B-scan views, volumetric views, etc.).

Phased array also offers the possibility of performing inspections with various angles 
and focal lengths. It provides hardware and software tools for different application 
types.

Delay

Transducer array

Focal point
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The application types that you can select in the Calculator dialog box are:

• Sectorial scanning
• Depth scanning
• Linear electronic scanning

7.2.1 Sectorial and Depth Scanning

Sectorial scanning of the phased array signal is obtained by applying several beams in 
sequence at each x-y coordinate of the inspected area.

At each x-y coordinate of the inspection sequence, an array of elements is used to 
deflect the ultrasonic beam without moving the probe. Scanning can be conducted 
along a horizontal axis (see Figure 7-5 on page 183), at different depths in the material 
(see Figure 7-6 on page 184), or for a combination of these two modes.

Figure 7-5  Sectorial scanning of x-axis using phased array deflection
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Figure 7-6  Scanning at different depths

For certain applications, a conventional UT inspection would require a number of 
different transducers. A single phased array probe can be made to sequentially 
produce the various angles and focal points required by the application (see 
Figure 7-7 on page 184).

Figure 7-7  Ultrasonic beam angle control and focusing of a linear array
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7.2.2 Linear Electronic Scanning

For large phased array probes containing a high number of elements, a phased array 
instrument can apply the same beam to different sets of elements. By moving the 
beam along a probe array, the scanning of an inspection axis is realized electronically 
without any need for physical displacement of the probe (see Figure 7-8 on page 185).

Figure 7-8  Electronic scanning along an axis

In Figure 7-8 on page 185, a focused beam is created using a few of the many probe 
elements of a long phased array probe. The beam is then shifted (or multiplexed) to 
the other elements to perform a high-speed scan of the part with no probe movement 
along scanning axis. More than one scan can be performed with various inspection 
angles.
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8. Calculator — 1-D Linear Arrays Tab

This section presents 1-D linear arrays and describes the Calculator’s 1-D Linear array 
tab.

8.1 Generic Conventions

You should consider generic conventions regarding probe, wedge, and part geometry 
to generate beams for 1-D linear arrays in the most efficient and accurate way. Generic 
conventions exist on aspects such as orientations and positive directions of axes, 
reference points and signs of offsets, and definition and signs of angles.

8.1.1 Probe Conventions

Axis definition

The axis convention for a 1-D Linear array, as described in “Tab Description” on 
page 204 (see Probe area), is illustrated in Figure 8-1 on page 188.
Calculator — 1-D Linear Arrays Tab 187



DMTA-20093-01EN, Rev. D, September 2022
Figure 8-1  Probe axis definition

Refracted angle

The refracted angle of the ultrasonic beam is the angle between the central ray of the 
ultrasonic beam in the material and the normal on the surface at the entrance point of 
the central ray (see Figure 8-2 on page 188 and Figure 8-3 on page 189). The refracted 
angle can have values between −89.9° and 89.9°.

Figure 8-2  Refracted angle on flat part
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Figure 8-3  Refracted angle on pipe part

Skew angle

The total skew angle is the sum of two components: the beam skew angle (for definition, 
see “Beam Angles Selection Area” on page 206) and the probe skew angle (for 
definition, see “Probe Area” on page 214). In both cases, the FocusPC conventions are 
used. The skew angle can have values between 0° and 359.9°.

Beam skew angle

Because the 1-D linear array has no skewing capability, only a beam skew angle 
different from 0° can be obtained when using a wedge with a roof angle.

The beam skew angle is the angle between the ultrasonic beam (central ray) projection 
on the scanning surface and the primary axis of the array. The beam skew angle can 
have values between −179.9° and 179.9°, and it has a positive value when turning from 
the positive primary axis towards the positive secondary axis.

An example of a beam skew angle going from 70° to 110° with a resolution of 10° is 
illustrated in Figure 8-4 on page 190.

Refracted angle
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Figure 8-4  Example of a beam skew angle

Probe skew angle

The probe skew angle is the angle between the primary axis of the probe and the scan 
axis. It can have values between 0° and 360°, and it is positive when turning from the 
positive scan axis towards the positive index axis.

Examples of different probe skew angles, ranging from 0° to 135°, are illustrated in 
Figure 8-5 on page 191 to Figure 8-8 on page 192.

110°

100°

90°
80°

70°
Chapter 8190



DMTA-20093-01EN, Rev. D, September 2022
Figure 8-5  Example of a probe skew angle equal to 0°

Figure 8-6  Example of a probe skew angle equal to 45°

Primary 
axis

Probe skew angle = 0°

Primary axis

Probe skew angle = 45°
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Figure 8-7  Example of a probe skew angle equal to 90°

Figure 8-8  Example of a probe skew angle equal to 135°

Primary axis

Probe skew angle = 90°

Primary axis

Probe skew angle = 135°
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Total skew angle

The combination of a probe skew angle of 90° and a beam skew angle of 15°, resulting 
in a total skew angle of 152.51°, is illustrated in Figure 8-9 on page 193.

Figure 8-9  Total skew angle

Primary axis

Probe skew angle = 90°

Beam skew angle = 15°

Skew angle = 152.51°
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8.1.2 Wedge Conventions

In the Calculator, the different rotations, which define the wedge, roof, and squint 
angles, are performed in such a way that they are independent. This is mathematically 
possible because the rotations are performed around adequate axes (not necessarily 
Scan, Index, and Usound). Consequently, the chronology of the rotations is not 
important. The value specified for each angle will be correctly applied.

Wedge angle

The wedge angle is the angle between the primary axis of the probe (when it is fixed on 
the wedge) and the surface of the component (or the tangential plane to the surface of 
the component in the case of cylindrical geometry). It is obtained by a rotation around 
the secondary axis of the probe, and it can have values between 0° and 89.9°.

Figure 8-10 on page 194 gives an example of a wedge with a wedge angle and no roof 
angle.

Figure 8-10  Wedge angle definition

Primary axis

Secondary 
axis Wedge angle > 0
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Roof angle

The roof angle is the rotation angle around the primary axis of the probe, and it can 
have values between −89.9° and 89.9°. For a probe skew of 0°, a positive roof angle 
generates beams with total skew angles between 0° and 180°.

Figure 8-11 on page 195 gives an example of a wedge with a positive roof angle and 
no wedge angle.

Figure 8-11  Roof angle definition

For pitch-catch configurations, the probe separation and the squint angle parameters 
must be appropriately set.

Secondary axis

Primary 
axis Roof angle > 0
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Probe separation

The probe separation defines the spacing (center-to-center distance) between the first 
element of the transmitter array and the first element of the receiver array (see 
Figure 8-12 on page 196).

Figure 8-12  Probe separation

Squint angle

The squint angle is half the angle between the primary axes of transmitter and receiver 
arrays. A symmetrical rotation is automatically applied to the receiving array. The 
squint angle can have values between −89.9° and 89.9°, and a positive squint angle 
means that the primary axes of the arrays cross in front of the arrays (see Figure 8-13 
on page 197).

Probe separation
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Figure 8-13  Squint angle definition

Position of the probe relative to the wedge

In the Wedge area of the Calculator, the values for the Primary axis position of wedge 
reference (mm) and Secondary axis position of wedge reference (mm) parameters 
are adjusted so that the probe is correctly positioned relative to the wedge. In the 
example shown in Figure 8-14 on page 198, the front of the wedge is at zero on the 
index axis and the center of the wedge is at zero on the scan axis.

For standard flat wedges, in the Wedge area of the Calculator, do not change the 
values of the Primary axis position of wedge reference and the Secondary axis 
position of wedge reference parameters (see “Wedge Area” on page 219)

Primary axis

Squint angle > 0°

Ultrasonic axis

IMPORTANT
Calculator — 1-D Linear Arrays Tab 197



DMTA-20093-01EN, Rev. D, September 2022
Figure 8-14  Wedge reference positions

8.1.3 Part Conventions

In order to increase the flexibility with regards to selection of reference points, the 
Calculator considers two different reference points:

• The wedge reference point is the intrinsic reference point used by Calculator, and it 
is always located at the rear-left corner of the wedge. The probe is then positioned 
with regards to the wedge reference by specifying the Primary axis offset at the 
middle of the first element parameter and the Secondary axis offset at the 
middle of the first element parameter (for definition, see “Wedge Area” on 
page 219).

• The mechanical reference point is an arbitrary reference point that you can use to 
define the position of the intrinsic wedge reference relative to an alternative 
wedge reference (for example, the front of the wedge) or a reference point on a 
scanning mechanism. The wedge reference is positioned with regards to the 
mechanical reference by specifying the Primary axis position of wedge reference 
parameter or the Secondary axis position of wedge reference parameter (for 
definition, see “Wedge Area” on page 219). In the visualization of the considered 
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configurations on the Beam display info. tab, the mechanical reference is always 
positioned at the origin.

When using Primary axis position of wedge reference and/or Secondary axis 
position of wedge reference values different from zero, the Calculator takes these 
values into account for the scan and/or index offset values in the Beam Information 
area of the Beam display info. tab.

Examples for flat and cylindrical parts are illustrated in Figure 8-15 on page 200, 
Figure 8-16 on page 201, and Figure 8-17 on page 202.

Flat part

For standard probes and wedges, to correctly position the wedge and the probe 
relative to the part, enter proper values in the Probe scan offset (mm) and Probe 
index offset (mm) parameters in the Probe area of the Calculator (see “Probe Area” 
on page 214).

For custom wedges, refer to Figure 8-15 on page 200 to understand the physical 
meaning of the various Calculator parameters.

IMPORTANT
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Figure 8-15  Flat part: offset definition

Primary axis position of wedge 
reference > 0 Wedge reference

Secondary axis 
position of wedge 
reference < 0

Primary axis offset at the middle of the first 
element > 0

Mechanical reference

Secondary axis offset at the middle 
of the first element > 0

Primary axis offset at the middle of the first element 

Height at the middle of the first element 
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Cylindrical part

Figure 8-16  Pipe OD with a curvature along the primary axis: offset definition

Primary axis position of wedge 
reference > 0 Wedge reference

Secondary axis 
position of wedge 
reference < 0

Primary axis offset at the middle of the first element > 0

Mechanical reference

Secondary axis offset at the middle of 
the first element > 0

Primary axis offset at the middle of the first element 
(measured along a straight line)

Height at the middle of 
the first element

Distance between contact points (wedge length)
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Figure 8-17  Pipe ID with a curvature along the primary axis: offset definition

For cylindrical parts (Pipe OD or Pipe ID), it is important to note that the wedge is, 
by definition, considered as centered on the center of the pipe.

Primary axis position of wedge 
reference > 0 Wedge reference

Secondary axis 
position of wedge 
reference < 0

Primary axis offset at the middle of the first 
element > 0

Mechanical reference

Secondary axis offset at the middle of the first
element > 0

Primary axis offset at the middle 
of the first element (measured 
along a straight line)

Height at the middle 
of the first element

Distance between contact points (wedge 
length)
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Similar conventions apply to a Pipe OD and Pipe ID with a curvature along secondary 
axis with the difference that the Distance between contact points represents the wedge 
width.
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8.2 Tab Description

The 1-D Linear array tab is divided into ten areas (see Figure 8-18 on page 204).

Figure 8-18  The 1-D Linear array tab
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8.2.1 Acquisition Unit Area

Figure 8-19  The Acquisition Unit area

The Acquisition Unit area (Figure 8-19 on page 205) contains only one list used to 
select the type of acquisition instrument for which you want to create beams. The 
beam calculation uses a slightly different compensation gain for each acquisition 
instrument type. The list is available only when no acquisition instrument is 
connected to the computer. The acquisition instrument is automatically detected 
when it communicates with the computer.

8.2.2 Scan Type Area

Figure 8-20  The Scan Type area

The Scan Type area (Figure 8-20 on page 205) is used to select the type of beams to be 
generated:

• Sectorial: the refracted or inspection angle varies (see “Sectorial and Depth 
Scanning” on page 183 and “Sectorial Beam Creation” on page 228).

• Linear: the primary aperture travels along the array (see “Linear Electronic 
Scanning” on page 185 and “Linear Beam Creation” on page 240).

• Depth: the focusing depth of the ultrasonic beam varies (see “Sectorial and Depth 
Scanning” on page 183 and “Depth Beam Creation” on page 224).

• Static: the refracted angle, the focusing depth, and the primary aperture are fixed 
values (generates a single beam) [see “Static Beam Creation” on page 221].
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8.2.3 Beam Angles Selection Area

Figure 8-21  The Beam Angles Selection (Deg.) area

The Beam Angles Selection (Deg.) area (see Figure 8-21 on page 206) contains the 
following:

Primary steering angle
This is the angle between the central ray of the beam generated at the probe 
surface and the normal on the wedge surface in contact with the probe. It is 
generated by electronic steering of the array probe and determines the resulting 
incident angle (α) in the wedge, used to calculate the refracted angle of the 
ultrasonic beam to be generated according to Snell’s law (see Figure 8-22 on 
page 207). The Primary steering angle can have values between −89.9° and 89.9°, 
and a “0” value generates the nominal angle defined by the wedge parameters.

For Sectorial beams: the Start, Stop, and Resolution boxes next to Primary 
steering angle are used to set the first and last primary steering angles and the 
angular primary steering angle resolution between two consecutive beams.

For Linear, Depth, and Static beams: only the Start box can be modified to set the 
primary steering angle of the ultrasonic beam to be generated.

Not applicable for pitch-catch configurations.

Secondary steering angle
Not applicable for a 1-D linear array.

Refracted angle
Defines the refracted angle of the ultrasonic beam to be generated. The refracted 
angle of the ultrasonic beam is the angle between the central ray of the ultrasonic 
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beam in the material and the normal on the incidence plane. The refracted angle 
(β) is calculated using the probe incidence angle (α), sound velocity in the wedge, 
and sound velocity in the material according to Snell’s law (see Figure 8-22 on 
page 207).

Figure 8-22  Refracted angle

The refracted angle can have values between −89.9° and 89.9°.

For Sectorial beams: the Start, Stop, and Resolution boxes next to Refracted 
angle are used to set the first and last refracted angles and the angular refracted 
angle resolution between two consecutive beams.

For Linear, Depth, and Static beams: only the Start box can be modified to select 
the refracted angle of the ultrasonic beam to be generated.

Beam skew angle
Defines the skew angle of the ultrasonic beam to be generated. This skew angle is 
the angle between the ultrasonic beam (central ray) projection on the scanning 
surface and the primary axis of the array. The Beam skew angle can have values 
between −179.9° and 179.9°, and it has a positive value when turning from the 
positive primary axis towards the positive secondary axis. The Beam skew angle 
value does not take into account the probe skew angle described in the Probe area 
(see Figure 8-4 on page 190).

For Sectorial beams: the Start, Stop, and Resolution boxes next to Beam skew 
angle are used to set the first and last skew angles and the angular beam skew 
angle resolution between two consecutive beams.

For Linear, Depth, and Static beams: only the Start box can be modified to set the 
beam skew angle of the ultrasonic beam to be generated.

αsin
βsin

----------- Sound velocity in wedge
Sound velocity in material
---------------------------------------------------------------=
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Not applicable for pitch-catch configurations.

Process angles button
Calculates the values of the primary steering angle, refracted angle, and/or beam 
skew angle associated with the beam angle selection.

8.2.4 Focal Points Selection Area

Figure 8-23  The Focal Points Selection (mm) area

The Focal Points Selection (mm) area (see Figure 8-23 on page 208) contains the 
following parameters:

Focusing type
Selects the type of focusing of the beams to be generated:

— True depth: all beams are focused at a constant true-depth value (see 
Figure 8-24 on page 209). For a cylindrical part, the true-depth value is the 
depth in the cylindrical geometry.

— Half path: all beams are focused at a constant half-path (distance) value (see 
Figure 8-25 on page 210).

— Projection: all beams are focused on a given vertical plane (see Figure 8-26 on 
page 210); this option is not applicable for depth laws or for pitch-catch 
configurations.

— Focal plane: all beams are focused on a user-defined focal plane (see 
Figure 8-27 on page 211); this option is not applicable for depth laws or for 
pitch-catch configurations.
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— Auto: the focalization depth is automatically calculated so that the transmitter 
and the receiver focus at the same point in space; thus, focalization occurs at 
the geometrical intersection of the central rays of the transmitter and the 
receiver (see Figure 8-28 on page 211). This option is only applicable for pitch-
catch configurations.

Focal plane position
Defines the focalization plane:

— Projection: the first Offset box is used to define the position (in scan or in 
index, depending on the skew angle of the probe) of the vertical focal plane 
(see Figure 8-26 on page 210).

— Focal plane: the Offset and Depth boxes are used to set the two points (in 
scan or index, and in depth) defining the focal plane (see Figure 8-27 on 
page 211).

Emission focus position
Defines the desired focusing position (depth or half-path) of the ultrasonic beams 
to be generated.

For Depth beams: the three boxes are used to set the initial (Start) and final (Stop) 
desired focusing position (depth or half-path) of the ultrasonic beams to be 
generated and the resolution.

Reception focus position
Defines the desired focusing position (depth or half-path) (applied delay) for the 
received signal.

Figure 8-24  True-depth focalization

True depth = 50 mm
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Figure 8-25  Half-path focalization

Figure 8-26  Projection focalization

Half path = 50 mm

Projection = 75 mm
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Figure 8-27  Focal plane focalization

Figure 8-28  Autofocalization for pitch-catch configuration

(95 mm Scan, 75 mm Usound)

(75 mm Scan, 12 mm 
Usound)
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8.2.5 Elements Selection Area

Figure 8-29  The Elements Selection area

The Elements Selection area (see Figure 8-29 on page 212) contains the following:

Improved resolution
This check box appears when Linear is selected in the Scan Type area and can 
only be selected when the Resolution parameter of the pulser is set to 1.

When the Improved resolution check box is selected, for each beam generated 
with the defined active aperture, another beam is generated with “active aperture + 
1” elements.
Therefore, the element step (Resolution) between two beams is reduced to 
1/2 element.

Pulser
Sets the first element of the active pulser group.

For linear beams: the three boxes define the elements that are used during the 
scan.
Start

Sets the first element of the first group of active elements (aperture).

Stop
Sets the first element of the last group of active elements (aperture).

Resolution
Sets the increment (in number of elements) for linear beams.

Receiver
Sets the first element of the active receiver group.
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Primary axis aperture
Sets the number of elements used simultaneously to generate beams.

8.2.6 Connection Area

Figure 8-30  The Connection area

The Connection area (see Figure 8-30 on page 213) contains the following parameters:

Pulser and Receiver
When using only one probe, always set the value of these parameters to 1.

Use these parameters when connecting two phased array probes to a splitter box 
(such as the OMNI-A-ADP05 shown in Figure 8-31 on page 214) for measurement 
in a symmetrical configuration. In this case, you need to separately calculate the 
beams for each probe using the same values for all parameters of the Calculator 
except for the Pulser and Receiver connection parameters. For a given probe, the 
Pulser and Receiver connection parameters must have the same value. If you are 
working with 128-element probes, the value can be between 1 and 64 for the first 
probe and between 65 and 128 for the second probe (see Figure 8-31 on page 214).

In the case of TOFD probes, you need to connect the pulser and receiver on different 
connectors and note the element numbers used in the respective parameters.

 

NOTE
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Figure 8-31  Example pulser and receiver configuration for two 128-element probes

8.2.7 Probe Area

Figure 8-32  The Probe area

The Probe area contains the following parameters (see Figure 8-32 on page 214):
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Probe database
Use the lists and buttons to select, save, or delete a probe in the probe database.

 Load from database button
Use to load a probe configuration from the probe database.

 Save in database button
Use to save the active probe configuration in the probe database.

 Delete from database button
Use to delete a probe configuration from the probe database.

Probe scan offset
Defines the distance between the center of the first element and the scan-axis 

origin. Clicking the question mark ( ) button on the same line opens the 
information window shown in Figure 8-33 on page 215.

Figure 8-33  Definition of the probe scan offset
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Probe index offset
Defines the distance between the front of the wedge and the index-axis origin. 

Clicking the question mark ( ) button on the same line opens the information 
window shown in Figure 8-34 on page 216.

Figure 8-34  Definition of the probe index offset

Probe skew angle
Defines the skew angle of the probe. The Probe skew angle is the angle between 
the primary axis of the probe and the scan axis. It can have values between 0° and 
360°, and it is positive when turning from the positive scan axis towards the 
positive index axis (see Figure 8-8 on page 192).

Probe frequency
Defines the probe frequency.
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Number of elements on primary axis
Defines the number of elements on the primary axis of the current probe (see 
Figure 8-1 on page 188).

Primary axis pitch
Defines the spacing (center-to-center distance) between consecutive probe 
elements on the primary axis of the probe (see Figure 8-1 on page 188).

Secondary axis width
Defines the width of the elements (see Figure 8-1 on page 188).

Pitch-catch
Allows the creation of a pitch-catch, side-by-side probe configuration.

Reverse primary axis
Inverts the order of the element numbers in the calculation of the beams.

Probe separation
Defines the spacing (center-to-center distance) between the first element of the 
transmitter array and the first element of the receiver array (see Figure 8-12 on 
page 196). This option is only applicable for pitch-catch configurations.

Squint angle
Defines the squint angle of the transmitter and the receiver array. The Squint 
angle is half the angle between the primary axes of transmitter and receiver 
arrays. A symmetrical rotation is automatically applied to the receiving array. The 
Squint angle can have values between −89.9° and 89.9°, and a positive squint 
angle means that the primary axes of the array cross in front of the arrays (see 
Figure 8-13 on page 197). Only applicable for pitch-catch configurations.

8.2.8 Part Area

Figure 8-35  The Part area for flat part

The Part area (see Figure 8-35 on page 217) contains the following parameters:
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Type
Defines the part type supported by the Calculator:

Plate: flat part

Pipe OD: cylindrical part inspected from the outside diameter

Pipe ID: cylindrical part inspected from the inside diameter

Thickness (mm)
Defines the thickness of the part to be displayed on the Beam display info. tab.

Radius (mm)
Defines the radius of the cylindrical part. For a Pipe OD part, this value 
represents the outer radius (inner radius + thickness). For Pipe ID part, the radius 
represents the inner radius.

8.2.9 Material Area

Figure 8-36  The Material area for a flat part

Material database
Use the list and buttons to select, save, or delete a material type from the Material 
database.

 Load from database button
Use to load a material configuration from the material database.

 Save in database button
Use to save the active material configuration in the material database.

 Delete from database button
Use to delete a material configuration from the material database.
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Sound velocity area
Defines the sound velocities in the material to be inspected for the available wave 
types, Longitudinal (compression) or Transverse (shear) waves, in meters per 
second.

Density
Defines the density of the selected material.

Attenuation
Use to set the ultrasonic attenuation for the selected material.

8.2.10 Wedge Area

Figure 8-37  The Wedge area

The Wedge (mm) area (see Figure 8-37 on page 219) contains the following 
parameters:

Wedge database
Use the lists and buttons to select, save, or delete a wedge in the Wedge database.
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 Load from database button
Use to load a wedge configuration from the wedge database.

 Save in database button
Use to save the active wedge configuration in the wedge database.

 Delete from database button
Use to delete a wedge configuration from the wedge database.

Footprint
Defines the footprint of the wedge. For a Plate part, the footprint is set to Flat. For 
a cylindrical part, choose one of the following footprints: Curvature along 
primary axis or Curvature along secondary axis.

Wedge angle
Defines the wedge angle in degrees. The Wedge angle is the angle between the 
primary axis of the probe (when it is fixed on the wedge) and the surface of the 
component (or the tangential plane to the surface of the component in the case of 
a cylindrical geometry). It is obtained by a rotation around the secondary axis of 
the probe, and it can have values between 0° and 89.9° (see Figure 8-10 on 
page 194).

Roof angle
Defines the roof angle in degrees. The Roof angle is the rotation angle around the 
primary axis of the probe, and it can have values between −89.9° and 89.9°. For a 
probe skew of 0°, a positive roof angle generates beams with total skew angles 
between 0° and 180° (see Figure 8-11 on page 195).

Sound velocity
Defines the sound velocity in the wedge.

Height at the middle of the first element
Defines the height at the middle of the first element, relative to the material 
surface (see Figure 8-15 on page 200).

For a cylindrical part, the height is measured relative to the flat surface obtained 
by drawing a line between the contact points of the wedge, and this value is 
always positive (see Figure 8-16 on page 201, Figure 8-17 on page 202).
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Primary axis offset at the middle of the first element
Defines the offset of the middle of the first element along the primary axis, 
relative to the back of the wedge (see Figure 8-15 on page 200). The offset is 
always measured along a straight line, and it normally has positive values.

Secondary axis offset at the middle of the first element
Defines the offset of the middle of the first element along the secondary axis, 
relative to the left side of the wedge (see Figure 8-15 on page 200). The offset is 
always measured along a straight line, and it normally has positive values.

Primary axis position of wedge reference
Defines the primary axis position of the wedge reference relative to the 
mechanical reference (see Figure 8-15 on page 200). The offset is always measured 
along the part surface and is positive along the positive scan-axis direction.

Secondary axis position of wedge reference
Defines the secondary axis position of the wedge reference relative to the 
mechanical reference (see Figure 8-15 on page 200). The offset is always measured 
along the part surface and is positive along the positive index-axis direction.

Wedge length or Distance between contact points (wedge length)
The Wedge length is the actual length of the wedge.

For a cylindrical part with a curvature along primary axis, the wedge length 
represents the distance between the contact points of the wedge (see Figure 8-16 
on page 201, Figure 8-17 on page 202).

Wedge width or Distance between contact points (wedge width)
The Wedge width is the actual width of the wedge.

For a cylindrical part with a curvature along secondary axis, the wedge width 
represents the distance between the contact points of the wedge.

8.3 Static Beam Creation

A Static beam is an ultrasonic beam generated by a phased array probe that is similar 
to a beam generated by a conventional probe. The refracted angle, the focusing depth, 
and the primary aperture cannot be modified; they are fixed. A single beam is 
generated.

To illustrate the use of the Calculator to create a Static beam for a 1-D linear array 
probe, the following typical application is given as an example:
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Example 1: single array, flat part, probe parallel to the scan axis

The following configuration is considered:

• Single 1-D linear array probe with the following characteristics: 5 MHz nominal 
frequency, 32 elements, 1 mm pitch, and the width of the elements is 10 mm

• A Rexolite wedge with the following characteristics: 36° wedge angle, no roof 
angle, 2330 m/s wedge velocity, 12 mm height at the middle of the first element, 
9 mm primary axis offset of the first element

• A flat carbon steel part with a wall thickness of 50 mm
• The probe is oriented parallel to the scanning axis (skew 0°), and the rear end of 

the probe is positioned at 75 mm from the scan-axis reference (0 point).
• The probe generates a shear-wave beam in pulse-echo mode at a 60° refracted 

angle, focusing at a true-depth of 30 mm; all 32 elements of the probe are used to 
generate the beam.

In order to generate this Static beam, the input parameters must be set as shown in 
Figure 8-38 on page 223.

Attention should be paid to the setting of the following parameters:

• Height at the middle of the first element: 12 mm, as previously mentioned
• Primary axis offset of the first element: 9 mm, as previously mentioned
• Secondary axis offset of the first element: 15 mm, in order to position the probe 

in the middle of the wedge with a width of 30 mm
• Primary axis position of wedge reference: −75 mm, in order to position the rear 

end of the wedge at a distance of 75 mm from the scan-axis zero reference 
(mechanical reference point)

• Secondary axis position of wedge reference: −15 mm, in order to position the 
middle of the wedge at the rear end of index-axis zero reference (mechanical 
reference point)

Also, note that the database has been used to save the probe, wedge, and material 
parameters (see “Calculator — Using the Databases” on page 275).
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Figure 8-38  Static beam: input parameters

The results can be examined in the graphic representation on the Beam display info. 
tab (see Figure 8-39 on page 224).
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Figure 8-39  Static beam: visualization

8.4 Depth Beam Creation

Depth beams are a set of ultrasonic beams that are generated at a fixed refracted angle 
and fixed primary aperture, but that focus at different depths.
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To illustrate the use of the Calculator to create Depth beams for a 1-D linear array 
probe, the following typical application is given as an example:

Example 1: single array, flat part, probe perpendicular to scan axis

The following configuration is considered:

• Single 1-D linear array probe, with the following characteristics: 5 MHz nominal 
frequency, 32 elements, 1 mm pitch, and the width of the elements is 10 mm

• A Rexolite wedge with the following characteristics: 36° wedge angle, no roof 
angle, 2330 m/s wedge velocity, 12 mm height at the middle of the first element, 
9 mm primary axis offset of the first element

• A flat carbon steel part with a wall thickness of 100 mm
• The probe is oriented perpendicular to the scanning axis (skew 90°), and the rear 

end of the probe is positioned at 75 mm from the index-axis reference (0 point).
• The probe generates shear-wave beams in pulse-echo mode at a refracted angle of 

45°, focusing between a true-depth distance of 20 mm to 80 mm with a depth 
resolution of 10 mm; all 32 elements of the probe are to be used to generate the 
beam.

In order to generate this set of Depth beams, the input parameters must be set as 
shown in Figure 8-40 on page 226.

Attention should be paid to the setting of the following parameters:

• Height at the middle of the first element: 12 mm, as previously mentioned
• Primary axis offset of the first element: 9 mm, as previously mentioned
• Secondary axis offset of the first element: 15 mm, in order to position the probe 

in the middle of the wedge with a width of 30 mm
• Primary axis position of wedge reference: −75 mm, in order to position the rear 

end of the wedge at a distance of 75 mm from the index-axis zero reference
• Secondary axis position of wedge reference: −15 mm, in order to position the 

middle of the wedge at the rear end of scan-axis zero reference

Also, note that the database has been used to save the probe, wedge, and material 
parameters (see “Calculator — Using the Databases” on page 275).
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Figure 8-40  Depth beams: input parameters

The results can be examined in the graphic representation on the Beam display info. 
tab (see Figure 8-41 on page 227).
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Figure 8-41  Depth beams: visualization
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8.5 Sectorial Beam Creation

Sectorial beams are a set of ultrasonic beams that are generated at a fixed focusing 
distance and fixed primary aperture, though at different inspection angles (refracted 
angles and/or skew angles).

To illustrate the use of the Calculator for creating a set of Sectorial beams for 1-D 
linear array probes, various typical applications are given as examples.

Example 1: single array, flat part, probe perpendicular to the scan axis

The following configuration is considered:

• Single 1-D linear array probe, with the following characteristics: 5 MHz nominal 
frequency, 32 elements, 1 mm pitch, and the width of the elements is 10 mm

• A Rexolite wedge with the following characteristics: 36° wedge angle, no roof 
angle, 2330 m/s wedge velocity, 12 mm height at the middle of the first element, 
9 mm primary axis offset of the first element

• A flat carbon steel part with a wall thickness of 50 mm
• The probe is oriented perpendicular to the scanning axis (skew 90°), and the rear 

end of the probe is positioned at 70 mm from the index-axis reference (0-point).
• The probe generates shear-wave beams in pulse-echo mode at refracted angles 

from 40° to 70° with a resolution of 5°, focusing at a constant half-path distance of 
40 mm; all 32 elements of the probe are to be used to generate the beam.

In order to generate this set of Sectorial beams, the input parameters must be set as 
shown in Figure 8-42 on page 229.

Attention should be paid to the setting of the following parameters:

• Height at the middle of the first element: 12 mm, as mentioned previously.
• Primary axis offset of the first element: 9 mm, as mentioned previously.
• Secondary axis offset of the first element: 15 mm, in order to position the probe 

in the middle of the wedge with a width of 30 mm
• Primary axis position of wedge reference: −70 mm, in order to position the rear 

end of the wedge at a distance of 70 mm from the index-axis zero reference
• Secondary axis position of wedge reference: −15 mm, in order to position the 

middle of the wedge at the rear end of scan-axis zero reference

Also, note that the database has been used to save the probe, wedge, and material 
parameters (see “Calculator — Using the Databases” on page 275).
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Figure 8-42  Sectorial beams: input parameters for sectorial sweep on a flat part

The results can be examined in the graphic representation on the Beam display info. 
tab (see Figure 8-43 on page 230).
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Figure 8-43  Sectorial beams: visualization of sectorial sweep on a flat part

Example 2: single array, flat part, probe parallel to scan axis, “lateral scan”

The following configuration is considered:
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• Single 1-D linear array probe, with the following characteristics: 5 MHz nominal 
frequency, 32 elements, 1 mm pitch, and the width of the elements is 10 mm

• A Rexolite wedge with the following characteristics: no wedge angle, 31° roof 
angle, 2330 m/s wedge velocity, 12 mm height at the middle of the first element, 
9 mm primary axis offset of the first element

• A flat carbon steel part with a wall thickness of 50 mm
• The probe is used to generate shear-wave beams at refracted angles of 

approximately 45°, skewed from at least −30° to +30° relative to the orientation 
perpendicular to the scan axis, and focusing at a constant depth of 35 mm; all 
32 elements of the probe are to be used to generate the beams.

• The probe itself is oriented parallel to the scanning axis (skew 0°), and the probe is 
positioned so that the focal points coincide approximately with the index-axis 
reference (0 point), and so that the center beam is aimed at the scan-axis reference.

• This type of configuration is often called a “lateral scan” technique, and can be 
used to improve detection of misoriented (skewed) flaws.

In order to generate this set of Sectorial beams, the input parameters must be set as 
shown in Figure 8-44 on page 232.

Attention should be paid to the following parameters:

• The beam angles are selected using the Primary steering angle as the input 
parameter. In the case of a lateral scan with a linear array probe, this is the most 
efficient way to define the angles, since the refracted angle changes from 53.4° 
down to 45.6° and back to 53.4°.

• Height at the middle of the first element: 12 mm, as previously mentioned
• Primary axis offset of the first element: 9 mm, as previously mentioned
• Secondary axis offset of the first element: 15 mm, in order to position the probe 

in the middle of the wedge with a width of 30 mm
• Primary axis position of wedge reference: −25 mm, in order to position the center 

beam focal point end at the scan-axis reference
• Secondary axis position of wedge reference: −60 mm, in order to position the 

focal point locus at the index-axis reference

Also, note that the database has been used to save the probe, wedge, and material 
parameters (see “Calculator — Using the Databases” on page 275).
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Figure 8-44  Sectorial beams: input parameters for “lateral scan” on a flat part

The results can be examined in the graphic representation on the Beam display info. 
tab (see Figure 8-45 on page 233).
Chapter 8232



DMTA-20093-01EN, Rev. D, September 2022
Figure 8-45  Sectorial beams: visualization of “lateral scan” on a flat part

Example 3: dual array, flat part, probe parallel to scan axis

The following configuration is considered:
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• Dual 1-D linear array probe (pitch-catch), with the following characteristics: 
2.25 MHz nominal frequency, 2 × 16 elements, 1.7 mm pitch, and the width of the 
elements is 6.6 mm

• The probe contains two identical Rexolite wedges with the following 
characteristics: 19.2° wedge angle, 4.7° roof angle, 2330 m/s wedge velocity, 
5.4 mm height at the middle of the first element, 7.9 mm primary axis offset of the 
first element; 15 mm probe separation, 6° squint angle

• A flat carbon steel part with a wall thickness of 50 mm
• The probe is oriented parallel to the scanning axis (skew 0°), and the rear end of 

the probe is positioned at 50 mm from the scan-axis reference (0-point).
• The probe generates compression wave beams in pitch-catch mode at refracted 

angles from 45° to 70° with a resolution of 5°; all 16 elements of the transmitter 
and receiver arrays are used to generate the beams. The focalization depth is 
automatically calculated to focus the transmitter and the receiver at the same 
position. The focalization is therefore made at the geometrical intersection of the 
transmitter and the receiver.

In order to generate this set of Sectorial beams, the input parameters must be set as 
shown in Figure 8-46 on page 235.

Attention should be paid to the setting of the following parameters:

• Height at the middle of the first element: 5.4 mm, as previously mentioned
• Primary axis offset of the first element: 7.9 mm, as previously mentioned
• Secondary axis offset of the first element: 5 mm, in order to position the probe in 

the middle of the wedge with a width of 10 mm
• Primary axis position of wedge reference: −50 mm, in order to position the rear 

end of the wedge at a distance of 50 mm from the scan-axis zero reference
• Secondary axis position of wedge reference: −12.5 mm, in order to position the 

symmetrical line between the transmitter and the receiver arrays at the index-axis 
zero reference

Also, note that the database has been used to save the probe, wedge, and material 
parameters (see “Calculator — Using the Databases” on page 275).
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Figure 8-46  Sectorial beams: input parameters for a pitch-catch configuration

The results can be examined in the graphic representation on the Beam display info. 
tab (see Figure 8-47 on page 236).
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Figure 8-47  Sectorial beams: visualization of a pitch-catch configuration

Example 4: single array, pipe OD, probe perpendicular to the pipe axis

The following configuration is considered:
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• Single 1-D linear array probe, with the following characteristics: 5 MHz nominal 
frequency, 32 elements, 1 mm pitch, and the width of the elements is 10 mm

• A Rexolite wedge with the following characteristics: 36° wedge angle, no roof 
angle, 2330 m/s wedge velocity, 9 mm height at the middle of the first element, 
7 mm primary axis offset of the first element, a curvature along primary axis with 
an 80 mm distance between contact points

• A pipe inspected from the outside diameter (Pipe OD) in carbon steel with an 
outside radius of 150 mm and a wall thickness of 25 mm

• The probe is oriented parallel to the scanning axis (skew 0°) and perpendicular to 
the pipe axis. The rear end of the probe is positioned at 40 mm from the scan-axis 
reference (0 point).

• The probe generates shear-wave beams in pulse-echo mode at refracted angles 
from 35° to 55° with a resolution of 5°, focusing at a constant cylindrical depth of 
25 mm (focusing on the back wall of the pipe); all 32 elements of the probe are to 
be used to generate the beam.

In order to generate this set of Sectorial beams, the input parameters must be set as 
shown in Figure 8-48 on page 238.

Attention should be paid to the setting of the following parameters:

• Height at the middle of the first element: 9 mm, as previously mentioned
• Primary axis offset of the first element: 7 mm, as previously mentioned
• Secondary axis offset of the first element: 20 mm, in order to position the probe 

in the middle of the wedge with a width of 40 mm
• Primary axis position of wedge reference: −40 mm, in order to position the rear 

end of the wedge at a distance of 40 mm from the scan-axis zero reference and to 
position the center of the pipe at the scan-axis zero reference

• Secondary axis position of wedge reference: −20 mm, in order to position the 
middle of the wedge at the index-axis zero reference

Also, note that the database has been used to save the probe, wedge, and material 
parameters (see “Calculator — Using the Databases” on page 275).
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Figure 8-48  Sectorial beams: input parameters for sectorial sweep on a pipe part

The results can be examined in the graphic representation on the Beam display info. 
tab (see Figure 8-49 on page 239).
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Figure 8-49  Sectorial beams: visualization of sectorial sweep on a pipe part
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8.6 Linear Beam Creation

Linear beams are ultrasonic beams that are generated at a fixed refracted angle and a 
fixed focusing distance, but with a primary aperture traveling along the array, thus 
generating the same beams with a different set of active elements. By moving the 
beam along a transducer array, scanning along an inspection axis is achieved 
electronically without physically displacing the transducer (see Figure 8-50 on 
page 240).

Figure 8-50  Electronic scanning along an axis

To illustrate the use of the Calculator for creating Linear beams for a 1-D linear array 
probe, the following typical application is given as an example.

Example 1: single array, flat part, probe perpendicular to scan axis

The following configuration is considered:

• Single 1-D linear array probe, with the following characteristics: 5 MHz nominal 
frequency, 64 elements, 1 mm pitch, and the width of the elements is 10 mm

• A Rexolite wedge with the following characteristics: 36° wedge angle, no roof 
angle, 2330 m/s wedge velocity, 12 mm height at the middle of the first element, 
9 mm primary axis offset of the first element

• A flat carbon steel part with a wall thickness of 50 mm
• The probe is oriented perpendicular to the scanning axis (skew 90°), and the rear 

end of the probe is positioned at 100 mm from the index-axis reference (0 point).

641

16

Scanning direction

Active group
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• The probe generates shear-wave beams in pulse-echo mode at a refracted angle of 
55°, focusing at a constant half-path distance of 50 mm. 16 elements of the probe 
are used to generate the beams.

In order to generate this set of Linear beams, the input parameters must be set as 
shown in Figure 8-51 on page 242.

Attention should be paid to the setting of the following parameters:

• Height at the middle of the first element: 12 mm, as previously mentioned
• Primary axis offset of the first element: 9 mm, as previously mentioned
• Secondary axis offset of the first element: 15 mm, in order to position the probe 

in the middle of the wedge with a width of 30 mm
• Primary axis position of wedge reference: −100 mm, in order to position the rear 

end of the wedge at a distance of 100 mm from the index-axis zero reference
• Secondary axis position of wedge reference: −15 mm, in order to position the 

middle of the wedge at the rear end of scan-axis zero reference

Also, note that the database has been used to save the probe, wedge, and material 
parameters (see “Calculator — Using the Databases” on page 275).
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Figure 8-51  Linear beams: input parameters

The results can be examined in the graphic representation on the Beam display info. 
tab (see Figure 8-52 on page 243).
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Figure 8-52  Linear beams: visualization
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8.7 Saving a Calculator Setup File (.xcal)

To save a Calculator setup file (.xcal)

1. Enter the parameters of the beams to be generated.
2. On the menu, select File > Save As or click Save As at the bottom of the 

Calculator dialog box.
3.  In the Save As dialog box, do the following:

a) Select the folder where you want to save the .xcal file.
b) Enter an appropriate file name.
c) In the Save as type box, select Extended Calculator Setup Files (*.xcal).
d) Click Save (see Figure 8-53 on page 244).

Figure 8-53  The Save As dialog box

The Calculator Setup File contains only the parameter values and settings entered in 
the Calculator; it does not contain the generated beams (the delays to be programed in 
the instrument).

8.8 Saving a Beam File (.law)

You can save the Calculator configuration to a beam file (.law) that can later be 
imported.

NOTE
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To save a beam file (.law)

1. Enter the parameters of the beams to be generated
2. On the menu, select File > Save As or click Save As at the bottom of the 

Calculator dialog box.
3. In the Save As dialog box, do the following:

a) Select the folder where you want to save the .law file.
b) Enter an appropriate file name.
c) In the Save as type box, select Law Files (*.law).
d) Click Save (see Figure 8-54 on page 245).

Figure 8-54  The Save As dialog box
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9. Calculator — 1-D Annular Arrays Tab

This section presents 1-D annular arrays and describes the Calculator’s 1-D Annular 
array tab.

9.1 Generic Conventions

To generate beams for 1-D annular arrays in the most efficient and accurate way, you 
should take into account the generic conventions regarding the probe wedge.

9.1.1 Probe Conventions

Fresnel annular array

When a Fresnel type annular array is used, only the First radius (R1) and the Spacing 
between elements (S) must be specified (see “Probe Area” on page 254). Based on 
these values, the internal and external radii of the successive elements are calculated 
according to the following formula:

A Fresnel type annular array is characterized by the fact that all elements have the 
same surface area, and they are separated by a constant distance (see Figure 9-1 on 
page 248).

R1
2 R1

ext2 R1
int2– RNext2 RNint2–= =
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Figure 9-1  Fresnel annular array

The central element is always positioned at the zero point of the scan axis and of the 
index axis.

Custom annular array

When a Custom type annular array is used, the Internal Radius (Rn
int) and the 

External Radius (Rn
ext) of each element must be specified (see “Probe Area” on 

page 254). Based on these values, the distance between each element is calculated.

A Custom type annular array can have different radii and variable spacing between 
consecutive elements (see Figure 9-2 on page 249).
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Figure 9-2  Custom annular array

The central element is always positioned at the zero point of the scan axis and of the 
index axis.

9.1.2 Important Details on the Delay Calculation

For both Fresnel type and Custom type annular arrays, the delay for each element is 
calculated at the radius Ri

calc, for which the following statement is true: half of the 
surface of the element is within this radius and half of the surface of the element is 
outside of this radius. Mathematically, this is expressed as follows:

Riext2 Ricalc2– Ricalc2 Riint2–=
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9.2 Tab Description

The 1-D Annular array tab is divided into seven areas (see Figure 9-3 on page 250).

Figure 9-3  The 1-D Annular array tab
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9.2.1 Acquisition Unit Area

Figure 9-4  The Acquisition Unit area

The Acquisition Unit area (Figure 9-4 on page 251) contains only one list for the 
selection of the type of acquisition instrument for which you want to create beams. 
The beam calculation uses slightly different compensation gain for each acquisition 
instrument type. The list is available only when no acquisition instrument is 
connected to the computer. The acquisition instrument is automatically detected 
when it communicates with the computer.

9.2.2 Scan Type Area

Figure 9-5  The Scan Type area

The Scan Type area (see Figure 9-5 on page 251) is used to select the type of beams to 
be generated:

• Depth: the focusing depth of the ultrasonic beam varies.
• Static: the focusing depth of the ultrasonic beam is fixed (generates a single 

beam).
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9.2.3 Beam Angles Selection Area

Figure 9-6  The Beam Angles Selection area

The Beam Angles Selection area (see Figure 9-6 on page 252) is not applicable for the 
1-D annular array option, because only ultrasonic beams at 0° (longitudinal waves) 
are considered.

9.2.4 Focal Points Selection Area

Figure 9-7  The Focal Points Selection area

The Focal Points Selection (mm) area (see Figure 9-7 on page 252) contains the 
following parameters:
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Focusing type
Selects the type of focusing of the beams to be generated:

— True depth: all beams are focused at a constant true-depth value. For a 
cylindrical part, the true-depth value is the depth in the cylindrical geometry.

— Half path: all beams are focused at a constant half-path (distance) value.
— Projection: all beams are focused on a given vertical plane; this option is not 

applicable for depth laws or pitch-catch configurations.
— Focal plane: all beams are focused on a user-defined focal plane (see 

Figure 8-27 on page 211); this option is not applicable for depth laws or for 
pitch-catch configurations.

Focal plane position
Not applicable for a 1-D annular array.

Emission focus position (depth)
Defines the desired focusing depth of the ultrasonic beam to be generated.

For Depth beams: the three boxes are used to set the desired initial (Start) and 
final (Stop) focusing depth of the ultrasonic beam to be generated and to set its 
resolution.

Reception focus position (depth)
Defines the desired focusing depth (applied delay) for the received signal.

9.2.5 Elements Selection Area

Figure 9-8  The Elements Selection area

The Elements Selection area (see Figure 9-8 on page 253) contains the following 
parameters:

 

Calculator — 1-D Annular Arrays Tab 253



DMTA-20093-01EN, Rev. D, September 2022
Pulser
Use to set the first element of the active pulser group.

Receiver
Use to set the first element of the active receiver group.

Primary axis aperture
Use to set the number of elements used simultaneously to generate beams.

9.2.6 Probe Area

Figure 9-9  The Probe area for annular arrays

The Probe area (see Figure 9-9 on page 254) contains the following parameters:

Probe database
Use the list and the buttons to select, save, or delete a probe in the Probe database.

 Load from database
Use to load a probe configuration from the probe database.
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 Save in database
Use to save the active probe configuration in the probe database.

 Delete from database
Use to delete a probe configuration from the probe database.

Probe skew angle (deg)
Defines the skew angle of the probe. The probe skew angle is always 0° for a 1-D 
annular array since it only generates ultrasonic beams at 0°.

Probe frequency (MHz)
Defines the probe frequency.

Number of elements on primary axis
Defines the number of elements on the primary axis (radial) of the current probe.

First radius (mm)
Defines the radius of the central element. This parameter is only applicable for 
Fresnel type annular arrays (see Figure 9-1 on page 248).

Space between elements (mm)
Defines the space between two consecutive elements; that is, the distance between 
the external radius of the nth element to the internal radius of the (n+1)th element. 
Only applicable for Fresnel type annular arrays (see Figure 9-1 on page 248).

Radius button
Opens the Annular Array Radius dialog box (see Figure 9-10 on page 256), which 
enables the creation of a Custom annular array.

When a Fresnel type annular array is used, the dialog box provides the possibility 
to verify the radius of each element.

Fresnel option button
Defines a Fresnel type annular array characterized by the fact that each element 
has the same surface (same area) and is separated by a constant distance (see 
Figure 9-1 on page 248).

Custom option button
Defines a Custom type annular array with arbitrary radii and a variable spacing 
between consecutive elements (see Figure 9-2 on page 249).
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9.2.7 Annular Array Radius Dialog Box

Figure 9-10  The Annular Array Radius dialog box

The Annular Array Radius dialog box (see Figure 9-10 on page 256) contains the 
following parameters:

Load button
Opens a standard Open dialog box, which enables you to load a text file (.txt file) 
containing the internal and external radius of each element.

Save button
Opens a standard Save As dialog box, which enables you to save the internal and 
the external radii of each element in a text file (.txt file).

It is important to note that the internal and external radii of a Custom annular 
array defined in the Annular Array Radius dialog box are not saved in the .xcal 
file.

OK button
Applies the defined radius.
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Cancel button
Closes the Annular Array Radius dialog box.

9.2.8 Part Area

Figure 9-11  The Part area for flat part

The Part area (see Figure 9-11 on page 257) contains the following parameters:

Type
Defines the part type supported by the Calculator—for example, Plate, which is a 
flat part.

Thickness (mm)
Defines the thickness of the part to be displayed on the Beam Display Info tab.

9.2.9 Material Area

Figure 9-12  The Material area for flat part

Material database
Use the list and the buttons to select, save, or delete a material type in the 
Material database.
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 Load from database button
Use to load a material configuration from the material database.

 Save in database button
Use to save the active material configuration in the material database.

 Delete from database button
Use to delete a material configuration from the material database.

Sound velocity area
Defines the sound velocities in the material to be inspected for the available wave 
types, Longitudinal (compression) or Transverse (shear) waves, in 
meters/second.

Density
Defines the density of the selected material.

Attenuation
Used to set the ultrasonic attenuation for the selected material.

9.2.10 Wedge Area

Figure 9-13  The Wedge area for annular arrays

The Wedge area (see Figure 9-13 on page 258) contains the following parameters:
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Wedge database
Use the list and the buttons to select, save, or delete a wedge in the Wedge 
database.

 Load from database
Use to load a wedge configuration from the wedge database.

 Save in database
Use to save the active wedge configuration in the wedge database.

 Delete from database
Use to delete a wedge configuration from the wedge database.

Sound velocity (m/s)
Defines the sound velocity in the wedge.

Height at the middle of the central element (mm)
Defines the height at the middle of the central element relative to the material 
surface.

9.3 Creating Depth Beams for Annular Arrays

Depth beams are a set of ultrasonic beams that focus at different depths.

To illustrate the use of the calculator for creating Depth beams for a 1-D annular array 
probe, the following typical application is given as an example.

Example 1: Fresnel annular array

The following configuration is considered:

• Single 1-D annular array probe, Fresnel type with the following characteristics: 
5 MHz nominal frequency, 16 elements, 5 mm first radius, and the spacing 
between elements is 2 mm

• A Rexolite wedge with the following characteristics: 2330 m/s wedge velocity, 
10 mm height at the middle of the central element

• A flat carbon steel part with a wall thickness of 100 mm
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• The probe generates compression wave beams in pulse-echo mode at 0°, focusing 
between a true-depth distance of 10 mm to 90 mm with a depth resolution of 
10 mm; all 16 elements of the probe are to be used to generate the beam.

In order to generate this set of Depth beams, the input parameters must be set as 
shown in Figure 9-14 on page 261.

Note that the database has been used to save the probe, wedge, and material 
parameters (see “Calculator — Using the Databases” on page 275).
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Figure 9-14  Fresnel annular array: Depth beam input parameters

The results can be examined in the graphic representation on the Beam display info. 
tab (see Figure 9-15 on page 262).
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Figure 9-15  Fresnel annular array: Depth beam visualization
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10. Calculator — 2-D Matrix Array Tab

This section describes how to create beams when inspecting parts using a 2-D matrix 
probe.

Sectorial beams are a set of ultrasonic beams that are generated at a fixed focusing 
distance with a fixed primary aperture, though at different inspection angles 
(refracted angles and/or skew angles).

The following is an example of configuration of Sectorial beams.

The probe, part, and wedge parameters are as follows:

• Two 2-D matrix probe, 5 MHz, 16 elements organized as follows: 4 elements on 
the primary axis and 4 elements on the secondary axis. The primary and 
secondary axis pitches are 2 mm. The probe configuration is of the type 1 (as 
defined in the Calculator).

• The part is a flat steel part with a thickness of 50 mm. The sound velocity in the 
part is 3200 m/s.

• A wedge, with a 2330 m/s sound velocity, is angled at 30°. The height at the 
middle of the first element is 4 mm and the primary axis offset of the first element 
is 3 mm. The secondary axis offset of the first element is also 3 mm. The wedge is 
12 mm long and 12 mm wide.

The inspection parameters are as follows:

• The inspection is done in the pulse-echo mode, using longitudinal waves.
• The focusing type is true-depth and the beam is focused at 10 mm.
• The probe motion is parallel to the scanning axis (skew 0°).
• The steering angles ranges from −10° to 10° in steps of 2° on both primary and 

secondary axes.
• The aperture uses all the elements of the probe.
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Figure 10-1 on page 264 presents the parameters to be entered to create the sectorial 
beams.

Figure 10-1  Example of parameters of sectorial beams for a 2-D matrix probe
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The results can be examined in the graphic representation on the Beam display info. 
tab (see Figure 10-2 on page 265).

Figure 10-2  Graphic representation of the sectorial beams for a 2-D matrix probe
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11. Calculator — Beam Display Info. Tab

The Calculator’s Beam display info. tab (see Figure 11-1 on page 268) can be used to 
verify and validate the inputs and the resulting beams for any of the supported array 
types. In addition to a graphical representation of the defined probe, wedge, and part, 
it also provides detailed numerical information for each of the created delay laws: 
position of beam exit point and focal point, beam refracted angle and skew angle, etc.
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Figure 11-1  The Beam display info. tab

The Beam display info. tab (see Figure 11-1 on page 268) contains the following data:

VC-Top (C)
This volume-corrected view is a 2-D graphical representation of the top view of 
the defined probe and part. One of the axes is the scan axis and the other is the 
index axis. The defined probe and wedge can be displayed along with the ray 
tracing of the beams.
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VC-Side (B)
This volume-corrected view is a 2-D graphical representation of the side of the 
defined probe and part. One of the axes is the scan axis and the other is the 
ultrasonic (Usound) axis. The defined probe and wedge can be displayed along 
with the ray tracing of the beams.

VC-End (D)
This volume-corrected view is a 2-D graphical representation of the end of the 
defined probe and part. One of the axes is the index axis and the other is the 
ultrasonic (Usound) axis. The defined probe and wedge can be displayed along 
with the ray tracing of the beams.

3-D
This view is a 3-D representation of the defined probe, wedge, and part.

The Top View button automatically readjusts the zoom and repositions the pane 
content in order to get a representation from the top of the part.

The Side View button automatically readjusts the zoom and repositions the pane 
content in order to get a representation from the side of the part.

The End View button automatically readjusts the zoom and repositions the pane 
content in order to get a representation from the end of the part.

In the 3-D Visualization view:
— Click and drag to rotate the 3-D model.
— Right-click and drag to move the 3-D model.
— Click the wheel button and drag to zoom in or out the view.

Fit Image to Pane ( )
This button simultaneously unzooms the content of the four views.

Current beam
Identifies the current beam.

Sectorial laws, depending on the Beam angle selection, are identified as follows:

Sectorial A: angle

Sectorial St: steering angle

Sectorial Sk: skew angle

Linear laws are identified as follows:
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Linear L: 1-16, where 1 and 16 represent the first and the last element used to 
generate the law

Depth laws are identified as follows:

Depth D: 45, where 45 represents the focalization depth

Static laws are identified as follows:

Static A: 30, where 30 represents the refracted angle

Beam information
Indicates the beam Exit point and Focal point in Cartesian coordinates (Scan, 
Index, and Usound) and, for cylindrical coordinates (Circumferential, Axial, and 
Depth) for the current beam.

Angle information
Indicates the Refr. Angle (refracted angle), the total Skew angle (beam skew 
angle + probe skew angle), the Primary, and the Secondary Steering angle of the 
current beam.

Display options
Use these check boxes to display or hide the following options:

— Wedge (wire frame) or solid wedge
— Probe (wire frame) or solid probe
— Part
— Element numbers
— Focal point
— Focal point locus
— Rebound path
— Weld center
The user-defined options are saved upon closing the Calculator.

Color
Use to define the color of the following components:

— Wedge
— Part
— Element
— Beam
The user-defined colors are saved upon closing the Calculator.
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Near-Field information
Indicates the Primary Aperture Near-Field Depth and the Secondary Aperture 
Near-Field Depth.
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12. Calculator — Elements Info. Tab

The Calculator’s Elements Info. tab presents lists for the pulser and the receiver 
elements (see Figure 12-1 on page 274). The lists contain the calculated delays for each 
element number for the beam selected in the Current Beam area.
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Figure 12-1  Example of the Elements Info. tab
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13. Calculator — Using the Databases

The Calculator uses a database to store information related to the probes, the material, 
and the wedges. The database file is located in a FocusPC folder in the following 
default location:

C:\EvidentNDT\FocusPCnnn

The FocusPC installer creates the following files in the database folder:

UtDatabase.mdb
Active database file containing factory default information used by the 
Calculator.

UtDatabase-InstallationBackUp-xxxx.tmp.mdb
If a previous version of the Calculator was installed, a copy of the existing 
UtDatabase.mdb is created with this name, where xxxx is an automatically 
generated unique ID for the file. Rename this file to UtDatabase.mdb if you 
want to restore the content of the database as it was for the previous version of the 
Calculator.

13.1 Probe Database

The Probe database enables you to save, load, or delete a user-defined probe 
configuration.

To save a probe configuration in the Probe database

1. Enter the probe parameters with an appropriate probe name (see Figure 13-1 on 
page 276).
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Figure 13-1  Probe parameters

2. Click the Save in database button ( ), and then click OK (see Figure 13-2 on 
page 276).
The probe configuration is automatically saved in the Probe database.

Figure 13-2  Saving a probe using the Probe Configuration dialog box
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To load a probe configuration from the Probe database

1. In the Calculator, click the Load from database button ( ).
2. In the Probe Configuration dialog box, select the desired probe configuration, 

and then click OK.
The probe configuration is automatically loaded from the Probe database.

To delete a probe configuration from the Probe database

1. In the Calculator, click the Delete from database button ( ).
2. In the Probe Configuration dialog box, select the probe configuration that you 

want to delete, and then click Delete.
3. Click OK to close the dialog box (see Figure 13-3 on page 277).

The probe configuration is automatically deleted from the Probe database.

Figure 13-3  Deleting a probe using the Probe Configuration dialog box

13.2 Material Database

The Material database enables you to save, load, or delete a user-defined material 
configuration.
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To save a material configuration in the Material database

1. Enter the material parameters with an appropriate material name (see Figure 13-4 
on page 278).

Figure 13-4  Material parameters

2. Click the Save in database button ( ), and then click OK (see Figure 13-5 on 
page 278).
The material configuration is automatically saved in the Material database.

Figure 13-5  Saving a material type using the Material Configuration dialog box

To load a material configuration from the Material database

1. In the Calculator, click the Load from database button ( ).
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2. In the Material Configuration dialog box, select the desired material 
configuration, and then click OK.
The material configuration is automatically loaded from the Material database.

To delete a material configuration from the Material database

1. In the Calculator, click the Delete from database button ( ).
2. In the Material Configuration dialog box, select the material configuration that 

you want to delete, and then click Delete.
3. Click OK to close the dialog box (see Figure 13-6 on page 279).

The material configuration is automatically deleted from the Material database.

Figure 13-6  Deleting a material type using the Material Configuration dialog box

13.3 Wedge Database

The Wedge database enables you to save, load, or delete a user-defined wedge 
configuration.

To save a wedge configuration in the Wedge database

1. Enter the wedge parameters with an appropriate wedge name (see Figure 13-7 on 
page 280).
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Figure 13-7  Wedge parameters

2. Click the Save in database button ( ), and then click OK (see Figure 13-8 on 
page 281).
The wedge configuration is automatically saved in the Wedge database.

 

Chapter 13280



DMTA-20093-01EN, Rev. D, September 2022
Figure 13-8  Saving a wedge using the Wedge Configuration dialog box

To load a wedge configuration from the Wedge database

1. In the Calculator, click the Load from database button ( ).
2. In the Wedge Configuration dialog box, select the desired wedge configuration, 

and then click OK.
The wedge configuration is automatically loaded from the Wedge database.

To delete a wedge configuration from the Wedge database

1. In the Calculator, click the Delete from database button ( ).
2. In the Wedge Configuration dialog box, select the wedge configuration that you 

want to delete, and then click Delete.
3. Click OK to close the dialog box (see Figure 13-9 on page 282).

The wedge configuration is automatically deleted from the Wedge database.
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Figure 13-9  Deleting a wedge using the Wedge Configuration dialog box
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Appendix A: Theoretical Considerations on Law Delay 
Accuracy

The Calculator calculates beam delays to electronically generate an ultrasonic probe 
for which the active surface is a Fermat surface for the considered focal point in the 
material. This means that the rays from the individual elements (center points) of the 
probe to the focal point should have equal flight times (FT). The errors are therefore 
expressed in time units, typically nanoseconds (ns). This approach is very similar to 
the optical path difference (OPD) parameter, expressed in number of wavelengths, 
used for quantitative assessment of the quality of optical systems (lenses, etc.).

In optics, it is assumed that a system with a maximum OPD error that is smaller than 
a quarter of the wave length generates a “sensibly” perfect image (refer to Warren J. 
Smith, Modern Optical Engineering, Chapter 11 “Image Evaluation,” 1966, McGraw 
Hill). This defined limit is called the Rayleigh criterion, and is used for evaluation of 
aberrations (errors) in precision optics (microscopes, telescopes, etc.).

When applying this criterion to the calculation of beam delays for ultrasonic array 
probes, a maximum difference of a quarter of a wavelength can be allowed, compared 
to an ideal Fermat surface. For typical probe frequencies used in nondestructive 
testing, the criterion yields the following allowable maximum delay differences:

• For a 10 MHz probe: 25 nanoseconds
• For a 5 MHz probe: 50 nanoseconds
• For a 2.25 MHz probe: 111 nanoseconds

For comparison purposes, a delay difference of 50 nanoseconds is equivalent to a 
mechanical accuracy of 0.06 millimeters (0.0025 inch) in the fabrication of the wedge, 
or an accuracy of approximately 0.1 degrees for the wedge angle.
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Appendix B: Description of the .law File Format

This appendix describes the .law file format used to create specific beam 
configurations. The .law file format is contained in text files that can be loaded 
directly into FocusPC.

To use the .law file format, you must have a good background knowledge of phased 
array technology in general, and of the hardware and software in particular.

B.1 General Format

This section details the .law file format and example for version 5.0 and version 5.2.

B.1.1 Format

This section describes the .law file format.

Law file version 5.0

The .law file format for version 5.0 is described as follows:

<Version> <Number of Laws>

<Number of Active Elements> <Frequency> <Cycles> <Sum Gain> <Mode> <Filter> 
<Refracted Angle> <Beam Skew Angle> <First Pulser> <First Receiver> <Scan 
Offset> <Index Offset> <Global Delay> <Focusing Depth> <Material Velocity>

<Element number> <Beam_Gain> <Transmission Delay> <Reception Delay> <Amplitude> 
<Pulse Width>
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Law file version 5.2

The .law file format for version 5.2 is described as follows:

<Version> <Number of Laws>

<Element Number> <Frequency> <Cycles> <Sum Gain> <Mode> <Filter> <Refracted 
Angle> <First Pulser> <First Receiver> <Scan Exit> <Index Exit> <Global 
Delay> <Focusing Depth> <Material Velocity> <Probe Skew Angle> <Beam Skew 
Angle>

<Element number> <Beam_Gain> <Transmission Delay> <Reception Delay> <Amplitude> 
<Pulse Width>

B.1.2 Examples

Law file version 5.0

The following is an example of a .law file containing two beams of 10 elements each, 
as generated by the Calculator:

V5.0 2
16 300 1 -1 1 0 400 900 1 1 0 -46040 13869 50000 3240
1 0 570 570 40 100
2 0 539 539 40 100
3 0 508 508 40 100
4 0 475 475 40 100
5 0 442 442 40 100
6 0 407 407 40 100
7 0 372 372 40 100
8 0 335 335 40 100
9 0 297 297 40 100
10 0 258 258 40 100
11 0 218 218 40 100
12 0 176 176 40 100
13 0 134 134 40 100
14 0 90 90 40 100
15 0 46 46 40 100
16 0 0 0 40 100
16 300 1 -1 1 0 500 900 1 1 0 -44142 14282 50000 3240
1 0 175 175 40 100
2 0 168 168 40 100
3 0 161 161 40 100
4 0 153 153 40 100
5 0 145 145 40 100
6 0 136 136 40 100
7 0 126 126 40 100
8 0 115 115 40 100
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9 0 103 103 40 100
10 0 91 91 40 100
11 0 78 78 40 100
12 0 64 64 40 100
13 0 49 49 40 100
14 0 34 34 40 100
15 0 17 17 40 100
16 0 0 0 40 100

Law file version 5.2

The following is an example of a .law file for version 5.2:

V5.2 2
16 300 1 -1 1 0 400 1 1 -46040 0 13869 50000 3240 900 0
1 0 570 570 40 100
2 0 539 539 40 100
3 0 508 508 40 100
4 0 475 475 40 100
5 0 442 442 40 100
6 0 407 407 40 100
7 0 372 372 40 100
8 0 335 335 40 100
9 0 297 297 40 100
10 0 258 258 40 100
11 0 218 218 40 100
12 0 176 176 40 100
13 0 134 134 40 100
14 0 90 90 40 100
15 0 46 46 40 100
16 0 0 0 40 100
16 300 1 -1 1 0 500 1 1 -44142 0 14282 50000 3240 900 0
1 0 175 175 40 100
2 0 168 168 40 100
3 0 161 161 40 100
4 0 153 153 40 100
5 0 145 145 40 100
6 0 136 136 40 100
7 0 126 126 40 100
8 0 115 115 40 100
9 0 103 103 40 100
10 0 91 91 40 100
11 0 78 78 40 100
12 0 64 64 40 100
13 0 49 49 40 100
14 0 34 34 40 100
15 0 17 17 40 100
16 0 0 0 40 100
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B.2 Object Description

The .law file object is defined by general parameters related to the file format and law 
parameters related to the beams.

B.2.1 General Parameters

The following general parameters are related to the .law file format:

Version
The version of the .law file in the following format: <V> <number> <ʹ.ʹ> <number>.

Number of Laws
The total number of beams defined in the file. This value ranges from 1 to 256.

B.2.2 Law Parameters

This section provides descriptions of the beam-related parameters in the .law file.

Number of Active Elements
The number of active elements used to generate a beam. This value ranges from 1 
to 32, and is determined by the limits of the hardware.

Frequency
Pulse train frequency for the given law, in kilohertz. The default value 300 is not 
used. The value ranges from 300 to 2000. Used only for EMAT (electromagnetic 
acoustic transducer).

Cycles
The number of cycles in the pulse train for the given law. The default value is 1. 
The value ranges from 1 to 15. Used only for EMAT.

Sum Gain
The gain working range for a given law, in decibels (dB). Sum gain is an 
attenuation value that varies according to the number of active elements. This 
value is dependent on the instrument being used. The value −1 is the Auto Sum 
gain, which is defined by the hardware. The value ranges from −1 to 30.

In FocusPC, the Sum gain can be modified on the Receiver tab of the UT Settings 
dialog box (see Figure B-1 on page 289).
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Figure B-1  The Sum gain on the Receiver tab of the UT Settings dialog box

Mode
The inspection mode for the given law:

— 0 = T/R (transmit/receive), which has different pulser and receiver elements
— 1 = Pulse-echo, which has the same pulser and receiver elements

Filter
Specifies the filter applied at reception:

— 0 = no filter (0.5 MHz to 20 MHz)
— 1 = 0.5 MHz to 5 MHz
— 2 = 2.0 MHz to 10 MHz
— 3 = 5.0 MHz to 15 MHz
In FocusPC, the Filter can be modified on the Pulser/Receiver tab of the UT 
Settings dialog box (see Figure B-2 on page 289).

Figure B-2  The Filters area on the UT Settings dialog box’s Pulser/Receiver tab

Refracted Angle
The refracted angle for the given law, expressed in tenths of degrees. The 
parameter-value range is as follows:

— For .law file version 5.0: 0 to 900
— For .law file version 5.2: −900 to 900
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In FocusPC, the Refracted angle can be modified on the Position tab of the UT 
Settings (see Figure B-3 on page 290).

Beam Skew Angle
The skew angle for the given law, expressed in tenths of degrees. The parameter-
value range is as follows:

— For .law file version 5.0: 0 to 3599
— For .law file version 5.2: −900 to 900

The beam skew angle is defined only for the beam, and initially assumes that the 
probe skew angle is 0. The probe skew angle (which determines the scan orientation) 
must be entered after the .law file is downloaded to the acquisition software.

In FocusPC, the Skew angle can be modified on the Position tab of the UT 
Settings dialog box (see Figure B-3 on page 290).

Figure B-3  The Refracted and Skew angles on the Position tab (UT Settings)

Probe Skew Angle (version 5.2)
The probe skew angle for the given law, in degrees. The value ranges from 
0 to 3599.

First Pulser1

Specifies the number of the first pulser hardware connection used for 
transmission during focal law formation (whether pulsing or not). The value is a 
positive integer determined by the hardware (instrument and probe).

In FocusPC, the First element can be modified on the Transmitter tab of the UT 
Settings dialog box (see Figure B-4 on page 291).

1. It is important to note that if this parameter is redefined in the UT settings of FocusPC, then the 
wedge delay calculated by the Calculator will be incorrect.

NOTE
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Figure B-4  The First element on the Transmitter tab of the UT Settings dialog box

First Receiver1

Specifies the number of the first receiver hardware connection used during focal 
law formation (whether receiving or not). The value is a positive integer 
determined by the hardware (instrument and probe).

In FocusPC, the First element can be modified on the Receiver tab of the UT 
Settings dialog box (see Figure B-5 on page 291).

Figure B-5  The First element on the Receiver tab of the UT Settings dialog box

Scan Offset
The offset of the scan-axis exit point (for the given law) relative to the probe set’s 
origin (the mechanical reference point), expressed in micrometers.

In FocusPC, the Scan offset can be modified on the Position tab of the UT 
Settings dialog box under Offset (see Figure B-6 on page 292).

Index Offset
The offset of the index-axis exit point (for the given law) relative to the probe set’s 
origin (the mechanical reference point), expressed in micrometers.

1. It is important to note that if this parameter is redefined in the UT settings of FocusPC, then the 
wedge delay calculated by the Calculator will be incorrect.
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In FocusPC, the Index Offset can be modified on the Position tab of the UT 
Settings dialog box under Offset (see Figure B-6 on page 292).

Figure B-6  The Scan axis offset on the Position tab of the UT Settings dialog box

Global Delay
Specifies the global delay (GD) expressed in nanoseconds (ns). The value is a 
nonnegative integer, and is calculated as follows:
GD = ED + WD + LD
ED: Electronic delay that is determined by the hardware. The value is 0 for 
FOCUS PX instruments.
WD: Total wedge delay (transmission and reception)
LD: Law delay (global delay introduced by the specified law)
In FocusPC, the Delay can be modified on the Position tab of the UT Settings 
dialog box (see Figure B-7 on page 292).

Figure B-7  The Delay on the Position tab of the UT Settings dialog box

Focusing Depth
Focusing distance, which is a true depth expressed in micrometers. The value is a 
nonnegative integer.

Material (sound) Velocity
Specifies the propagation velocity in the material, in meters per second (m/s). The 
value is a nonnegative integer.

In FocusPC, the Sound velocity can be modified on the Position tab of the UT 
Settings dialog box (see Figure B-7 on page 292).
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Element parameters
Parameters that are related to the individual elements in a defined beam.

Element Number
The number identifying the individual element of the phased array probe relative 
to the first pulser and the first receiver (see “First Pulser” on page 290 and “First 
Receiver” on page 291). The element numbers are consecutive (1, 2, 3, and so on). 
Inactive elements are disabled by setting the Transmission Delay and Reception 
Delay to 65535 (see “Transmission Delay” on page 293 and “Reception Delay” on 
page 293). The value must be less than or equal to the maximum number of 
hardware elements. The value is a positive integer.

Beam Gain
The gain applied to the considered beam, in decibels (dB). Admissible range: 0–
80. Elements of the same beam must have the same focal law gain.

For .law files generated in offline mode (that is, without phased array equipment 
connected), this parameter has the default value 0.

In FocusPC, the Beam gain can be modified on the General tab of the UT Settings 
dialog box (see Figure B-8 on page 293). Make sure that All beams is cleared 
before modifying the focal law gain.

Figure B-8  The Beam gain on the General tab of the UT Settings dialog box

Transmission Delay
Specifies the transmission delay for the specified active element. The delay is 
expressed in nanoseconds and must be between 0 and 25600. The transmission is 
deactivated if 65535 is used.

Reception Delay
Specifies the reception delay for the specified active element. The delay is 
expressed in nanoseconds and must be between 0 and 25600. The reception is 
deactivated when 65535 is used.
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Amplitude
The excitation amplitude for the specified active element, expressed in volts 
(range: 50–200). The value must be the same for all elements of all beams defined 
in the current law file.

For .law files generated in offline mode (that is, without phased array equipment 
connected), this parameter has the default value 180.

In FocusPC, the Voltage can be modified on the Pulser/Receiver tab of the UT 
Settings dialog box (see Figure B-9 on page 294).

Pulse Width
The pulse width is applied to the specified active element, expressed in 
nanoseconds (range: 30–500). The value must be the same for all elements of all 
beams defined in the current law file. Generally, the pulse width value can be 
confirmed as follows:
Pulse Width (ns) = 500 ÷ Probe Frequency (MHz)

In FocusPC, the Pulse width can be modified on the Pulser/Receiver tab of the 
UT Settings dialog box (see Figure B-9 on page 294).

Figure B-9  The Pulse Width on the Pulser/Receiver tab (UT Settings dialog box)
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